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Abstract

Abstract

This research project is concerned with the numerical investigation of the behaviour of
homogeneous and bubbling gas-fluidized beds. We started by investigating the homogeneous
expansion of gas-fluidized beds using the Richardson & Zaki (1954) equation. We modelled the
stable expansion of gas-fluidized beds of different diameter, accounting for enduring contacts
among particles and wall effects. We solved the model numerically to obtain the bed expansion
profiles, back-calculating from them the values of the expansion parameter n. To validate our
model, we carried out fluidization and defluidization experiments, analyzing the results by
means of the Richardson & Zaki equation. We obtained a reasonable agreement between
numerical and experimental findings; this suggests that enduring contacts among particles,
which are manifestations of cohesiveness, affect homogeneous bed expansion. The results
showed that homogeneous gas-fluidized beds do not consist of particles floating freely; rather

they are made up of particles in sustained frictional contacts.

We then investigated the process of lateral solid mixing in bubbling fluidized beds, adopting the
Eulerian-Eulerian modeling approach. To quantify the rate at which solids mix laterally, we
used a lateral dispersion coefficient (Ds,). The values of D, obtained numerically are larger
than the experimental ones, within the same order of magnitude. The overestimation has a
twofold explanation. On one side, it reflects the different dimensionality of simulations (2D) as
compared with real fluidized beds (3D), which affects the degrees of freedom of particle lateral
motion. On the other, it relates to the way frictional solid stress was modelled. To investigate
how sensitive the numerical results are on the constitutive model adopted for the frictional
stress, we ran the simulations again using different frictional models and changing the solid
volume fraction at which the bed is assumed to enter the frictional flow regime (¢nin). We
observed that Dy, is quite sensitive to the latter. The results show that accurate prediction of
lateral solid dispersion depends on adequate understanding of the frictional flow regime, and

accurate modelling of the frictional stress which characterizes it.

We further examined the influence of simulation dimensionality in numerical results. We ran
3D CFD simulations using the same powder, the same operational conditions and the same
computational setup as in the previous 2D simulations. The 3D simulations predicted D, more
accurately than the 2D simulations, the simulation dimensionality appearing to be an important
factor. To analyse further the role of frictional stress models, we ran 3D DEM simulations. The
simulation results agreed reasonably well with the empirical data, but their accuracy depended
on the values used for the collision parameters; also, the 3D CFD simulations matched the
empirical data more closely. Altogether, we thus concluded that the simulation dimensionality

plays a dominant role in predicting D, accurately.
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Notation

Units are expressed using the Sl system. Some symbols used infrequently are not listed, but are
defined where they first appear in the text.

a positive constant -
a; linear acceleration of particle i m/s?
b positive constant -
B, granular bond number -

c positive constant -

C void-free solid concentration kg/m?
C, experimental void-free solid concentration kg/m?
Cp" drag coefficient -
Cp drag coefficient -
D vessel diameter m
d, particle diameter m
d, bubble diameter m
D¢ averaged rate of deformation tensor of the fluid 1/s
D; averaged rate of deformation tensor of the i th particle phase 1/s
Dg, axial dispersion coefficient m?/s
Dy, lateral dispersion coefficient m?/s
E; elastic modulus of particle i N/m?
E,, elastic modulus of the wall N/m?
f interaction force per unit particle N
fi averaged buoyancy force N

vii



Notation

averaged drag force

total contact force

total external force

sum of other particle-particle forces
contact force exerted by particle j on particle i
gravitational force on particle i

drag force on particle i

pressure forces on particle i

Froude number

gravitational acceleration

shear modulus of particle i

bed height at minimum fluidization
initiak bed height

bed height

moment of inertia of particle j
moment of inertia of particle i
janssen coefficient

impulse

ratio of aggregate size to particle size
particle cohesion coefficient
tangential spring constant

normal spring constant

total mass of particle

Richardson & Zaki exponent
experimental Richardson & Zaki exponent

normal unit vector

number of particles per aggregates

viii

m?/s

N/m?

kg.m

kg.m

N.s

N/m?
N/m3/2
N/m3/2

kg



Notation

number of particles per unit volume

total solid pressure

averaged pressure of particle phase i

frictional pressure of the i th particle phase

pressure of the i th particle phase in the viscous regime

averaged fluid pressure
minimum fluidization flow rate
minimum bubbling flow rate
position vector of particle i
position vector of particle j
terminal Reynolds’s number
particle Reynold’s number
averaged fluid stress tensor
averaged particle stress tensor
averaged stress tensor of particle phase i
time

tangential unit vector

torque on particle i

superficial fluid velocity
averaged velocity of particle i
averaged fluid velocity
averaged particle velocity
minimum fluidization velocity
minimum bubbling velocity
kinematic wave velocity
dynamic wave velocity

particle terminal velocity

N/m?
N/m?
N/m?
N/m?
N/m?

m*/s

m’/s

N/m?
N/m?

N/m?

m/s
m/s
m/s
m/s
m/s
m/s
m/s
m/s

m/s



Notation

U experimental terminal velocity

Ug terminal settling velocity of aggregates

v; linear velocity of particle j before collision
vj' linear velocity of particle j after collision

Vij linear velocity of i relative to j before collision
v volume of vertical layer

Greek Symbols

a; angular acceleration of particle i

B coefficient of tangential friction

6 bubble fraction

€ fluid volume fraction

Emy bed voidage at minimum fluidization

Emb bed voidage at minimum bubbling

Ne tangential damping coefficient

Nn normal damping coefficient

0; granular temperature of the i th particle phase
Kr dilatational fluid viscosity

Ki dilatational viscosity of i th particle phase

u friction coefficient

Ur fluid viscosity

Wi viscosity of particle phase i

Us solid viscosity

w;® viscosity of the i th particle phase in the viscous regime
wit frictional viscosity of the i th particle phase
pr fluid density

Pp particle density

m/s
m/s
m/s
m/s

m/s

rad/s?

N.s/m
N.s/m
m?/s?
kg/(m.s)

kg/(m.s)

kg/(m.s)
kg/(m.s)
kg/(m.s)
kg/(m.s)
kg/(m.s)

kg/m®

kg/m®



Notation

PprL

PLp

bulk density obtained under loose packing

bulk density obtained under prolonged packing

poisson ratio of particle i

solid volume fraction

volume fraction of aggregates

solid volume fraction at which enduring contacts vanish
maximum value of solid volume fraction

average solid volume fraction

angular velocity of particle i before collision

angular velocity of particle j before collision

Xi

kg/m?

kg/m®

rad/s

rad/s
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Chapter 1

General Introduction

In this chapter, we provide a general overview on the process of fluidization, its applications
and different fluidization regimes. We summarize the main goals of this research work, and

finally we provide an outline of the thesis.

1.1 An introduction to fluidization

Fluidization is an operation in which a bed of granular material is made to behave like a fluid by
contact with gas or liquid. This is usually achieved by feeding the fluid through the granular
material at a rate that is sufficient to exert a force on the particles that at least counter-balances
its weight, making the bed acquire fluid-like properties such as: ability to flow freely under
gravity, ability to deform or to be pumped using fluid-type technologies. The bed of granular
material is then said to be fluidized. In the fluidized state there is extremely high surface contact
between the fluid and the solid per unit volume of the bed, high level of mixing of the
particulate phase(s) which promotes heat and mass transfer and high relative velocity between
the fluid and the dispersed solid phase. These properties allow fluidized beds to find

applications in many industrial operations.
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The first application of fluidized beds was in Germany, where they were used in the Winkler
process for coal gasification to produce synthesis fuel. Following this, fluidized beds were
employed in the fluid catalytic cracking (FCC) of heavy oils to convert them to light products
such as gasoline, kerosene, diesel and light olefins. This process is by far the largest application
of fluidized bed technology. Similar to FCC applications, the Fischer-Tropsch (F-T) process is
another catalytic gas-phase process that relies on fluidized bed technology. The F-T process is
used to synthesize carbon monoxide (CO) and hydrogen (H,), which are used to produce long
chain hydrocarbons. This process draws on the advantage of excellent heat transfer rate in the
fluidized beds which ensures uniform temperature is achieved in the process, thus improving the
efficiency of the process. Other catalytic gas-phase processes where fluidized beds are
employed are production of phthalic anhydride, acrylonitrile, aniline, ethylene dichloride,

polyethylene and polypropylene.

In recent times, fluidized beds have been used in the incineration of solid wastes. This
application is the most widely used of all the waste-to-energy technologies. Incineration is
particularly useful for getting rid of harmful materials and for the utilization of heat produced
for electricity generation. Consequently, fluidized beds have been employed extensively in the
incineration of municipal and industrial wastes, offering distinct advantages such as ability to
handle different feed materials, homogeneous combustion and lack of moving part in the

combustion zone.

The world-wide campaign for environmental sustainability and green technology has caused a
great shift of attention to the use of renewable sources for energy generation, with biomass as
one of the preferred energy resources. Gasification of biomass offers an efficient way of
controlling emissions, offering a simpler way of removing pollutant gases such as sulphur
dioxide, nitrogen oxides and carbon dioxide. It also produces synthesis gas which is used to
produce different environmentally friendly gaseous and liquid fuels. The conversion of biomass
to these fuels relies on fluidized bed technology, making the latter a contributor to sustainable

development.
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Table 1.1: Applications of fluidized bed technology

Polymeric materials e Synthesis of polyethylene, polypropylene

e Production of silicon for semi-conductor applications

Pharmaceutical & e Cultivation of microorganisms for food and

Biochemical applications pharmaceutical applications e.g. fluidized bed
bioreactors

e Continuous and batch processing to produce
antibiotics, enzymes, fermentation products, proteins,

vitamins.

Chemical synthesis e Synthesis of varieties of products such as phthalic
anhydride, Fischer-Tropsch synthesis of
hydrocarbons, acrylonitrile, maleic  anhydride,

activated carbon

Petroleum processing e Fluid catalytic cracking for production of gasoline
from oil
e Fluid coking
Combustion & Gasification e Coal combustion

e Solid waste incineration
e Biomass gasification

e Chemical looping combustion

Other applications e Coating of particulate material
e Drying of solids

e Granulation

e Adsorption of solvents

e Metallurgical applications

Another area of fluidized beds application that is worth mentioning is in the mineral and
metallurgical processes. The use of fluidized beds for these processes commenced in the late
1940s in Ontario, Canada, where these systems were used for the roasting of arsenopyrite
(Kunii & Levenspiel, 1991). Fluidized beds are suitable for this application because of the

excellent heat and mass transfer rates which they promote. Subsequently, fluidized beds have
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been employed in a wide range of mineral and metallurgical processes such as roasting of

pyrites, pyrrhotite, zinc sulfide, copper and cobalt concentrates.

The application of fluidized beds is not limited to processes where chemical reactions take
place, such as those described above. They are also employed in many physical operations. We
mention for instance, their use in drying operations. This has been used in many industries such
as food and agriculture industry, pharmaceutical industry and chemical process industries. Other
physical processes in which fluidized beds are employed include coating, granulation, solid
mixing, food freezing, solvent adsorption and heat treatment. Table 1 summarizes some

applications of fluidized bed technology.

1.2 The phenomenon of fluidization

When a fluid is passed upwards through a bed of particles as shown in Figure 1.1, at low flow
rate, the fluid just moves through the spaces between the particles while the particles remain
stationary in their positions. This is referred to as fixed bed or packed bed. As the flow rate of
the fluid is increased, the particles move apart and a few of them vibrate and move in restricted
regions. As the flow rate is further increased, a point is reached where all particles are just
suspended by the upward flowing fluid. At this point, the drag force on the particles
counterbalances their effective weight (real weight minus buoyant force). When this happens,
the bed is considered to be just fluidized and is referred to as incipiently fluidized bed or bed at
minimum fluidization. For a bed fluidized by liquid, a further increase in flow rate above the
minimum fluidization flow rate @, will result in a smooth, progressive expansion of the bed
and the bed remains in a homogeneous state. The superficial gas velocity corresponding to
Qmy, Obtained by dividing the latter by the cross sectional area A of the vessel, is a property of
the fluid-particle system, referred to as minimum fluidization velocity, u,, A bed such as this is

called a particulately fluidized bed or homogeneously fluidized bed. This behaviour is observed

in gas-fluidized beds only when small, light particles are fluidized.
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Fixed bed Minimum Smooth Bubbling
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Figure 1.1: Fluidization regimes (Kunii & Levenspiel, 1989).

Typically, in gas-fluidized beds, when the flow rate is increased beyond that which is needed for
minimum fluidization, bubbles begin to form and movement of particles become more vigorous.
Unlike the situation obtained for liquid-solid systems, the bed does not expand much beyond its
volume at minimum fluidization. This type of bed is called an aggregative fluidized bed or a
bubbling fluidized bed. This type of bed rarely occurs in liquid-solid systems, except with very
dense solids fluidized by low density liquids. The velocity u,,; at which the first bubble forms
is also a property of the fluid-particle system, and it is called the minimum bubbling velocity.
With further increase in gas flow rate, bubbles coalesce as they rise through the bed, and in a
bed that is deep and of small diameter, they may eventually become large enough to spread

across the vessel. This is called slugging fluidization. At sufficiently high gas flow rate, the
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terminal velocity of the solid is exceeded, making the upper surface of the bed disappear, and
instead of bubbles, one observes a turbulent motion of solid clusters and voids of gas of various
sizes and shapes. This is called a turbulent fluidized bed. A further increase in gas velocity
drives the bed into the pneumatic transport regime, where the particles are carried out of the
bed. We summarize the different regimes of fluidization in Figure 1.1. In this work, we focus on
two regimes: the homogeneous and bubbling regimes. The former is our main focus in Chapters

2 and 3, while the latter is addressed in Chapters 4 through 6.

The fluidization behavior described above provides a generalization of how particles behave
when subjected to an increasing upward flow of gas. However, the behavior of gas-fluidized
beds depends largely on the physical properties of the particles and the operating conditions. In
trying to describe this dependence, Geldart (1973) characterized the behavior of particles
fluidized by gas into four distinct groups. Figure 1.2 reports the classification of powders

fluidized by air at ambient temperature.

Group A powders have small sizes (30 - 100 um) and/or low density (typically less than
1.4 g/cm3). A notable example is FCC catalyst. When they are fluidized by gas they expand
homogeneously at superficial gas velocities between u,,s and u,,,. The physical mechanism
responsible for this homogeneous expansion has been a subject of controversy among
researchers (Foscolo & Gibilaro, 1984; Mutsers & Reitema, 1977; Tsinontides & Jackson, 1993;
Fortes et al., 1998); some argue that the homogeneous expansion (or the stability) is due to the
existence of interparticle forces in the bed, while others sought for a purely fluid dynamic
explanation. In Chapter 2, we provide an extensive review of this lingering controversy, while
in Chapter 3 we address the subject, providing further insight using theoretical and experimental

methods.

Group B contains powders in the mean size range of 40 — 500 um, and density range 1.4 —
4 g/cm3. An example is sand. When these particles are fluidized, bubbles start to appear at

minimum fluidization velocity or at a velocity slightly higher than the latter. Group D consists
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of large and/or dense particles whose minimum fluidization wvelocity coincides with the
minimum bubbling velocity; thus powders belonging to this group begin to bubble as soon as

they are fluidized.
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Figure 1.2: Fluid-particle system classification for air at ambient temperature (Geldart, 1973)

Group C consists of cohesive powders characterized by very small particles of size range
20 — 50 pum. Fluidization of this group of powder is difficult because of the strong interparticle
forces among the particles which dominate the fluid dynamic forces. Their fluidization usually
leads to undesirable processes such as plugging, channeling and formation of stable cakes
(Chaouki et al., 1985; Molerus, 1982; Ozcan & Tiiziin, 2006). To fluidize this group of powder,
researchers have developed various methods including sound assisted fluidization (Morse,
1955), vibro-fluidization (Mori et al., 1990), magnetically assisted fluidization (Lu & Li, 2000),
electro-fluidization (Kashyap et al., 2006), addition of foreign particles (Brereton, 1987) and the

use of tapered fluidized beds (Venkatesh et al., 1996). As we shall later see in this work,



Chapter 1 Introduction 2016

successful fluidization of Group C powders makes them behave in a similar way to Group A
powders, having in particular a stable interval of homogeneous expansion before transiting to

the bubbling regime.

1.3 Computational modelling of fluidized suspensions

Despite the extensive applications of fluidized beds, their design is quite challenging. The usual
way is to construct them on a laboratory scale, construct a bigger pilot plant, and then scale-up
the pilot plant to a commercial size. This approach has some problems associated with it - many
of the essential operating parameters are scale-dependent, a change in one parameter affects
several other parameters, making the scaled fluidized bed have a significantly different
hydrodynamics. In addition to this, fluidized beds operate in different regimes (bubbling,
turbulent, spouting etc.); therefore, it is difficult to come up with a general rule on fluidized bed
scale-up. While describing the complexity of fluidized bed scale-up, Matsen (1996) stated that
“scale-up is not an exact science, but is rather that mix of physics, mathematics, witchcraft,
history and common sense that we call engineering”. Matsen’s statement clearly revealed the

difficulties inherent in the design of fluidized beds using the scale-up method.

As interest in understanding the mechanisms responsible for complex fluid dynamic interactions
in fluidized systems grew, a more fundamental approach based on equations of motion for
interacting fluid and particles was developed. These equations nevertheless were seen as a
means of understanding the mechanisms responsible for complex behaviour of fluidized
systems rather than as a basis for engineering design. However, in the 1980s, researchers began
to attempt using differential equations of continuity and momentum as a basis for quantitative
design calculations. This effort was greatly complemented by rapid improvements in the speed
and memory capacity of digital computers, coupled with the development of better numerical
methods for solving equations of motion. Consequently, researchers began to attempt predicting
bubble formation in dense fluidized beds by direct integration of these equations (Pritchett et al.,

1978; Gidaspow & Ettehadieh, 1983; Gidaspow et al., 1986).
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Nowadays, computer simulations have proven to be a useful tool in the design and scale-up of
fluidized bed processes, allowing researchers to obtain fundamental insights into the complex
behaviour of dense fluidized suspensions. Computer simulations are also employed as a design
tool, where numerical models are used to predict the behaviour of dense gas-particle flows
encountered in engineering-scale equipment. The use of computational methods in the design of
fluid bed processes has led to reduction in cost of product and process development, reduced the
need for physical experiment, improved design reliability, increased conversions and yield and

facilitated the resolution of environmental, health and right-to-operate issues (Davidson, 2002).

Although empirical correlations are still employed in many practical engineering designs,
attention is gradually shifting towards the use of computational methods. This is because the
latter are able to provide answers to questions that cannot be addressed using empirical
correlations. For example, empirical correlations are unable to tell us the effect of introducing
internals or changing the designs of distributor plates on fluid dynamics and performance,
whereas computational codes are able to solve the governing equations to answer these

guestions.

The equations used for investigating the behaviour of fluidized systems can be formulated at
different levels of detail. At the most fundamental level, the particles are treated individually
and their motion is determined by Newtonian equation of motion for translational and rotational
motion, thus retaining the discrete nature of the particles. The interstitial fluid, on the other
hand, is modelled as a continuum whose dynamics is described by Navier-Stokes and continuity
equations, satisfied at every point of the fluid itself. Each set of equations is coupled by no-slip
boundary condition between solid and fluid on each particle boundary, the fluid also satisfying
no-slip condition on the remaining boundaries of the computational domain. The main
advantage of this modelling approach lies in the simplicity of the equations; the latter do not
contain indeterminate terms that need closure — except the fluid stress tensor, for which the
classical Newtonian equation holds, and particle-particle collisions. Despite the simplicity of

this approach, it is seldom used. This is because of its enormous computational demand. Indeed,
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simulations at this level of detail have only been carried out for very dilute systems (Pan et al.,
2002). Quite recently, Kriebitzsch et al. (2013) carried out simulations of gas-fluidized beds
using this approach, but in the simulations they considered only 2000 particles, owing to the

significant computational effort required.

Another modelling approach, which provides a lower level of detail, can be obtained by
averaging the fluid velocity over a spatial domain large enough to contain many particles but
still small compared to the whole computational domain. The Newtonian equations of motion
are solved for each particle, and the force exerted on each particle is related to the particle’s
velocity relative to the locally averaged fluid velocity. This modelling approach, referred to as
discrete element modelling (DEM), is less computationally demanding compared to that
reported in the preceding paragraph, and has been widely employed to investigate the behaviour
of fluidized suspensions (Tsuji et al., 1993; Hoomans et al., 1996; Ouyang & Li, 1999; Kafui et
al., 2002; Lu et al., 2005; Sun, et al., 2007; Liang — wan & Zhan, 2010; Zhu et al., 2011). The
approach provides enormous information on the fluid bed dynamics, and is an approach of
choice for researchers who are interested in gaining deeper insight into the dynamics of granular
media. Nonetheless, discrete particle modelling has its own drawbacks — it requires enormous
computational effort and can rarely be employed to investigate the dynamics of large-scale

fluidized systems. We provide further detail on this modelling approach in Chapter 6.

At an even lower level of detail, both the fluid velocity and particle velocity are averaged over
the local spatial domain; thus the resulting equations resemble those that one would write for n
imaginary fluids capable of interpenetrating each other while occupying the same volume
simultaneously. The model, referred to as Eulerian-Eulerian, therefore takes the form of coupled
differential equations subject to boundary conditions at the boundaries of the whole system. The
numerical solution of the Eulerian averaged equations of motion is known as computational
fluid dynamics (CFD). This modelling approach, when compared to those described previously,
is computationally less demanding, and is often used by researchers who are interested in

investigating the behaviour of large-scale systems. The approach has been successful in
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investigating the behaviour of full-scale systems, thus offering a more reliable way of designing

and investigating industrial size fluidized beds.

Although the Eulerian-Eulerian modelling approach is very attractive to researchers and
engineers who are interested in investigating the behaviour of industrial scale fluidized systems,
it has a major drawback: the equations are mathematically unclosed; therefore closures must be
formulated for indeterminate terms resulting from the averaging process. To close these
equations, we must formulate models for the fluid-particle interaction force and the effective
fluid dynamic stress of the fluid and solid phases. To express the former, we employ empirical
correlations together with results of classical fluid dynamics, while the Newtonian equation is
used to express the effective fluid dynamic stress of the fluid phase. Modelling interaction
forces between particles of different phases and effective fluid dynamic stress of solid phase is
very challenging. Many researchers resort to the kinetic theory of granular flow (Haff, 1983;
Jenkins & Savage, 1983; Lun et al., 1984; Jenkins, 1987; Lun, 1991; Gidaspow, 1994;
Goldshtein & Shapiro, 1995; Mazzei et al., 2010; Oke, et al., 2014). However this approach is
inadequate to describe correctly the behaviour of dense fluidized systems where particle interact
through enduring frictional contacts; hence several approaches originating from the field of soil
mechanics have been adopted (Savage, 1982; Johnson & Jackson, 1987; Makkawi & Ocone,
2006). In Chapter 5 we discuss this modelling approach in greater detail, reporting its governing

equations and demonstrating its capability to investigate the process of mixing in fluidized beds.

1.4 Computational fluid dynamic codes
The numerical solution of averaged equations of motion consists of three basic steps — pre-
processing, solving and post-processing. These steps are briefly described below.

1. Pre-processing:
In this step we set up the physical problem. This involves creating the geometry, generating the
mesh, specifying the number of Eulerian phases and their physical and/or chemical properties,
time-step, initial and boundary conditions.

2. Solving:

11
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Most commercial CFD codes use the finite volume method. The code integrates the differential
transport equations over each computational cell, generating a set of integral equations on a
control volume basis. Then, the code converts these equations into algebraic form using
discretization techniques. Finally, the code solves the set of algebraic equations and finds the
cell-centre values of the flow variables.
3. Post-processing:

The raw outputs from the solver consist of huge data sets that have to be analysed in order to
obtain useful information. The modeller therefore uses analysis tools to extract and manipulate

the data and generate diagrams and snapshots.

1.5 Research questions

This research project is concerned with the investigation of the fluid dynamic behaviour of
homogeneous and bubbling regimes of gas-fluidized beds. Knowing how fluidized beds behave
will greatly allow us to model and design them more accurately. The research aims to answer
some fundamental questions relating to the dynamics of fluidized bed suspensions. These
involved answering, among others, guestions such as how do particles interact in homogeneous
gas-fluidized beds? Do homogeneous fluidized beds consist of free-floating particles having no
form of particle-particle interactions? How applicable are the existing fluid dynamic
correlations, often used to analyse bed expansion, to the solid-like regime of fluidized beds?
What roles do interparticle forces play in the homogeneous expansion of gas-fluidized beds.
These questions have lingered for quite a while in the fluidization community. Answering these
questions will provide deep insight into the complex fluid dynamic relationships in fluidized
beds and will enhance our ability to better model their behaviour. The investigations in this
work also cover the bubbling regime of fluidized beds. In this regime, the process of lateral
solid mixing is examined. Lateral solid mixing is crucial for assessing the performance of large-
scale fluidized beds. The influence of operational and design conditions on lateral solid mixing

is investigated. In this part of the research, we aim to investigate how well the two widely used
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modelling approaches, the Eulerian-Eulerian and the Eulerian-Lagrangian, can estimate lateral

solid dispersion coefficients.

1.6 Research objectives
The main goals of this research are:

1. Presenting clearly the process of homogeneous fluidization in gas-fluidized beds;
investigating the distinctive features of solid-like and fluid-like regimes of
homogeneous fluidization.

2. Elucidating the fluid dynamic behaviour of homogeneous gas-fluidized beds; providing
deeper insight into the mechanisms responsible for the stability observed in gas-
fluidized beds.

3. Modelling the stable expansion in gas-fluidized beds, accounting for enduring particle
contacts and wall friction; examining the roles played by enduring particle contacts and
wall friction on the homogeneous expansion of gas-fluidized beds.

4. Conducting fluidization and defluidization experiments to investigate the expansion
process in gas-fluidized beds; carrying out experiments to determine yield stresses in
gas-fluidized suspensions; analysing the expansion profiles of gas-fluidized beds using
the Richardson & Zaki (1954) equation, and examining the applicability of the latter in
describing the expansion profiles in gas-fluidized beds.

5. Modelling lateral solid mixing in gas-fluidized beds using the Eulerian-Eulerian
approach; quantifying lateral solid mixing using a lateral dispersion coefficient and
validating numerical results with empirical data.

6. Investigating the effects of operational and design factors on the lateral solid mixing in
gas-fluidized beds; in particular the influence of superficial gas velocity, bed diameter
and bed height.

7. Examining the influence of frictional models and dimensionality on the numerical
simulations of lateral solid mixing; comparing the numerical results obtained from 2D

13
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and 3D simulations of lateral solid mixing; analysing the effects of frictional packing
limit, frictional pressure and frictional viscosity models on lateral solid mixing.

8. Investigating the capability of Eulerian-Lagrangian modelling approach in estimating
lateral solid dispersion coefficients; comparing the predictive ability of this modelling

approach with that of Eulerian-Eulerian methods.

1.7 Thesis outline

Chapter 2 reports on the stability of gas-fluidized beds, discussing on the lingering controversy
among researchers about its origin. We then report on the homogenous expansion of gas-
fluidized beds, revealing the distinct peculiarities of the solid-like and fluid-like regimes. In
Chapter 3, we investigate the mechanics of homogeneous expansion in gas-fluidized beds using
theoretical and experimental methods. In Chapter 4, we report on the process of mixing in
bubbling fluidized beds and how it is quantified. We highlight the importance of axial and
lateral solid mixing and report on the dominant mechanisms by which these processes occur. In
Chapter 5, we model lateral solid mixing using the Eulerian-Eulerian approach. We solve the
2D governing equations numerically to determine the lateral dispersion coefficients. We finally
investigate the influence of design and operating conditions on the latter. We then examine the
influence of frictional stress models on our numerical results. In Chapter 6, we investigate the
effect of simulation dimensionality on the numerical results obtained in Chapter 5. We run 3D
CFD simulations comparing the results with those obtained in the latter. We later review the
Eulerian-Lagrangian approach and we use it to investigate lateral solid mixing in gas-fluidized
beds. We compare our numerical results with those obtained from the Eulerian-Eulerian

modelling approach.
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Chapter 2

The stability of gas-fluidized beds

This chapter reviews various mechanisms proposed for the stability of gas-fluidized beds.
1. We present a brief account on the lingering controversy on the mechanism responsible
for the stability of gas-fluidized beds.
2. We report on the experimental and theoretical works supporting the fluid dynamic
stability of gas-fluidized beds.
3. We review the experimental evidence put forward to support the idea that stability in
gas-fluidized beds is due to interparticle forces.

4. We present the fluid-like and solid-like behaviour of gas-fluidized beds.
Parts of this chapter have been published:

Oke, O., Lettieri, P., Mazzei, L. (2015). An investigation on the mechanics of homogeneous

expansion in gas-fluidized beds. Chemical Engineering Science, 127, 95-105.

2.1 Introduction

Generally ligquid-fluidized beds display a smooth appearance and expand progressively as the

fluid flow rate is increased, while gas-fluidized beds display heterogeneous appearance,
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containing rising pockets of gas, referred to as bubbles. The former behaviour is referred to as
homogeneous (particulate) fluidization, while the latter is termed bubbling (aggregative)
fluidization. Although gas-fluidized beds generally exhibit bubbling fluidization, small particles
with low density (Geldart A powders) fluidized by gas displays an interval of smooth expansion
when the gas flow is increased above the minimum fluidization rate (Tsinontides & Jackson,
1993). The origin of the stable behaviour of Group A powders has been a subject of controversy
in the fluidization community. On one side of the argument are those ascribing the stability to
the existence of interparticle forces in the bed and on the other side are those seeking for a
purely fluid dynamic explanation.

Over 60 years ago, Wilhelm & Kwauk (1948) proposed an empirical fluid dynamic criterion for

stability in fluidized beds. They based their criterion on the Froude number E.:

_ (umf)2

K
T gdp

2.1)

where d,, is the particle diameter, g is the gravitational acceleration and w,,; is the minimum

fluidization velocity. They observed that a bed is fluidized homogeneously if E. < 1, while it

bubbles otherwise.

Jackson (1963) sought to derive a theoretical justification for the criterion proposed by Wilhelm
& Kwauk (1948) using a linear stability analysis. This was based on the continuity and linear
momentum balance equations for the fluid and particle phase. Unfortunately, the analysis
yielded a physically unacceptable behaviour: it predicts that all fluidized suspensions should be
unstable and that the rate of growth of instability should increase monotonically as their
wavelengths tend to zero. However, the analysis predicted correctly that the rate of growth of
instability in gas-fluidized beds is generally greater than in beds of comparable particles

fluidized by liquids.

The physically unacceptable behaviour predicted by the linear stability analysis is because the

particle-phase momentum balance equation adopted by Jackson did not include terms
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representing viscous dissipation (Anderson & Jackson, 1967). The latter accounts for the
physical mechanisms responsible for momentum transport associated with fluctuations in
particle velocity. When such terms are added to the particle-phase momentum balance equation
(Pigford & Baron, 1965; Anderson & Jackson, 1967) there is a bounded value of the wavelength

for which the disturbances grow.

The foregoing attempts simply attribute the difference between liquid and gas-fluidized beds to
the greater growth of disturbance, but could not establish a sharp dividing line between
homogeneous and bubbling fluidization, neither did they say anything about the ultimate fate of
the disturbance nor provide a justification on why disturbances in liquid fluidized beds do not
grow into bubbles. The failure of linear stability analysis to establish a clear distinction between
homogeneous and bubbling fluidization has led researchers to take into account non-linearities
in the equations of motion (Liu, 1982; Needham & Merkin, 1983; Ganser & Drew, 1990).
Nevertheless these attempts, based only on fluid dynamic considerations, have neither revealed
any qualitative distinction between the predicted behaviour of gas and liquid fluidized beds, nor

provided convincing evidence for stability due to fluid dynamic forces.

Verloop & Heertjes (1970) investigated the transition from homogeneous to bubbling fluidized
beds, considering only the fluid dynamic forces in the bed. Following Wallis (1962), they
viewed bubbles as shock waves propagating in the bed. They reported that shock waves
originate in the latter when the velocity of kinematic wave is greater than that of dynamic wave.
Kinematic waves propagate between two regions of different voidage where equilibrium of fluid
dynamic forces exists and there is no inertia effect (Cherntongchai & Brandani, 2013). Lighthill
& Whitman (1955) describes kinematic waves using a road-traffic flow analogy. They reported
that kinematic wave is comparable to a ‘traffic concentration wave’ which arises when an
interruption of traffic flow occurs at some distance ahead. This traffic concentration wave
propagates backwards at a constant speed from the point of obstruction. Drivers who are far
away from the point of obstruction are forced to slow down and move closer as the wave passes

over them. We should note that the kinematic description just described does not take into
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account the inertial effects due to breaking and acceleration. A dynamic wave, on the other
hand, arises as a result of a force considered to be a component of the drag, which accelerates
the particles as a result of the concentration gradient. This wave is likened to the inertial effects
of breaking and deceleration. Verloop & Heertjes (1970) described the condition for transition

from homogeneous to bubbling fluidization as:

Uy = U, (2.2)

where u, is the kinematic wave velocity and u, is the dynamic wave velocity. Accordingly, a
bed manifests homogeneous behaviour when u, < u,, and bubbling behaviour when u, > u,.
It is important to note that the considerations by Verloop & Heertjes assumed that the fluid is
incompressible; hence, these considerations are valid for liquid-fluidized beds. For beds

fluidized by gas, their propositions are invalid.

Similar to Verloop & Heertjes (1970), Fanucci et al. (1979) described bubbles as shock waves
which propagate in the bed when the velocity of kinematic wave is greater than the velocity of
dynamic wave. By solving the mass and linear momentum balance equations for the fluid and
particle phase, they demonstrated that shock waves can indeed form in the bed. They
investigated the effects of several parameters on the formation of shock waves. Their results
showed that decreasing particle size, increasing bed density, increasing fluid viscosity and
decreasing particle density delay the formation of shock waves. These results are consistent with

experimental data on bubble formation in fluidized beds.

In the same vein, Foscolo & Gibilaro (1984) derived a stability criterion based on fluid dynamic
arguments, resorting to the stability theory of Wallis (1969) to show that stability depends on
the relative magnitude of the kinematic and dynamic waves that propagate in the bed. They
argue that the drag force should include an addition term proportional to the gradient of void

fraction. This led to a criterion for instability of the form:

(gdp)l/z <pp - pf

1/2
< 0.56n(1 — &)/2gn1 (2.3)
U Pp )
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where g is the acceleration of gravity, u, is the terminal velocity of a particle, p,, is the particle
density, py is the fluid density, n is the Richardson & Zaki (1954) exponent and ¢ is the void
fraction. Although the authors claimed that Eq. 2.3 is valid for investigating the stability of a
wide range of gas-fluidized beds, experimental observations revealed that the criterion failed
when applied to certain liquid-fluidized systems. Researchers (Anderson & Jackson, 1969; El-
Kaissy & Homsy, 1976; Ham et al., 1990) reported that certain water-fluidized beds of glass
beads predicted to be stable by Eq. 2.3 are actually unstable, though the instabilities never grow

into bubbles.

Another approach, based on fluid dynamic considerations, was adopted by Batchelor (1998). He
showed that stability could arise due to random fluctuations in particle velocity and related this

to diffusion of particles in the suspension. He proposed the following criterion for instability:

(gdp)'/? ( a4

1/2 )
” 20 + a2)> <n(l-¢e)e (2.4)

where a; and a, are parameters related to the virtual mass effects and the particle phase
pressure. Batchelor reported that the value of (1+ a,) lies between 1 and 2, and a4 is of order

unity.

The foregoing works, based on fluid dynamic considerations, assume that particles are free
floating in the fluid during fluidization, without any form of particle-particle interaction. On the
other side of the argument are those attributing the stability to the existence of interparticle
forces. They argue that the stability of gas-fluidized beds arises due to interparticle forces
holding the particles together and delaying their bubbling over a range of superficial gas
velocity. Those upholding this view report that interparticle forces keep the particles together in
permanent contacts, conferring to the expanded bed a solid-like structure. Indeed, most
experimental results, as we shall later report in this chapter, suggest that Group A powders
behave like a weak solid rather than a fluid in the homogeneous fluidized state, due to enduring

interparticle contacts. The weight of the fluidized particles are therefore not fully supported by
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the upward flow of gas, but also supported in part by interparticle forces among the particles.
Before reporting on this solid-like behaviour, we will review the nature of interparticle forces

that are often at play in gas-fluidized beds.

2.2 Interparticle forces in fluidized beds

Interparticle cohesion in fluidized beds may arise from the interplay of different forces. These
forces, as we shall see, affect the fluidization behaviour of powders and have been closely
linked to the stability observed in gas-fluidized beds. Some notable examples of interparticle

forces are reported below.

2.2.1 Van der Waals forces

This is due to the interaction between instantaneous dipoles formed in the atoms by their
orbiting electrons. The rapidly changing dipole of one atom generates an electric field that
induces the polarization of the neighbouring atom. The induced dipole of the latter produces an
attractive interaction known as the van der Waals force. We should note that this type of
attractive force does not only exist between atoms and molecules, but also between macroscopic
particles. The van der Waals force F,, between two smooth spheres of radius R and separation r

is given by:

hy hy
fv = 8mz?2 K (1 * 8n2r3hr) (2:5)

where h,, is the Liftshits-van der Waals coefficient; the latter depends on the nature of bodies in
contact and the surrounding medium. h,. is a coefficient characterising the hardness of the
bodies in contact (Krupp, 1967; Molerus, 1982; Massimilla & Donsi, 1976). The Van der
Waals force is generally more significant than other interparticle forces for fine particles of
diameter less than 100 um fluidized by dry gas, dominating over their fluid dynamic counterpart

(Visser, 1989; Valverde et al., 1998; Seville et al., 2000).
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2.2.2 Electrostatic forces

In addition to van der Waals forces, electrostatic forces can also contribute to interparticle
cohesion in fluidized beds. When non-conducting particles come into contact with surfaces of
dissimilar material or slide along such surfaces, for example particles sliding along the wall of
fluidized beds, there is generally an exchange of electrons in the surface layer. This causes the
particles to be electrically charged. The motion of a charged particle in the fluidized bed is
influenced by the neighbouring charged particle, therefore creating an electrostatic force
between them. According to Coulomb’s law, the electrostatic force F, between two charged
objects a and b is proportional to the product of their charges and inversely proportional to the
square of the distance r between them (Fan & Zhu, 1998). Coulomb’s law is expressed as:

1 qa9p

~ 4me 12 (2:5)

e

where q, and g, are the charges on a and b, respectively, and € is the permittivity of the
surrounding medium. In general, when compared to van der Waals forces, electrostatic forces
are not significant in a fluidized bed (Reitema, 1991). Nevertheless significant electrostatic
forces can be generated in the bed depending on the material from which the fluidizing vessel is
contructed. For instance, we see significant electrostatic effects when a fluidized bed reactor is

made from Perspex.

2.2.3 Capillary forces

This arises when moisture from the surrounding gas condenses on the surface of particles,
forming a liquid bridge in the gap between neighbouring particles. This produces a resultant
attractive force on the two particles. Capillary forces can dominate the gravitational force on
particles when the vapour pressure of surrounding gas is near the saturation vapour pressure and
can be larger than van der Waals forces (Lian et al., 1993). The magnitude of capillary forces is

very challenging to calculate. One method, proposed by Lian et al. (1993), is the boundary
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method, where the total capillary force F, is calculated at the liquid-solid contact. The capillary

force is given by:
F, = 2myRsina sin(6 + B) + tR2APsin?0 (2.6)

where y is the surface tension of the liquid, 6 is the half-filling angle, g is the contact force and
AP is the pressure drop across the air-liquid interface. It is worth mentioning that in most
fluidized beds applications, capillary forces are always small and can be neglected (Reitema,

1991).

Researchers have made considerable headway in investigating the role of interparticle forces on
the behaviour of gas-fluidized beds. For instance, the understanding of the effects of
interparticle forces on fluidization behaviour has led to the re-interpretation of Geldart’s (1973)
classification of powders, using a dimensionless number known as the granular Bond number
B,. The latter is defined as the ratio of interparticle forces to the weight I}, of a particle.
Powders having B,, < 1 are generally non-cohesive and bubble as soon as they are fluidized;
these powders are classified by Geldart (1973) as Group B and D powders. Those powders for
which B,, > 1 are very cohesive and generally difficult to fluidize; they are classified as Group
C powders in the Geldart classification. Furthermore, powders having B, = 1 exhibit smooth
expansion over a range of superficial gas velocity as soon as they are fluidized; these are

Geldart A powders. The fluidization behaviour of the latter is discussed in the next section.

We should note that the Geldart classification was intended to predict the behaviour of powders
fluidized by air at ambient conditions. Reitema (1984, 1991) pointed out that it is more
appropriate to speak in terms of Geldart’s A, B, C or D behaviour instead of Geldart’s A, B, C
or D powders, since the same powder can exhibit different fluidization behaviour depending on
experimental conditions. For example, Geldart B materials can be fluidized homogeneously
with substantial expansion under conditions of high temperature and pressure. Under these
conditions, there is a significant increase in the interparticle forces among the particles, causing

the granular bond number to take a value very close to unity; hence the shift in behaviour from
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Geldart B to Geldart A. Likewise, a powder which shows Geldart C behaviour may exhibit
Geladart A behaviour when fluidized by a gas of high viscosity or when certain additives (such
as fumed silica) are added. This decreases the interparticle forces among the particles, causing a
reduction in the granular bond number. These observations show that the behaviour of a fluid-

particle system depends largely on the ratio of interparticle forces to the weight of a particle, B,,.

2.3 Solid-like behaviour of Geldart A gas-fluidized beds

The controversy on the origin of stability of Group A powders started over 60 years ago when
Wilhelm & Kwauk (1948) proposed their empirical criterion based on the Froude number. Since
then researchers, some of which were reported in Section 2.1, have carried out theoretical and
numerical studies to emphasize the role of fluid dynamic forces on the stability of Group A
powders. Contrary to the views expressed by these authors, Reitema (1973) stated the stability
of gas-fluidized particles is due to the existence of interparticle forces. He stated that the latter
confer to the bed an effective elastic modulus that could stabilize the bed against small
perturbations, making the bed behave like a weak solid rather than a fluid; this behaviour is
referred to as solid-like behaviour. In their earlier studies, Reitema (1967) measured the
electrical conductivity of a fluidized bed of coke particles. He observed that, during all
fluidization stages, there is a considerable amount of electrical conductivity in the bed,
signifying that particles are in frictional contacts with each other. On this basis he reported that
particles in a fluidized bed arrange themselves in a string, with the latter behaving as a
mechanical system, and exhibiting elastic behaviour. He stated further that a fluidized bed of
cohesive particles, in a way, can be compared to a cigarette-tobacco consisting of crumpled
strings. When a certain mass of tobacco is strongly compacted it is stable, but within certain
limits displays elastic behaviour. When the tobacco is loosened, a more porous structure is
obtained which is also stable and shows elastic behaviour. In the same way, a fluidized bed of
cohesive particles displays an elastic property where the elasticity decreases as the porosity of
the bed increases. To further provide evidence in support of fluidized bed stability by
interparticles forces, Reitema & Mutsers (1973) conducted a tilting bed experiment. In the
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experiment they tilted a homogeneously fluidized bed over the horizontal axis. They observed
that the bed remains stable until a critical tilting angle is reached where the bed surface
suddenly shears off. Their experimental set-up is reported in Figure 2.1. The critical tilting angle
depends on bed expansion, particle size and particle density. When the bed is tilted, the
direction of the drag force on the particles changes, whereas the surface of the bed does not
slide. This implies that the change is being compensated by some other forces in the bed.
Reitema (1973) referred to these forces as interparticle forces in bed. The experiment
demonstrates that the homogeneous fluidized bed has a certain mechanical strength caused by a

network of interparticle contacts.

(@ (b)

Figure 2.1: Tilting bed experiments (a) before shearing off (b) after shearing off. (Reitema & Piepers,
1990)

The idea of interparticle forces as a stabilizing agent for gas-fluidized beds led Mutsers &
Reitema (1977) to conclude that an elasticity term (E de/dz, where E is the elasticity modulus
of the bed and z is the vertical coordinate) should be added to the solid phase linear momentum
balance equation. They employed Wallis (1969) criterion to show that a fluidized bed is

unstable if:
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(2.7)

where p,, is the particle density, d,, is the particle diameter, u is gas viscosity and ¢ is the void
fraction. Whenever there are perturbations in the bed, such as those arising from gas
fluctuations, hydrodynamic stress is generated in the bed. Reitema (1977) stated that for a bed to

be stable it must have a sufficiently large elasticity to compensate for the stress caused by

perturbations in the bed.

To highlight the solid-like behaviour of Geldart A powders, Donsi et al. (1984) carried out
experiments similar to those of Reitema (1973). They measured the tilting angles of Geldart A
and B powders. They observed for the latter powder that the tilting angle tend to zero when the
particles are fluidized, implying that the upper surface of the bed shears off at minimum
fluidization velocity. Conversely the tilting angle of Geldart A powders takes non-zero values
throughout the period of homogeneous expansion. They explained that the tilting angle of
Geldart B powders becomes zero at minimum fluidization because the particles do not maintain
a network of interparticle contacts when they are fluidized; hence they do not have mechanical
strength that such enduring contacts bring and therefore they bubble as soon as they are
fluidized. Donsi et al. (1984) also measured the angle of internal friction of Group A powders,
starting from the packed state (when the fluid flow rate is zero) to the minimum bubbling point.
They reported that the angle of internal friction measured when the bed is fluidized accounts for
the contribution of cohesive forces in the bed. They could not measure the angle of internal

friction for Group B powders because they bubble as soon as they are fluidized.

Although the above experiments provide evidence that stability of gas-fluidized particles is due
to interparticle forces in the bed, Gilbertson & Yates (1996) expressed doubts on the use of such
experiments for obtaining information on the stability of gas-fluidized beds. They carried out
tilting bed experiments using the same powder investigated by Reitema, but they used metal as

the bed container as opposed to perspex used by the latter author. They reported a radically
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different observation from Reitema: the surface of the bed shears off as soon as the particles are
fluidized. They attributed the difference in observation to the different materials used for the
fluidized bed container. Reitema used Perspex, which is more prone to cause electrostatic
charges within bed. The interparticle forces generated by these charges are sufficient to stabilize
the bed during tilting, thus validating Reitema's conclusions. However, Gilberton & Yates
(1996) reported that Reitema’s results may only be applicable to their experiments and should
not be generalized for all Group A powders. This is because they observed that the angle of tilt
of the bed is different from the angle of tilt of the container. They argued that if the particles are
held together by interparticle forces the two angles should be the same. They concluded that
interparticle forces should not be ruled out as a potent factor responsible for the stability of
Geldart A powders, but they should not be invoked as the sole explanation for their stability.
Although their experiments seem to contradict the solid-like structure of gas-fluidized particles,
they reported that there are possibilities of smaller, temporary structures in the bed due to fluid
dynamic interactions, but they did not provide detailed explanation on the physical mechanisms

governing the evolution of these structures.

Empirical observations on magnetically stabilized beds (MSBs) appear to cast doubt on
Gilberton & Yates (1996) conclusions. In these experiments, interparticle forces are induced on
fluidized particles by applying an external magnetic field. Rosensweig (1979) carried out the
fluidization of magnetisable particles by a gas stream in the presence of a uniformly applied
magnetic field. He reported that fluid dynamic instability due to formation of bubbles was
curtailed. The fluidized suspension expanded uniformly in a manner typical of Geldart A
powders. Visual observations of the bed suggested that the MSB is free of agitation and solid
recirculation, implying that the bed acquired a solid-like structure where particles are held
together in enduring contacts by the magnetically induced interparticle forces. If interparticle
forces did not play a dominant role in the stabilization, as Gilberton & Yates (1996) suggested,
then the application of external magnetic field on the fluidized bed would not result in a
dramatic change in the fluidization behaviour. Figure 2.2 shows Rosensweig’s comparison of
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ordinary fluidized beds and MSBs. Further experimental studies revealed that the fluidity of
MSBs decreases continuously as the magnetic field strength is increased, indicating that the bed
becomes more solid-like. Lee (1983) measured the yield stress in a MSB. He reported that there
is an appreciable yield stress in the bed which increased monotonically as the magnetic field
strength is increased. The yield stress arises owing to the sustained contacts among particles as

the interparticle forces increased.
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Figure 2.2: Comparison between an ordinary fluidized bed and a magnetized fluidized bed

(Rosensweig, 1979)

The dynamics of magnetically fluidized beds, as revealed by Valverde (2003), is controlled by
the balance between the magnetically induced interparticle forces and the drag force. As the
strength of the field increases, particles tend to form chains due to the prevalence of magnetic
attractive forces over the drag force that tends to separate them. Further increase in the magnetic
field strength leads to crowding of these chains of particles, causing the suppression of bubbles.
To further investigate the solid-like structure of gas-fluidized beds, Espin et al. (2011) applied

an external magnetic field to a naturally stabilized bed. They observed that the field does not
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cause a remarkable increase in yield stress as one would expect. The reason for this, they
reported, was that the field was applied when the particles were already fixed and therefore they
were not free to rearrange. Their experimental results showed that interparticle forces provide

the bed with a yield stress that stabilizes it, thus delaying the formation of bubbles.

Tsinontides & Jackson (1993) investigated the stability of gas-fluidized beds by carrying out
fluidization and defluidization of FCC particles. They measured the pressure drop and bed
height as a function of superficial gas velocity. Their measurements revealed hysteresis between
the fluidization and defluidization pressure drop and bed height curves. This strongly suggests
the existence of compressive yield stress in the particle assembly which forms the expanded
bed. Tsinontides & Jackson also demonstrated that the fluidized particles behave like a weak
solid with an effective elastic modulus, revealing a solid-like behaviour of fluidized systems. To
do this, they slowly increased the superficial gas velocity of a partially compacted bed. They
observed no significant change in bed height, signifying that the bed has an ability to resist
compression and confirming that it has a measure of elasticity arising from the sustained
contacts among particles. Similar conclusions were made by several authors; see for instance
Loezos et al., 2002; Srivastava & Sundaresan, 2002; Jackson, 2000. Tsinontides & Jackson
measured the axial solid volume fraction along in the bed using a high resolution gamma-ray
densitometer. Their measurements showed that a solid volume fraction profile developed along

the vertical bed axis, implying that the particles are in contact and a finite yield stress exists.

To further demonstrate the existence of yield stresses in a homogeneous gas-fluidized bed,
Menon & Durian (1997) studied the motion of particles in a gas-fluidized bed. They measured
the reflection of laser light from fluidized glass beads using diffusion-wave spectroscopy. They
found no fluctuations in the interval of stable expansion. Their results revealed the presence of
enduring contacts among particles due to the existence of interparticle forces in the bed.
Fluctuations in particle motion, according to Reitema (1973), can only be initiated by instability
due to bubbling. This observation revealed that the homogeneous state of the bed behaves like a
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weak solid, supporting the solid-like behaviour of Geldart A powders. Similar measurements
were made by Cody et al. (1996). They measured bed expansion and shot noise due to particle
impacts on the wall of a bed of FCC powder. They reported that the bed was completely silent
in the stable interval of homogeneous expansion until the superficial gas velocity reached a

certain critical value.

The fundamental role of interparticle forces in stabilizing the fluidization of Geldart A powders
was demonstrated by Marzocchella & Salatino (2004). They fluidized the particles using carbon
dioxide at pressures ranging from subcritical to supercritical conditions. As they varied the
pressure, the fluid density changed from the values typical of gases to those of liquids, and
hence the fluid dynamic behaviour of the bed changed. They observed that the increase in fluid
density causes the interval of bubble-free expansion to be extended. They carried out a
statistical analysis of the heat transfer coefficient fluctuations in the bed. The analysis revealed a
negligible fluctuation in the interval of homogeneous expansion, signifying that particle
mobility is substantially hindered at superficial gas velocities within the range of homogeneous

expansion. This observation supports the solid-like behaviour of Geldart A powders.

The solid-like behaviour of Geldart A powders is not only demonstrated by experimental
investigations. Koch & Sangani (1999) studied the behaviour of Geldart A powders using the
kinetic theory. They derived the particle-phase pressure for a homogeneous suspension of
particles, and carried out a linear stability analysis of the system. Their results indicated that a
gas-fluidized bed where there are no enduring particle contacts is also always unstable. This led
them to conclude that bubbling can only be restrained by a solid-like behaviour of expanded
beds.

Similarly, Fortes et al. (1998) used a theoretical approach to provide further insight into the
solid-like behaviour of Geldart A powders. They adopted the Eulerian-Eulerian modelling
approach to describe the fluidized suspension. The results of their investigation show that the
stability of Geldart A powders has two distinct origins: one that is fluid dynamic, arising from
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the interactions between the solid and fluid phases, and one that is not, arising from interparticle
forces. Their results also revealed that the latter are responsible for the formation of clusters in

gas-fluidized beds and deposition of particles on the vertical walls of the bed.

Ye et al. (2005) investigated the influence of interparticle forces on the fluidization behaviour of
Geldart A powders using the Discrete Element Methods (DEM). They modelled the interparticle
forces by adopting the Hamaker expression for van der Waals force between two spheres. They
reported that interparticle van der Waals force delays the transition from homogeneous to
bubbling regime. In particular, they noted that the minimum bubbling velocity increases as the
granular bond number (the ratio of interparticle forces to the weight of a particle) increases,

signifying that bubbling is delayed because the interparticle forces are increased.

Experimental and theoretical investigations such as those reported above provide evidence that
homogeneous gas-fluidized particles maintain a network of enduring contacts which stabilizes
the bed against small perturbations. The bed thus behaves like a weak solid with an effective
elastic modulus, having ability to resist compression. In contrast to the solid-like behaviour of
gas-fluidized Geldart A powders, most beds of granular material fluidized by liquids exhibit a
non-bubbling fluid-like behaviour; they expand homogeneously without having any form of
enduring particle contacts. Therefore gas-fluidized and liquid-fluidized beds are considered as
systems displaying a radically different behaviour. However, experimental observations show
that gas-fluidization of fine powders also display a non-bubbling fluid-like behaviour. This
observation appears to reconcile the different opinions about the forces responsible for the
stability of gas-fluidized beds; the solid-like behaviour on the one hand supports the idea that
interparticle forces are responsible for the stability, while the fluid-like behaviour strengthens
the view of those ascribing stability to fluid dynamic forces. Before reporting on the fluid-like
behaviour of gas-fluidized fluidized beds, we report its distinctive features in liquid-fluidized

beds.
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2.4 Fluid-like behaviour of particles fluidized by liquids

Generally, granular materials fluidized by liquid display a smooth expansion without formation
of visible bubbles as the fluid velocity is increased. The particles are freely suspended in the
liquid, being fully supported by the upward flow of the latter. Unlike gas-fluidized beds of
Geldart A powders which show solid-like behaviour, liquid-fluidized beds display a fluid-like
behaviour, having in particular no ability to transmit stress through the particulate assembly,
since there are no enduring contacts among the particles. In this condition, the stability of the
fluidized particles is solely due to the fluid dynamic forces arising from the interaction between

the fluid and the particles.

Researchers have made considerable efforts to predict the expansion profiles of liquid-fluidized
beds. These profiles provide the velocity-voidage relationship which is often of great interest in
fluidized bed applications. Numerous empirical and semi-empirical correlations have been
developed for the velocity-voidage relationship in liquid-fluidized beds. Most of these
correlations, summarized by Jamialahmadi & Mauller-Steinhagen (1992), are reported in Table
2.1. Most of the correlations reported in Table 2.1 are applicable over a restricted range of
Reynolds number, except for the Richardson & Zaki (1954) equation which covers the fluid
dynamic regime from viscous to inertial flow. The Richardson & Zaki (1954) equation is the
most widely used of all; hence we will place more emphasis on it. Although it was developed
for particles falling in a stationary liquid under the influence of gravity, it is justifiable to use the
equation for liquid fluidized beds, since sedimentation and fluidization are similar processes
viewed from different frames of reference. When the Richardson & Zaki equation is employed
in fluidization processes, the sedimentation velocity u becomes the superficial liquid velocity.
Over the years, the equation has proved to be accurate in providing an excellent account of

expansion profiles of non-bubbling liquid-fluidized beds.
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Table 2.1: Correlations for predicting bed expansion in liquid-fluidized beds

Author Equation Range of Type
Application of equation
u Re; < 0.2;
Steinour (1944) o= eexp[—4.19(1 — &)] Semi-empirical
‘ £<0.85
u 8 05
Brinkman (1947) —=1+0.75(1-¢) [1 - (1 - 3)] Re, <2 Theoretical
Uy —€
" 11<Re, < 2.6
Lewis et al. (1949) o= g*6s Empirical
t
Hawksley (1951 = &2 ( 25~ ¢) ) Poot < fe =58 Semi-empirical
awksley (1951) w P\ TT 39010y /6a emi-empirica
0.001 < Re, < 0.4
Jottrand (1952) o= 56 Empirical
t
" 2 < Re, < 500
Lewis & Bowerman (1952) | — = 0.9¢%%7 Empirical
t
n = 465+ 20d,/D Re <02
o gn _o.
u, € n= (44 + 18dp/D)Ret 0.03 0.2< Ret<l
Richardson & Zaki (1954 _ Semi-empirical
(1954) n = (44 + 18d,/D)Re, *! 1< Re,< 200 P

Letan (1974)

7
£1.033

U 14015 (Re. %)0'68

n = 4.4Re,~ %! 200 < Re;< 500
n=24 Re,> 500
3—-4501 3 4.5(1 3 3(1 2
— 4, — 3 3 — 3 — —_
Happel (1958) ¥ (1 - )3 +4.5( 85) a-e Re, < 0.2 Theoretical
e 3+2(1—¢)3
u 1
Oliver (1961) = (1-215(1-¢) [1 —0.75(1 —€)3 Re, < 0.4 Semi-empirical
t
u (14 0.15Re*%*)e*S 1.5 < Re, < 2200

Semi-empirical

Foscolo et al. (1983)

u et

u_t=4(1—£)+£3
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u 0.0288Re,
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32



Chapter 2 The stability of gas-fluidized beds 2016

It is important to note that the Richardson & Zaki (1954) equation, and indeed other correlations
reported in Table 2.1, are purely fluid dynamical and entirely unrelated to particle-particle
interactions in the bed. These correlations were derived for monodisperse spherical particles
which are uniformly suspended in the fluid; hence they are appropriate for investigating
fluidized systems manifesting fluid-like behaviour. Nonetheless, as we shall see in Chapter 3,
these equations (in particular the Richardson & Zaki equation) have also been employed to
study the behaviour of gas-fluidized in the solid-like regime, such as those reported in Section

2.2.

Although most liquid-fluidized beds exhibit non-bubbling behaviour, displaying smooth
appearance and expanding progressively as fluid velocity is increased, Anderson & Jackson
(1969) reported a different observation in their liquid-fluidized bed of glass beads. Their
experiment was carried out in a 1.8 m tall cylindrical tube. They observed that the bed of glass
beads was traversed by one-dimensional travelling voidage wavefronts. They observed that the
amplitude of these waves increased exponentially as the distance from the distributor plate
increased, signifying that the bed is by no means uniform beyond a certain extent of bed
expansion. Similar observations were reported by Ham et al. (1990). They studied the
homogeneous fluidization of small particles with liquid. They conducted a wide range of
experiments changing the particle size, particle density and fluid properties. They measured
instabilities in the bed using light extinction technique proposed by Anderson & Jackson (1969).
This technique measures the amount of light attenuation by particles in suspension and uses this
to calculate particle concentration in the bed. Ham et al. (1990) reported that uniform
fluidization exists between the minimum fluidization velocity and a certain critical velocity u,
beyond which the bed began to be unstable with significant particle velocity fluctuations. These
observations made researchers conclude that non-uniform structures (bubbles) do exist also in

liquid-fluidized beds, but they occur very slowly, whereas in gas-fluidized beds the evolution of
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these non-uniform structures occurs very rapidly (Anderson et al., 1995; Glasser et al., 1997;

Homsy, 1998; Duru & Guazzelli, 2002).

Table 2.2: Cases of bubbling behaviour in liquid-fluidized beds

Author

Powder

Experimental method

Observations

Wilhelm &  Kwauk

(1948)

1.3mm lead shot

Visual observations

Bubbling and intermittent
motion

Peck & Watkins (1956)

7mm glass beads

Visual observations

Bubbling fluidization with
pockets of water

Hanratty & Bandukwala
(1957)

0.56mm steel spheres

Visual observations

Motion of solids similar to
gas-solid systems

Cairns &  Prausnitz | 3mm glass and lead | Visual observations Bubbling and void waves

(1960) spheres moving upwards

Harrison et al. (1961) 0.7mm lead shot Visual and still | Bubbling behaviour
photographs

Hasset (1961a,b) 1-1.5mm glass ballotini Visual and still | Partial voids and bubbles
photographs observed

Kelly (1961) 9-19mm steel ball Gamma rays absorption Slugging bed with large

density fluctuations

Simpson & Roger (1961)

1.71mm lead shot

Visual observations

Lens-shaped bubbles at the
bed wall and top

Reuter (1964) 1mm lead shot Photographs Bubble shape similar to
gas-fluidized beds
Volpicelli et al. (1966) 3mm plastic and steel | Photographs Non-uniform particle
spheres distribution

Bicknell
(1967)

& Whitmore

9-12mm resin spheres

Visual observations

Waves of high voidages
travelling upwards

Trupp (1968)

1.2-9.7mm glass and lead
spheres

Visual observation and

high-speed movie

Parvoids for glass bed and
Sloshing of the lead bed

Garside & Al-Dibouni
(1973)

1.8-3mm glass ballotini

Visual observations

Boiling appearance of bed
surface

Kwauk (1973)

0.5-4mm glass spheres

Still photographs

Dense and dilute region
present in the bed

El-Kaissy & Homsy | 0.5-1.4mm glass beads Visual observations and | Horizontal waves and high
(1976) light transmitting | voidage regions measured
techniques

Kmiec (1978) 6mm glass beads Photographs Inhomogeneity in particle
distribution

Didwania & Homsy | 0.5-1.1mm glass beads Light transmission and | Wavy, turbulent and

(1981a) optical scanning bubbling regimes

Dorgelo et al. (1985) 10mm marble Visual observations Slugging behaviour
observed
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The experimental evidence reported above demonstrates that liquid-fluidized beds (in general
fluidized beds in the fluid-like regime) are not uniform over the entire range of bed expansion,
although these non-uniform structures rarely develop into macroscopic bubbles. To the naked
eye, a fluidized bed in the fluid-like regime appears smooth and uniform; nonetheless the
existence of mesoscale non-uniform structures proves that such beds are not really

homogeneous.

The origin of non-uniform structures in liquid-fluidized beds has been associated with particle
inertia, resulting from the relative motion between the fluid and particles. The relative motion
between them is assumed to impart a fluctuating velocity on the particles. The velocity
fluctuations generate a particle phase pressure ps and viscosity ug, both of which are functions
of ¢. This in turn generates an effective elasticity on the particle phase dp,/d¢. If the latter is
greater than zero and is sufficiently large to overcome the destabilization arising from particle
inertia and voidage dependence on the drag, the bed is stable; otherwise the bed becomes

unstable (Sundaresan, 2003).

Although, generally, liquid fluidization of granular materials can be extremely smooth, and in
some cases characterised by the evolution of mesoscale structures, such as those reported in the
preceding paragraphs, it is indeed possible for such beds to exhibit macroscopic bubbling. This
was first observed by Wilhelm & Kwauk (1948) for the fluidization of lead spheres by water.
Since then, several other experimental works which confirmed the bubbling behaviour of liquid-

fluidized beds have been reported in the literature. These are summarized in Table 2.2.

It is interesting to note that the similarity between liquid-fluidized beds and gas-fluidized beds is
quite remarkable. Some liquid-fluidized beds reported in Table 2.2 bubble as soon they are
fluidized; a behaviour typical of Geldart B powders fluidized by gas, while some expand over a

substantial interval of superficial gas velocity before bubbling, similar to what is observed for
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Geldart A powders. In the latter, however, the bubble-free expansion is usually characterised by

solid-like behaviour, while for liquid-fluidized beds the behaviour is completely fluid-like.

2.5 Fluid-like behaviour of fine particles fluidized by gas

We reported in Section 2.2 that gas-fluidization of Geldart A powders results in homogeneous
expansion over an interval of superficial gas velocity. Experimental observations revealed that
such homogeneous expansion is possible because the fluidized particles maintain a network of
enduring contacts. The latter, as said, confers to the bed an effective elastic modulus which
stabilizes the bed against small perturbations and delays their bubbling. The bed therefore
behaves like a weak solid having the ability to resist compression — a behaviour referred to as
solid-like behaviour. In this section we wish to clarify that the solid-like behaviour is not a
necessary condition for the homogeneous gas-fluidization of all kinds of particles. Indeed, as
experimental observations reveal, highly cohesive powders (such as Geldart C powders)
fluidized by gas can exhibit non-bubbling fluid-like behaviour typical of granular materials
fluidized by liquids reported in Section 2.3. However, to achieve this, fluidization assisting
methods need to be used. These methods act in a way to reduce the interparticle forces in the
bed, thus enhancing the fluidization of these highly cohesive powders. Before reporting on the
fluid-like behaviour of gas-fluidized fine particles, we will briefly review the various assisting

methods that have been employed to enhance the fluidization of highly cohesive powders.

2.5.1 Fluidization assisting methods

The assisting methods used in fluidization of highly cohesive powders include the use of
acoustic wave, mechanical vibration, magnetic/electric field, tapered beds and the addition of

foreign materials (also called flow control additives).

2.5.1.1 Sound assisted fluidization
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Morse (1955) was the first author to study the fluidization behaviour of cohesive powders under
the influence of acoustic fields of various sound pressure levels and frequencies. He applied an
acoustic field to the bottom of the bed using loudspeakers. He found that submicron particles
which had shown intense channelling were smoothly fluidized when he applied an acoustic field
with a frequency in the range of 50 to 500 Hz. Other researchers (Chirone et al., 1992, 1993,
Russo et al., 1995; Levy et al.,, 1997; Guo et al., 2005, 2006) have reported enhanced
fluidization with the use of acoustic waves. The common observation among these researchers
is that there is a minimum sound pressure level below which the acoustic field does not have
any effect on the fluidization quality of fine powders. They reported that when the sound
pressure level is below this minimum, the acoustic oscillation strength is not high enough to
initiate fluidization. They also observed that large agglomerates are formed in the bed when the
sound pressure level is very high due to greater collisions between the particles and smaller

agglomerates.

2.5.1.2 Mechanical vibrations

Fluidization of highly cohesive powders has been achieved with the aid of mechanical
vibrations. Dutta & Dullea (1991) used external mechanical vibrations to improve the
fluidization quality of fine powders. Several others (Marring et al., 1994; Noda et al., 1998;
Wank et al., 2001; Tasirin & Anuar, 2001; Mawatari et al., 2002; Xu et al., 2004; Valverde &
Castellanos, 2006; Levy & Celeste, 2006; Harris, 2008; Zhang & Zhao, 2010; Wang et al.,
2010; Kaliyaperumal et al., 2011) have also achieved a smooth fluidization of Geldart C
powders with the aid of mechanical vibrations. Despite the success of this method in enhancing
the fluidization of highly cohesive powders, more research is needed to clarify the effects of

vibration frequency and amplitude on fluidization behaviour (Shabanian et al., 2012).

2.5.1.3 Magnetically assisted fluidization

This method involves the use of oscillating magnetic fields to enhance the fluidization of fine
and ultrafine particles. This method has been generally implemented to enhance either the

37



Chapter 2 The stability of gas-fluidized beds 2016

fluidization of magnetic particles or a mixture of magnetic and non-magnetic particles. To
achieve fluidization, the particles reorganize themselves to form a chain structure along the lines
of the magnetic field. Zhu & Li (1994, 1996) reported that the chain structures block the
channels and eventually eliminate them, allowing for even distribution of gas through the bed

and thus enhancing fluidization.

2.5.1.4 Electrically assisted fluidization

Kashyap et al. (2006, 2008) investigated the influence of electric fields on the fluidization
behaviour of fine particles. They reported that cohesive particles were fluidized with a
considerable bed expansion under the influence of an electric field. The latter breaks the
cohesive forces among the particles, thus enhancing their fluidization. Several others (Valverde,
2008; Quintanilla et al., 2008; Lepek et al., 2010) have also reported improved fluidization of

fine particles with the aid of externally applied electric fields.

2.5.1.5 Centrifugal fluidized beds

Qian et al. (2001) studied the effect of centrifugal force on the fluidization of fine particles
theoretically. They reported that particles belonging to Geldart C classification will manifest
Geldart A behaviour under the action of a centrifugal force. To confirm their theoretical studies,
they fluidized 7um alumina particles (Geldart C powder) in centrifugal fluidized bed operating
at a high rotating speed. They reported that at a sufficiently high speed of rotation, the bed

behaves like a Geldart A powder.

2.5.1.6 Tapered fluidized beds

Vankatesh et al. (1996) showed that using a fluidized bed with a conical base, having an
expanding section along the direction of flow, greatly enhanced the fluidization of fine particles.
Others (Yang, 2005; Tong et al., 2004) have also reported improved fluidization quality with the

use of tapered beds.
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2.5.1.7 Addition of foreign particles

This method has significant advantages over those previously discussed. Most methods
described above are difficult to implement for large-scale applications, requiring significant
modifications to the fluidized bed reactors (Valverde, 2003). Some of these methods are not
economically feasible except for selected applications, for instance the use of external
mechanical vibrations and oscillating magnetic field (Ajbar et al., 2011). Addition of foreign
particles however does not need any change to the reactor. This method can be used for a wide
range of particle size, shape and density (Zhou & Li, 1999; Song et al., 2009; Ajbar et al.,
2005). Owing to the advantages of this method over others, it has been widely adopted to

investigate the fluid-like behaviour of fine powders.

Valverde et al. (2001) investigated the non-bubbling fluid-like behaviour of gas-fluidized beds
by adding foreign particles, to which they referred as flow control additives, to the fine powder.
Their investigations revealed that the non-bubbling fluidization of these conditioned powders
exhibit both solid-like (the Geldart A behaviour reported in Section 2.2) and fluid-like (the
general behaviour of liquid-fluidized beds reported in Section 2.3) behaviour. They reported that
the solid-like behaviour was observed at superficial gas velocities below a critical value v, and
the fluid-like behaviour was observed for higher values of the superficial gas velocity. To
demonstrate this, they fluidized toner powders of two different colours — yellow and magenta,
having mean size of 8.53um. To enhance their fluidization, the powders were conditioned by
adding flow control additives. They placed the powders in a container divided into two equal
halves by a vertical removable partition; the magenta powder on one side and the yellow
powder on the other side of the partition. The powders were then subjected to an upward flow of
air. When the powders were fluidized, the partition was carefully removed. For values of
superficial gas velocities below v, no mixing was observed between the yellow and magenta
powders, signifying that the particles were held in permanent contacts — a solid like behaviour.

In this condition, they observed that the gas pressure drop was below the weight of the particles
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per cross sectional area, implying that a fraction of particles derive support from their mutual
permanent contacts and that the bed has a certain measure of mechanical strength. To further
confirm this, they did a similar experiment to Reitema (1973). They tilted the bed slowly and
observed that the bed remained stable while its upper surface was also tilted. When the
superficial gas velocity was increased above vy, a radically different behaviour was observed.
Even though the bed did not manifest bubbling behaviour, the yellow and magenta powders
mixed successfully. The bed weight was fully supported by the gas flow; the gas pressure drop
being exactly equal to the bed weight per cross sectional area. In this state, stresses due to
enduring interparticle contacts vanished. Stresses in the bed were now generated by collisions
among the particles due to fluctuations in their motion and the non-bubbling fluidized state is
purely a result of fluid dynamic interactions in the bed, as in the case of liquid-fluidized beds
discussed in the preceding section. Valverde et al. (2001) reports that the non-bubbling fluid-
like bed has some properties of a liquid. For instance, when the bed enters the fluid-like regime,
its upper surface remains horizontal when it was tilted just like one would expect a liquid to
behave. They also measured the diffusion coefficient of magenta powder as it mixes with the
yellow powder. They reported that the diffusion coefficient is a strong function of superficial

gas velocity, increasing exponentially with the latter.

Valverde (2003) investigated the effect of particle size on the fluid-like regime of gas-fluidized
powders. They reported that the range of superficial gas velocity in which the bed manifests
fluid-like behaviour increased as the particle size reduces. From their results they sought to
establish a link between the two agents of stabilization proposed for gas-fluidized beds — fluid
dynamic and interparticle forces. They reported that the reduction in the extent of fluid-like
regime as the particle size is increased revealed the reduced contribution of fluid dynamic forces
on bed stability. They observed that when the particle size is such that the granular Bond
number was B, < 1, the fluid-like regime disappeared completely, indicating that the stability
of the bed is due to enduring contacts in the particulate assembly. The fluidization behaviour is

now similar to what one observes in the fluidization of Geldart A powders.
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The non-bubbling fluid-like behaviour of gas-fluidized beds is quite similar to the fluid-like
behaviour of liquid-fluidized beds. In the latter, as reported in Section 2.3, the absence of
macroscopic bubbling does not necessarily mean that the bed is stable (Homsy, 1998; Jackson,
2000; Duru & Guazzelli, 2002). Similarly, the smooth expansion of gas-fluidized bed in the
fluid-like regime does not mean that the bed is stable. Experimental observations by Valverde
(2003) revealed the existence of mesoscale structures in the bed. As they increased the
superficial gas velocity the number of local voids detected in the bed increased until the bed
enters the bubbling regime. Furthermore density fluctuations, measured by fluctuations in light
reflectance, increase with bed height for values of gas velocities below the minimum bubbling
velocity. For velocities above the latter, these fluctuations continue to grow without limit. A
similar result was obtained by Duru & Guazzelli (2002) by direct visualization of liquid-

fluidized beds.

Although there are similarities between non-bubbling fluid-like regime of gas-fluidized beds
and liquid-fluidized beds, we should note that one striking difference exists. The non-bubbling
fluid-like regime of fine powders is characterised by the dynamic aggregation of freely
suspended particles. The aggregation is caused by attractions among the particles, which make
them form light aggregates in the suspension. The size of the aggregates, according to
Castellanos (2005), is dictated by the dynamic equilibrium between the interparticle forces and
the flow shear on the surface of aggregates. The fluid-like regime of gas-fluidized beds of fine
particles therefore consists of light aggregates uniformly suspended in the fluid. This type of
dynamic aggregates has not been reported for liquid-fluidized beds, raising a question of
whether the empirical correlations reported in Section 2.3 can be employed to investigate the

fluid dynamic behaviour of non-bubbling fluid-like gas-fluidized beds.

Castellanos (2005) investigated the sedimentation of a gas-fluidized bed in the non-bubbling
fluid-like regime using a modified Richardson & Zaki (1954) equation. The latter has to be
modified to account for the presence of clusters. Castellanos (2005) described the settling

velocity of the aggregates using the following equation:
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u=ug(l—¢g)" (2.8)

where u is the superficial gas velocity, u, is the terminal settling velocity of individual
aggregates, ¢, is the volume fraction of aggregates and n is the Richardson & Zaki exponent.
The terminal settling velocity of individual aggregates u, and the volume fraction of aggregates

¢, are expressed in terms of the number of particle N per aggregate as follows:

uq = uN/k; ¢g = pk3/N (2.9)
where k is the average ratio of aggregate size to particle size, u, is the terminal settling velocity
of a particle and ¢ is the particle volume fraction. If we substitute Eq.2.9 into Eg.2.8 we obtain:

v N 1 ¢k3n 2.10
u—t—z< _T> (210)

Eqg. 3.0 is the modified Richardson & Zaki (1954) equation for investigating the non-bubbling

fluid-like behaviour of fine powders.

2.6 Conclusions

There has been a long controversy regarding the mechanism responsible for the stability of
Geldart A powders. On one side of the argument are those proposing that fluid dynamic forces
are responsible for the stability, on the other side others ascribed the stability to the existence of
interparticle forces in the bed. Experimental observations revealed that gas-fluidized beds of
Geldart A powders have an effective elastic modulus which stabilizes the bed against small
perturbations. The elastic modulus arises because particles in the bed form a network of
enduring contacts which confers to the bed a certain mechanical strength which allows the
particles to be stable over a certain range of superficial gas velocity before transiting to
bubbling; a behaviour referred to as solid-like. The solid-like behaviour strengthens the idea that
interparticle forces are responsible for the stability of Geldart A powders. The solid-like
behaviour of gas-fluidized particles is different from the fluid-like behaviour observed in liquid-

fluidized beds. In liquid-fluidized beds particles are uniformly suspended in the fluid and
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enduring particle contacts are absent. In the fluid-like state, the stability of the bed is purely a

result of fluid dynamic forces arising from fluid-particle interactions.

Valverde (2001) sought to reconcile the arguments on the stabilizing agents of gas-fluidized
beds. He demonstrated that the homogeneous regime of gas-fluidized particles consists of both
solid-like and fluid-like regimes. The latter prevails when the superficial gas velocity is
increased above a certain critical value, and the bed is fluidized in a manner similar to liquid-
fluidized beds. He showed that the extent of the fluid-like regime reduces as the particle size
increases; most gas-fluidized beds of Geldart A particles are fluidized in the solid-like regime.
In the following chapter the behaviour of this class of powder is studied more closely using

theoretical and experimental methods.
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Chapter 3

Theoretical and experimental investigation

of the behaviour of homogeneous
gas-fluidized beds

This chapter is concerned with an investigation on the mechanics of homogeneous expansion in

gas-fluidized beds using experimental and theoretical approaches.

1.

We recap some salient points raised in Chapter 2 regarding the solid-like behaviour of
gas-fluidized powders.

We introduce the Richardson & Zaki (1954) equation, discussing on its ability to
describe the expansion profiles in gas-fluidized beds.

We describe the process of fluidization and defluidization in gas-fluidized beds.

We model the homogeneous expansion in gas-fluidized beds using a linear momentum
balance equation, and accounting for enduring contacts among the particles.

We perform fluidization and defluidization experiments to validate our numerical

results.

Parts of this chapter have been published:

Oke, O., Lettieri, P., Mazzei, L. (2015). An investigation on the mechanics of homogeneous

expansion in gas-fluidized beds. Chemical Engineering Science, 127, 95-105.
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3.1 Introduction

Gas-fluidized beds of Geldart A powders manifest homogeneous expansion over a certain range
of superficial gas velocity before transiting to the bubbling regime. Experimental observations
have shown that this behaviour results from enduring particle contacts which confers to the bed
a measure of mechanical strength which stabilizes it and therefore delays its bubbling.
Conversely, for most gas-fluidized beds such enduring contacts are absent and therefore they
bubble as soon as they are fluidized. These considerations have been reported in Chapter 2. In
this chapter we intend to provide further insight into the stable behaviour of cohesive
homogeneous gas-fluidized beds. We believe that the effect of cohesiveness in such beds is
reflected by the presence of enduring contacts among the particles. These enduring contacts are
characteristic of the homogeneous gas-fluidized beds in the solid-like regime; therefore we
focus our analysis on it. To do this, we carried out fluidization and defluidization experiments,
analysing the results using the Richardson & Zaki (1954) equation. We believe that such
experiments will further give us insight into the behaviour of homogeneous gas-fluidized beds.
In our analysis we also employed the linear momentum balance equation proposed by Jackson
(2000), which accounts for enduring contacts among the particles, to investigate the stable
behaviour of gas-fluidized particles. In what follows, we briefly review the Richardson & Zaki
equation, discussing on its ability to predict the expansion profiles of gas-fluidized beds.

3.2 The Richardson & Zaki (1954) equation and homogeneous expansion of gas-fluidized
beds

The expansion characteristics of homogeneous fluidized beds have been of great interest to
researchers. This is because knowing the expansion of a fluidized bed is crucial to its design and
operation. For liquid-fluidized beds, many empirical and semi-empirical correlations have been
developed to predict the expansion profiles (refer to Table 2.1 in Chapter 2). The most widely

used of these correlations is the Richardson & Zaki (1954) equation; a simple, but powerful
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equation that correctly captures bed expansion over the entire fluid-dynamic regime from

viscous to inertial flow. The equation reads:
u=ue" (3.1)

where n is an empirical parameter which depends on the free fall particle Reynolds number Re;,
and u; is the unhindered terminal settling velocity of the particles. Several correlations have
been proposed for determining the value of n. In particular, we report the empirical relationship

proposed by Rowe (1987), which we used in this work:

A+ B x0.175Re,3/*
1+ 0.175Re,>/*

n(Re;) = (3.2)

Here A and B are the values ascribed to n in the limits of viscous and inertial regimes,
respectively. Richardson & Zaki (1954) take A and B to be equal to 4.65 and 2.39, respectively;
Rowe (1987) employs the values of 4.70 and 2.35, while Khan & Richardson (1989) and
Gibiliaro (2001) use 4.80 and 2.40. The unhindered terminal settling velocity u;, on the other

hand, can be obtained in the creeping flow regime using the well-known Stokes equation:

_(pp = pr)gdy”

= 33

Here uy and p; are the viscosity and density of the fluid, respectively, d,, and p,, are the particle
diameter and density, respectively, and g is the gravitational acceleration. Other expressions
have been suggested as an improvement to the Richardson & Zaki (1954) equation, but their
ability to predict the expansion profiles of homogeneous fluidized beds do not differ
significantly from the latter (see for instance Garside & Al-Dibouni, 1977; Riba & Couderc,

1977; Hirata & Bulos, 1990).

The Richardson & Zaki (1954) equation and the correlations proposed for estimating the
exponent n are found to hold for liquid-fluidized systems, where they are very accurate in
providing an excellent account of the expansion profiles of such systems. The values of the

parameter n in such systems range from 2.35 to 4.8 in the limits of inertial and viscous regimes.
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But questions were raised regarding the applicability of this correlation to gas-fluidized systems.
While trying to answer these questions, Godard & Richardson (1968) conducted several
experiments on powders fluidized by air and characterized by extremely narrow size
distributions. They found that the relationship between the superficial fluid velocity and the
void fraction could be expressed in the Richardson & Zaki form, given in Eq. 3.1; however, the
values of the exponent n for all the powders tested were found to be greater than those predicted
by Eqg. 3.2. They also found that the values of the parameter u; determined by extrapolating the
logarithmic void fraction-velocity plots were greater than the terminal velocity of the particles.
To emphasize this, we shall denote these experimental values as n* and u;*. The latter, as said,
differ from the fluid dynamic values of n and u; observed in liquid-fluidized beds and

predicted by Egs. 3.2 and 3.3, respectively.

Lettieri et al. (2002) studied the homogeneous bed expansion of FCC catalysts fluidized by
gases at high temperatures. They employed the Richardson & Zaki equation to describe the
homogeneous expansion of these particles, estimating the values of the parameters in the
equation. These values were compared with those of n and u, predicted by Egs. 3.2 and 3.3,
respectively; for all the FCC catalysts considered, they found that the former (that is, n*
and u;*) were much higher than the latter (that is, n and u;). They attributed this to the

formation of clusters in the bed, which are caused by the presence of interparticle forces.

In the same vein, Geldart & Wong (1984, 1985) investigated the bed expansion characteristics
of Group A powders. They fluidized different materials with different gases and found the
values of n* between 4 and 60, showing that materials with higher cohesiveness have greater
values of the exponent. The summary of their experimental work is reported in Table 3.1.
Moreover, they observed that in non-cohesive systems, the value of the terminal velocity given
by the Stokes equation is very close to that extrapolated from the logarithmic plot of the

Richardson & Zaki equation, whereas for cohesive systems it is greater.
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Table 3.1: Richardson & Zaki (1954) exponent (Geldart & Wong, 1984)

Fluid Powder Type Geldart Group n
Air a320 — N AC 6.60
a320 -0 A 6.82
a360 AC 12.24
A4 AC 7.55
FRF5 A 5.21
FRF20 C 15.75
FRF40 C 60.00
FRF85 C 51.00
9G4 A 4.38
CI A 5.95
11 A 4.00
F0.3 A 7.76
F3/7 A 5.19
FSG A 4.96
F2/5 A 4.48
Lactose Cc 35.03
Nitrogen a320 - N AC 6.61
A4 AC 7.55
9G4 A 5.20
FRF5 A 4.38
Ccl A 5.91
B20 A 5.50
Arction - 12 Al AC 8.00
FRF5 A 7.21
B20 A 5.21

All the foregoing experimental evidence, and much more not reported here, allow us to
conclude that the Richardson & Zaki equation is capable of describing the bed expansion of gas-
fluidized particles, but the values of the equation parameters are greater than those required for
liquid-fluidized systems (in general, fluidized systems in which fluid dynamic forces dominate
over interparticle forces). Researchers have presented compelling experimental evidence to
show that the greater values obtained for the parameters are indications of the presence of

interparticle forces. For instance, Geldart & Wong (1984) correlated the n / 4.65 to the Hausner
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ratio, pp;. /p.p (Where pp; is the bulk density of the powder under prolonged tapping and p; p is
the bulk density obtained under loose packing condition). The higher the Hausner ratio, the
more significant is the role of interparticle cohesive forces. Similarly, Lettieri et al. (2002)
reported an increase in the value of n with temperature. These observations appear to support

the idea that these forces play a crucial role in the stabilization of gas-fluidized fine powders.

We should note that the expansion of non-cohesive homogeneous powders depends only on the
drag force exerted by the fluid on the particles, in addition to the effective weight of the latter;
as a consequence, the values of n and u, (which refer to liquid-fluidized beds, in which
interparticle forces are negligible compared to their fluid dynamic counterpart) are directly
related to the drag force magnitude. Conversely, the expansion of cohesive powders depends not
only on the fluid dynamic forces just mentioned, but also on the forces that the particles exert on
one another; accordingly, the values of n* and u,* (which refer to gas-fluidized beds, in which
interparticle forces are often as important as their fluid dynamic counterpart) lump together the
effects of both forces and are not directly related only to the drag force magnitude. This

observation is important when one intends to model the drag force.

In this chapter, our goal is to investigate the homogeneous regime in gas-fluidized beds,
intending to show that the stress transmitted through sustained contacts among particles plays a
role in the bed homogeneous behaviour and is responsible for the higher values of n* and u;*
observed experimentally for fine particles. To this end, we employed a theoretical model to
analyse the expansion of gas-fluidized powders, taking into consideration enduring particle-
particle contacts. We used the model to determine the axial void fraction profiles through the
bed at different superficial gas velocities. By plotting the mean void fraction against the
superficial gas velocity in the Richardson & Zaki form, we then computed the values of the
parametersn and u; which appear in the correlation. We then conducted fluidization and

defluidization experiments to validate our theoretical results. Before presenting the model, we
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briefly report on the processes of fluidization and defluidization, on which the remaining part of

this work focuses.

3.3 The processes of fluidization and defluidization of fine particles

In describing these processes, we find it more convenient to examine defluidization first.
Consider a fluid bed of small, light particles, such as those belonging to Group A of the Geldart
(1973) classification. We assume that the bed is homogeneous and in the fluid-like regime, so
that no enduring contacts are present among the particles. These, in consequence, are fully
supported by the fluid. Being the bed homogeneous, the volume fraction of solid, denoted as ¢,
is uniform throughout it. If we slightly decrease the fluid flow rate, the bed contracts, remaining
uniform and in the fluid-like regime, until ¢ attains the value needed by the drag force to
balance the effective weight of the bed. If we continue to decrease the fluid flow rate, the
volume fraction of solid will eventually reach a value ¢.,;, at which the granular material is
able to resist compression. When the bed reaches this compaction, it enters the solid-like
regime, in which particles do form enduring contacts and the bed starts behaving like a weak
solid. The more ¢ exceeds the value ¢,,,;, (that is, the more compact the bed), the larger the
stress needed to cause compressive yield (that is, further bed compaction). We assume that the
compressive yield stress tends to infinity at some value ¢,,,,; When the bed reaches this
compaction, it cannot compact further, no matter how large the compressive stress to which it is
subjected becomes. Hence, with Tsinontides & Jackson (1993), we can model the compressive

yield stress using the following constitutive equation:

( - min)a
O-c((.b) = C(ini—_(w, Pmin < P < Pmax

=0 ¢ < ¢min (34)
where a, b and c are positive constants which must be determined experimentally. As

said, ¢min denotes the lowest solid volume fraction at which the assembly of particles is

capable of supporting stress through a structure of enduring contacts, whilst ¢, denotes the
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highest solid volume fraction that one can obtain in a defluidization process without resorting to
mechanical means. The interval between ¢,.x and ¢ iS largely determined by the
cohesiveness of the material. For large, smooth, non-cohesive particles, such as those belonging
to Groups B and D of the Geldart (1973) classification, ¢ax and ¢nin are very close; this is
because particles are brought to random close packing under very small compressive stress,
insofar as they are unable to form a network of enduring contacts. For small, rough, cohesive
particles, which are able to form such a network, the interval between ¢,,.x and ¢,in is instead
much larger. These groups of particles are able to form extended structures which can resist
compressive stress over a broader range of particle concentration. This might explain why,
during fluidization, they can expand homogeneously over a wide range of superficial gas
velocity before transiting to the bubbling fluidization regime. In this work, we focus on this

second group of particles.

When the bed enters the solid-like regime, its structure is uniform — the solid volume fraction
being equal to ¢, everywhere. In this condition, the bed is still fully supported by the fluid.
But when the fluid flow rate is decreased further, the bed compacts non-uniformly, the mean
bulk density increasing progressively from the top of the bed to its bottom: a solid volume
fraction profile develops along the vertical bed axis. In particular, if we assume that the bed is
in a condition of incipient yield everywhere, in each location the solid volume fraction takes the
value required by the compressive yield stress to equate the compressive stress present at that
location. The bed is only partially fluidized, being partly supported by the distributor plate and
partly by the frictional forces acting between the walls of the vessel and the particles. And even
if the bed may look homogeneous to the naked eye, it is not. When the fluid flow rate vanishes,
the bed is completely defluidized and fully supported by the distributor plate and the vessel
walls; also in this case, the bed is inhomogeneous, the solid volume fraction increasing towards

the bed bottom.

Consider now the bed of granular material that is resting on the distributor plate. If an upward

flow of gas is established, the bed structure, and in particular the solid volume fraction profile
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along the vertical axis of the bed, initially remains unchanged, the pressure drop through the bed
rises, and the particles become partly supported by the drag force exerted on them by the fluid.
At a sufficiently large flow rate, the bed weight is entirely supported by the drag force, but in
general the bed retains its structure, without dilating (in other words, it does not fluidize). A
further increase in gas flow rate generates tensile stress within the granular material. When the
latter exceeds the tensile yield stress which the material may sustain, the bed breaks and
fluidization begins. When this happens, the pressure drop, and hence the drag force, is equal to
the sum of the weight of the bed and the tensile yield stress which must be exceeded before the

bed dilates (Tsinontides & Jackson, 1993; Watson et al., 2001).

The condition for the bed to dilate, according to Tsinontides & Jackson (1993), is first met at the
contact surface between the bed and the distributor plate; thus, the fluidization process
commences by the fracture of the bed at its lowest point. When this happens, the stress at the
bottom and top of the bed vanishes and the bed accelerates upwards. The acceleration is caused
by the imbalance between the bed weight and the drag force; the latter, as said, is greater than
the former when the bed detaches from the distributor plate. As the bed travels upwards, its
bottom part, which is a free surface, gradually erodes, generating a rain of particles behind it.
These particles recompact to form a new, more dilute bed. While the fluid flow rate is kept
constant, the original packed bed continues to travel upward, gradually becoming shorter in
length as its lower region progressively disappears, until it is entirely replaced by the new bed.
This dynamic process is complex, and since we also lack an exact understanding of the
mechanics of erosion, predicting how the newly-formed bed is structured (particularly, how the
solid volume fraction varies along the bed axis) is not possible. We do not expect the bed to be
at incipient yield conditions, but nothing can guarantee that it is fully supported by the fluid

(and therefore fully fluidized).

The above description presents a contrary view to the conventional idea that sees fluidization as
a uniform dilation process taking place throughout the particle assembly. It also makes us regard

homogeneous beds differently, not necessarily as systems with uniform solid volume fraction
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which are entirely supported by the fluid: this is only observed in beds that are in the fluid-like
regime. More often, homogeneous beds are in the solid-like regime, and so are only partly
fluidized, presenting a solid volume fraction gradient along the bed axis. Homogeneous beds do
not always consist of particles which float freely in the fluid with no form of particle-particle
contact. The presence of structures of sustained particle contacts in uniform beds presents a
view that has to be further investigated. One often uses the Richardson & Zaki (1954) equation
to describe the bed expansion of any kind of homogeneous bed, although the equation was
derived merely for beds in the fluid-like regime, in which interparticle forces are absent or
negligible. Also this aspect has to be investigated in more detail. This is what we now intend to

do.

3.4 Theoretical analysis

The Eulerian averaged equations of motion have been used extensively to study the dynamics of
fluidized particles (Oke et al., 2015; Mazzei et al., 2010; Mazzei et al., 2008; Lettieri & Mazzei,
2009; Owoyemi et al., 2007). These equations, reported hereunder, express the conservation of
mass and linear momentum for the solid and fluid phases. Here we intend to use them, making
necessary assumptions and simplifications, to investigate the homogeneous expansion in gas-
fluidized beds. As said, solid-like homogeneous expansion occurs when the particles are able to
form a network of enduring contacts; these contacts confer mechanical strength to the bed,
making the latter expand over a range of fluid flow rates before the onset of bubbling. The

averaged equations of motion for the fluid phase are:

oe
a +V- (suf) =0 (35)
d(euy)
Pr atf +prV - (eupup) =V-Sp—n,f +eprg (3.6)

Those for the solid phase are:

d¢
TR (pu,) =0 3.7)
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?
Py ((g:f”) +ppV - (puyw,) = V- S, +nyf + dp,g (3.8)

Here ¢, ¢, pf, pp, Uy, Up, Sy and S, are, respectively, the volume fractions, densities, mean
velocities and effective stress tensors for the fluid and particle phases; n,, is the particle number

density, g is the gravitational acceleration vector and f is the interaction force per unit particle

exerted by the fluid phase on the particle phase.

To apply these equations in our case, we refer to the processes of fluidization and defluidization
described in the previous section. At each stage of fluidization or defluidization, the particulate
assembly is assumed to be in an equilibrium state, so that the local mean value of the particle
velocity is zero everywhere in the bed. This is what we try to achieve in fluidization and
defluidization experiments when, at each increase or decrease of fluid flow rate, we wait for a
certain period of time to allow the bed to attain fluid dynamic equilibrium before taking
measurements. If the local average velocity of the particles vanishes, the linear momentum
balance equation for the solid phase reduces to a force balance that one obtains by setting the

left-hand side of Eq. 3.8 to zero:
V-S,+n,f+dp,g=0 (3.9)

The first term in Eg. 3.9 has two major contributions: the stress transmitted through contact
forces o and that generated by collisions and momentum transfer owing to fluctuations in
particle velocity around its local average (Jackson, 2000). Several authors have examined the
magnitude of the contribution of the latter stress to S, in beds operating in the solid-like regime
(see, for instance, Cody et al., 1996 and Menon & Durian, 1997). They measured the particle
granular temperature, because this provides a direct indication about the contribution of
collisional and kinetic stress to the total stress S,,. Cody et al. (1996) measured bed expansion
and shot noise resulting from the collisions of particles against the vessel walls. Their results
revealed that, over a substantial range of bed expansion, the bed is completely silent, indicating
that the contributions of collisional and kinetic stress are negligibly small. This observation is

consistent with the conclusion of Tsinontides & Jackson (1993) that particle assemblies form a
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network of enduring contacts that stabilizes the bed throughout the range of solid-like
homogeneous expansion, and demonstrates that stress transmitted through enduring particle
contacts plays a major role in stabilizing gas-fluidized suspensions, contributing significantly to
the effective stress tensor of the particulate phase. So, in the present considerations, we neglect
the contributions of kinetic and collisional stress, considering only the stress transmitted through

particle-particle contacts.

Let us consider again the processes of homogeneous fluidization and defluidization of particles
in a vessel of diameter D. We assume that the particles are constrained to move in one

dimension; thus, we consider only the component of S, = ¢ acting on the planes normal to the

direction of motion: the normal stress . This represents the stress transmitted through a
network of enduring particle contacts. If we account for the frictional force between the

particles and the vessel walls, Eq. 3.9 becomes:

do

4
1, T oo = bpg —pf (3.10)

Eqg. 3.10 is a force balance in the z-direction, assumed to be vertical, for a particle assembly in
the regime of stable bed expansion. In Eq. 3.10, o is the zz-component of the stress, z is the
vertical coordinate measured downwards from the upper surface of the bed, D is the bed
diameter, u is the coefficient of wall friction, j is the Janssen coefficient, while u is the

superficial velocity of the fluid.

The first term on the left-hand side of Eq. 3.10 relates to the forces transmitted via particle-
particle contacts. In this work, we aim to investigate how their presence influences the
behaviour of the bed, in particular its homogeneous expansion. The second term represents the
frictional force exerted on the particle assembly by the walls of the vessel containing the fluid
bed; the positive sign applies to the defluidization process, in which the bed slowly
consolidates, while the negative sign applies to the fluidization process. The first term on the
right-hand side is the gravitational force acting on the particles, while the second term models

the fluid-particle interaction force. With Jackson (2000), we consider the drag and buoyancy
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forces to be the main contributors to npf; hence, other contributions, such as lift or virtual mass
forces, are neglected. The constitutive equation used to model the fluid-particle interaction force
is:

_dpp—pPr)g u
npf = A-o" w + ¢prg (3.11)

where u; is the unhindered terminal settling velocity of a particle and n is the fluid dynamic
Richardson & Zaki (1954) exponent. The first term of Eq. 3.11 represents the drag force
component of the fluid-particle interaction force, while the second term is the buoyancy force.
We point out that the hydrodynamic value of n is used because the drag force is hydrodynamic
and entirely unrelated to particle-particle interaction forces. If we employed the experimental
value of n in Eq.3.11, we would no longer be modelling the drag force: we would be modelling
an ‘effective force’ that combines the drag and interparticle forces — this has been mentioned in
Section 3.2. Therefore, to calculate the value of n in Eq. 3.11, we employed Eqg. 3.2, which is

purely fluid dynamical and unrelated to particle-particle contacts.

The force balance on the fluid phase yields:

dp _ ¢(pp—pr)g u
pEiircers el (3.12)
where p is the fluid pressure. If we combine Eg. 3.10 and 3.11, we obtain the following

equation:

do 4 | 1 u
=, Yoo =60y —pg [1 “d-erw (3.13)

In Eqg. 3.13 there are two unknown functions: o(z) and ¢(z). To find the solid volume fraction
profile ¢(z) in the bed, we need to express the normal stress ¢ as a function of ¢» and then
substitute this expression in the linear momentum balance equation. During defluidization, the
variables ¢ and ¢ are related, if we assume that the bed is in conditions of incipient yield

everywhere; thus, following Tsinontides & Jackson (1993), we can employ Eq. 3.4. In Section
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3.5, we will report how we obtained the values of the constants in the equation. Consequently,

for a defluidization process, we can write:

dp dofdoy™t Lon 1 4  yrdo1™ 314
- dz %] = {(Pp Pf)f;bg[ u_t—(l—cp)"] 5#]0} E] (3.14)
where the derivative of a(¢) can be calculated by means of Eq. 3.4. The value of j is related to

the angle of internal friction ¢ as follows:

_ (1-sing)

] = m (3.15)

To estimate the coefficient of wall friction u, following Mabrouk et al. (2008), we use the

relationship reported below:
ke
p=— + tang (3.16)

where k. is the particle-wall cohesion coefficient, which we assume to be negligibly small since

no strong cohesion is present between the particles and the steel walls of the vessel.

To calculate the solid volume fraction profile in the bed at each operating condition, we

integrate Eq. 3.14, using the following boundary condition:

z2=0, ¢ = dmin (3.17)

This condition is given at the lower limit of the integration domain, which coincides with the
top surface of the bed. The upper limit of the integration domain, which coincides with the
bottom surface of the bed, located at z = H, where H denotes the bed height at the given
operating condition, is unknown at the start of the numerical integration of Eqg. 3.14. To
determine it, we start integrating Eg. 3.14 from the top of the bed, terminating the integration at

the value of H which satisfies the following condition:

H
ppfo ¢p(z)dz=m (3.18)

where m is the particle mass loading, that is, the mass of particles per unit cross-sectional area.

Thus, by imposing the condition reported in Eg. 3.18 on the solution of Eqg. 3.14, we can
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determine the solid volume fraction profile ¢(z) and the bed height H for a given superficial
fluid velocity. Knowing ¢ (z) allows us to integrate Eq. 3.12 to obtain the fluid pressure profile

at different values of u.

In the fluidization process, if we assume that the tensile yield stress of the powder is vanishingly
small, we can argue that, as the velocity is gradually increased from zero, ¢ at the bottom of the
bed decreases to finally vanish when the minimum fluidization wvelocity u,, is reached.
Following this argument, we can determine the value of u,, as follows. During fluidization, Eq.

3.13 reads:

do 4

_ u 1
=, "o = (op = P)¢g [1 —u—tm] (3.19)

In this case, o and ¢ are no longer functionally related; so, EQq.3.19 cannot be solved to obtain
¢(z) at each superficial gas velocity, as we did during the defluidization process. For
fluidization velocities lower than the minimum fluidization velocity, this does not present a
problem, because the bed retains the structure acquired during the defluidization process, and
therefore the solid volume fraction profile ¢(z) is known, being equal to that obtained during
defluidization for a zero fluid velocity. This allows us to solve Eq. 3.19 to determine the stress
profile a(z). We can easily solve the differential equation by using the integrating factor e P#,
where p = 4uj/D. If we multiply both sides of Eq.3.19 by e™P# and then integrate with respect
to z, we obtain:

Ppgu
U

H H
o(z=H)e P —g(z=0) = ppgf pe Pidz — f a _¢¢)n e PZdz (3.20)
0 0

As reported in Section 3.3, at the minimum fluidization point ¢ vanishes at the top and bottom
of the bed and so the left-hand side of Eg. 3.20 vanishes. In these conditions, the velocity u is

equal to the minimum fluidization velocity u,,; therefore, we obtain:

1

W ([ N[\
u_t_<-[0 ¢epdz>(_[0 We”dz) (3.21)
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Eqg. 3.21 allows calculating the value of the minimum fluidization velocity given the axial
profile ¢(z). The latter, as said, is the solid volume fraction profile obtained in the

defluidization process when the gas flow rate is zero (that is, the bed is fully defluidized).

3.5 Experimental

We investigated two types of powders: Powder 1(Alumina) and Powder 2 (Ballotini). Their
properties are reported in Table 3.2. For each powder we performed two sets of experiments:
first, fluidization and defluidization experiments, which allowed us to determine the pressure
drop and bed height profiles in the bed; second, experiments aimed to determine the
compressive yield stress o of the powder, which allowed us to obtain the values of the
parameters appearing in Eq. 3.4. Before conducting the experiments, we carried out sieve

analysis to determine the mean sizes of the powders.

3.5.1 Powder preparations

Particle size analysis using test sieves is, and has been, the standard for many years. Other
methods have been developed, but they are commonly used for sub-micron analysis where
sieves are difficult to use. To obtain representative samples of the powders, avoid segregation
and ensure homogeneity, we shuffled large batches of powders. To carry out the sieve analysis
we weighed each sieve and recorded their weight. We placed a known mass of powder on the
top sieve of a stack of sieves and covered the top. We shook the stack, keeping it in the vertical
position, using a mechanical shaker for about five minutes. Figure 3.1 shows the arrangement of
the sieve stack and the mechanical shaker. We weighed the powder retained on each sieve and
the bottom pan and recorded their weight. This allowed us to calculate the percentage of powder
on each sieve and the mean particle size. We carried out the experiments three times to ensure
repeatability. Figures 3.2 — 3.5 report the normal and cumulative size distributions of the

powders. Table 3.2 reports the properties of Powder 1 and 2.

59



Chapter 3 Homogeneous expansion of gas-fluidized beds 2016

Sieve stack

Mechanical shaker

Figure 3.1: Sieve stack and mechanical shaker arrangement
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Figure 3.2: Normal particle size distribution of Powder 1
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Table 3.2: Physical properties of powders (Oke et al., 2015)
Powder 1 Powder 2
Mean particle diameter (um) 53 66
Particle density, kg/m® 1730 2500
Angle of internal friction, ¢ 40° 13°
Minimum fluidization velocity 0.113 0.633
(cm/s)
Minimum bubbling velocity (cm/s) 0.301 0.971

352

Fluidization and defluidization experiments

We carried out fluidization and defluidization experiments in three different tubes, made of

stainless steel, with nominal internal diameters of 10 cm, 5 cm and 2.5 cm, and height of 1 m.

We chose stainless steel as vessel material to minimize electrostatic effects. The latter usually
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arise as a result of continuous contact and separation between the particles and the vessel walls.
Electrostatic effects create serious problems in fluidized beds, making particles adhere to the
wall and in some cases generating channelling. One method suggested by Katz & Sears (1969)
to minimize these effects is to increase the humidity of the fluidizing gas. We did not resort to
this method, because it would increase the cohesiveness of the particles, making it impossible to
distinguish between the effects of air humidity and those (that continue to be) present also in dry
conditions. In any case, the electrostatic effects were reduced significantly with the use of
stainless steel as vessel material. The gas distributor, made of a 5mm-thick sintered mesh with
pore size of 20 um, was mounted between the tubes and the windbox (whose diameter, in each
case, was equal to that of the tube). We used dry air, from compressed air cylinders, as
fluidizing medium, passing it through a pressure regulator to minimize flow fluctuations. We
measured the gas flow rates by means of flow meters and the pressure drops across the bed by

means of a digital manometer.

To visualize the bed, we used a pulsed x-ray system consisting of an x-ray generator, an x-ray
tube and an image intensifier, respectively labeled 1, 2 and 3 in Figure 3.6. The x-ray tube and
the image intensifier are mounted on a twin column suspension unit that allows them to be
moved vertically or horizontally across the room. The horizontal movement allowed us to adjust
the distance between the x-ray tube and the image intensifier, while the vertical movement
allowed us to visualize different heights in the fluidized bed. Each column can be moved
vertically independently or as a synchronized pair. The x-rays are produced from a high-voltage
source ranging from 40 to 150 kV and frequencies up to 72 Hz, pulsed at 25 fps. The x-ray
pulses, synchronized with an image capturing device, pass through the fluid bed. The absorption
of the x-rays by the latter is proportional to the nature and quantity of the material along its path.
The x-ray beam that emerges from the fluid bed is amplified by the image intensifier by
converting the x-ray absorption pattern to an image of sufficient brightness and contrast. These

are then recorded by a video camera. The images from the camera are sent by fibre optics to a
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dual processor industrial PC that has the capacity to store real-time image sequences of high

quality.

To start the experiments, we placed a known mass of particles in the tube. We aerated the bed at
low flow rate for about 30 minutes to ensure that the particles were moisture-free. We then
increased the flow rate, allowing the bed to bubble gently for a period of time. After, we
decreased the air flow in small intervals until the bed was entirely defluidized. At each step, we
let the bed equilibrate, subsequently measuring the bed height and pressure drop. After
completing the defluidization process, we increased the air flow rate in small increments,
measuring at each step the bed height and the pressure drop through the bed until the latter

entered the bubbling regime.

3.5.3 Determination of the powder compressive yield stress

To determine the compressive yield stress of the powders investigated, we adopted a procedure
proposed by Valverde et al. (1998). We placed a known mass of particles in the tube with
diameter of 10 cm. We allowed the bed to bubble gently for a while, and then we slowly
reduced the gas flow rate until it became entirely defluidized. We finally measured the bed
height. We then added a known mass of particles to the bed, letting the latter bubble gently for a
while; then, we slowly defluidized it, recording its resting height. By repeating this procedure,
we obtained the bed height H as a function of the mass loading m. We then calculated the mean

solid volume fraction ¢ (H) for each value of H using this relation:

m
ppgH

P(H) = (3.22)

The variation with H of the experimental values obtained for ¢ , along with a curve fit, is shown

in Figure 3.7 and 3.8 for Powders 1 and 2, respectively.

We see that ¢ increases rapidly when the bed is shallow, remaining approximately constant
when it becomes sufficiently deep. This constant value gives a rough estimate of ¢, We now

use these figures to determine the compressive yield stress curves for the two powders.
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The increase in ¢ as the bed height increases is caused by an increase in compressive stress,
owing to the weight of the particles; this makes the latter rearrange into a more compact
ensemble in the lower parts of the bed. Assuming that wall friction plays a negligible role — this
is why to carry out these measurements we used the vessel of largest diameter — we can

calculate the compressive yield stress at the bottom of the bed using the following relation:
o(H) = pp¢(H)gH (3.23)

If we now succeed in determining the corresponding values of ¢(H), that is, of the solid volume
fractions at the bottom of the bed for the various bed heights considered, combining the
functions ¢ (H) and ¢p(H) we can obtain the compressive yield stress locus a(¢). Our task is
thus finding a way to obtain the values ¢ (H). These differ from those of ¢ (H): the former are
the local values of the solid volume fraction at the bottom of the bed, whereas the latter are the

mean values of the solid volume fraction, averaged over the entire bed.

Figure 3.6: Experimental set-up showing the x-ray machine employed to visualize the bed. 1: x-ray
generator 2: x-ray tube 3: image intensifier.
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To derive an expression for ¢(H), we proceed as follows. We begin by writing:

qub(Z)dz =¢ (HH (3.24)
0

Differentiating both sides of Eq. 3.24 with respect to H, we obtain:

H) = ¢(H qub 3.25
d(H) = p(H) + aH (3.25)

We can now use the experimental curve ¢ (H) reported in Figures 3.7 and 3.8 and Eq. 3.25 to

evaluate ¢(H) and use Eq. 3.23 to evaluate o(H).

Figures 3.9 and 3.10 report the curves o(¢) for Powders 1 and 2 obtained with this method. The
figure shows that the stress needed to cause compressive yield is small at low values of ¢. But
as the latter increases, o rises slowly at first and then rapidly. To obtain the values of the
parameters that appear in Eq. 3.4, we fitted the equation to the experimental curves in Figures

3.9 and 3.10; the results are reported in Table 3.3, along with other properties of the powders.
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Figure 3.9: Compressive yield strength ¢ against solid volume fraction ¢ obtained experimentally for
Powder 1.
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Figure 3.10: Compressive yield strength ¢ against solid volume fraction ¢ obtained experimentally for
Powder 2.

Table 3.3: Simulation parameters

Powder 1 Powder 2

Terminal velocity, m/s u, 0.10 0.25
Richardson & Zaki exponent n 4.60 4.30
Coefficient of wall friction u 0.80 0.27
Solid volume fraction beyond which ¢ i 0.5565 0.5486
enduring particle contacts vanish

Maximum solid volume fraction D, o 0.6343 0.5800
Janssen’s coefficient j 0.20 0.63
Positive parameter a 1.00 1.00
Positive parameter b 1.00 1.00
Positive parameter, N/m’ c 32.00 35.00
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3.6 Results and discussion

Figures 3.11 — 3.13 refer to Powder 1 and report the plots, obtained through fluidization and
defluidization experiments, of the pressure drop, normalized with respect to the bed weight per
unit cross-sectional area of the tube, against the superficial gas velocity. The corresponding bed
height profiles are reported in Figures 3.14 — 3.16. Similar profiles, reported in Appendix D,
were obtained for Powder 2. In Figures 3.11 — 3.13, during the fluidization process, the
normalized pressure drop rises linearly until the velocity reaches the minimum fluidization
value. At this point, the normalized pressure drop increases above unity, revealing that the
pressure drop through the bed exceeds the effective bed weight. This is observed for all the tube
diameters investigated. There is a noticeable increase in the pressure drop overshoot as the bed
diameter decreases; we attribute this to wall effects, which become more pronounced as the tube
diameter becomes smaller. Similar pressure drop overshoots have been reported by several
authors (see for instance, Tsinontides & Jackson, 1998; Valverde et al. 1998; Srivastava &
Sundaresan, 2002). We observe that the normalized pressure drop at fluidization velocities
beyond the point of initial expansion is less than unity; this means that the pressure drop does
not support the full weight of the bed, and that in the latter compressive stress is at work. This is
contrary to what one would expect in ideal fluid beds, where the pressure drop exactly balances
the effective weight of the particles, the bed being unable to transmit stress. Although the bed
expands, it is not fully fluidized, being in the solid-like regime over the entire interval of stable
expansion, before transiting to the bubbling regime at a superficial gas velocity of 0.30 cm/s.
This powder, therefore, never enters the fluid-like regime, even if, when the superficial gas
velocity approaches the minimum bubbling velocity, the compressive yield stress almost
vanishes (the normalized pressure drop being equal to 0.98). This kind of behavior is common
to Group A powders, having been reported many times in the literature (Tsinontides & Jackson,
1998; Jackson, 2000; Srivastava & Sundaresan, 2002; Loezos et al., 2002). For more cohesive
powders, such as those belonging to Geldart’s Group C, the stable expansion interval features

both solid-like and fluid-like regimes. This point has been discussed in Chapter 2.
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Table 3.4: Experimental and theoretical values of minimum fluidization velocities

Powder 1 Powder 2

Minimum Fluidi

zation Velocity (cm/s)

D (cm) Experimental Theoretical Experimental Theoretical
10.0 0.102 0.106 0.610 0.614
5.0 0.112 0.110 0.641 0.623
25 0.121 0.117 0.648 0.637

Figures 3.11 — 3.13 report also the theoretical fluidization and defluidization curves. The
fluidization curves extend up to the superficial gas velocity at which the structure of the bed,
acquired during defluidization, breaks down and fluidization begins; to continue these curves to
higher superficial gas velocity values, we would have to assume something about the structure
of the fluidized bed; the simplest assumption is that the bed is fully fluidized (i.e., homogeneous
and in the fluid-like regime), so that no compressive stress is present. However, as the
experimental curves reported in Figures 3.11 — 3.13 reveal, this is untrue, because the
normalized pressure drop is less than unity. As a consequence, we preferred to stop the
fluidization curves at the end of the initial linear branch. The minimum fluidization velocities

predicted theoretically and those obtained experimentally are reported in Table 3.4.

The theoretical and experimental fluidization/defluidization curves are very similar, except in
one respect. The theoretical normalized pressure drop curves during defluidization approach a
value of unity when the gas velocity exceeds 0.24 cm/s; the model, therefore, predicts that
between this velocity and the minimum bubbling velocity the bed finds itself in the fluid-like
regime. This is not observed experimentally, even if, for velocities larger than 0.24 cm/s, the
bed is almost entirely fluidized. The reason for this, we believe, is that the value of ¢in
estimated experimentally (through the best-fit procedure reported in Section 3.5) and adopted in
the model is slightly underestimated, so that the model predicts a transition of the system to the

fluid-like regime when in reality the bed is still able to sustain a weak compressive stress.
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3.7 Solid volume fraction profiles

By integrating Eq. 3.14 numerically, using for the parameters the values reported in Table 3.3,
we determined the solid volume fraction profiles in the bed at various superficial gas velocities
u during defluidization. Figures 3.15 and 3.16 report the solid volume fraction vertical profiles
for Powders 1 and 2 at different superficial gas velocities. At each velocity, the volume fraction
varies significantly near the top of the bed, remaining fairly constant at lower heights; this
shows that the bed bulk density builds up with depth. The figure also shows that the solid
volume fraction at the bottom of the bed decreases as the superficial velocity of the gas

increases.

This is because at larger velocities the bed is more expanded, and we do expect lower and lower
values of the solid volume fraction as the bed becomes progressively less packed; this indicates
that as the gas velocity increases a larger fraction of the bed weight is supported by the fluid.
The profiles of solid volume fraction show that the beds are not fully fluidized until the fluid
velocity reaches the value of 0.24 cm/s for Powder 1 and 0.82 cm/s for Powder 2. At such
values, the beds enter the fluid-like regime, becoming fully fluidized. We can tell because the
solid volume fraction becomes constant over the entire depth of the bed: this implies that the
particles are uniformly suspended into the fluid and particle-particle contacts are absent. In such
a condition, the gradient of the normal stress vanishes, so that the beds can no longer transmit
stress due to a network of particle-particle contacts; accordingly, spatial variations in solid

volume fraction no longer exist.
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Figure 3.15: Normalized bed height (H/H,) against solid volume fraction ¢ obtained theoretically for
powder 1. H,, is the initial bed height.
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To see if wall friction affects the solid volume fraction profile in the bed, we ran simulations at
various values of the bed diameter, keeping the superficial velocity of the fluid constant. Figures
3.17 and 3.18 show the plot of normalized bed height against solid volume fraction for Powders
1 and 2 respectively. We observe that, at a given value of the superficial fluid velocity, the solid
volume fraction, in particular at the bottom of the bed, decreases as the value of D decreases.
This is due to the additional support provided by the walls of the vessel, the latter reducing the
component of the particle weight balanced by the action of the distributor plate. At larger
velocity, the difference among the solid volume fraction profiles becomes less significant; the
profiles at 0.15 cm/s for Powder 1 and 0.80 cm/s for Powder 2 are closer than those obtained at
lower velocities. The reason for this is that at a high superficial gas velocity, the bed expands
more, the enduring contacts among the particles reduce, and therefore the normal stress
decreases considerably. This causes a corresponding decrease in the frictional force at the walls,
since the latter is directly related to the normal stress o (refer to the second term on the left-hand
side of Eq.3.10). At these high velocities, the dependence of the frictional force on the normal
stress outweighs that on the vessel diameter; hence, the solid volume fraction profiles do not

vary appreciably as D changes.

3.8 Richardson & Zaki equation and homogeneous expansion in gas-fluidized beds

Before advancing further, let us briefly recap the aim of this chapter. We pointed out, in Section
3.2, that the correlation of Richardson & Zaki (1954) holds for both liquid-fluidized and gas-
fluidized beds, but for the latter the values of the parameters n and u, appearing in the
correlation are greater than those predicted by the relations reported in the literature, which
instead are reasonably accurate for liquid-fluidized beds. As said, we denote the larger values
holding for gas-fluidized beds as n* and u,*. These values reflect the effects of both fluid
dynamic and interparticle forces, whilst the values of n and u, reflect only the effects of the
former, insofar as in liquid-fluidized beds the interparticle forces play a negligible role. We

believe that the larger values of n* and u,” are caused by the enduring contacts among the
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particles, which in turn are a manifestation of cohesiveness. In homogeneous fluidized beds in
the fluid-like region these contacts are absent, and the Richardson & Zaki parameters take on
the expected fluid dynamic values denoted as n and u;. In most of the stable interval of
homogeneous expansion, nevertheless, gas-fluidized beds find themselves in the solid-like
region, where enduring contacts among particles are present. We believe that these play a key
role, their presence explaining why the values of the Richardson & Zaki parameters are larger
than expected. We are now in a position to put this claim to the test. The model results provide,
for any given superficial gas velocity, the axial profile of the solid volume fraction, and
therefore of the void fraction as well. Using these profiles, we may determine the mean values
of the void fraction through the bed as a function of the superficial gas velocity: these values are
those that one measures in experiments on homogeneous fluidized beds and uses in the
Richardson & Zaki correlation. To determine the n* and u;* values theoretically, we operate as
follows: from the profiles of solid volume fraction, we calculate the mean solid volume fraction
¢ at each fluidizing velocity u in the stable interval of expansion, using the following

relationship:

_ 1 H
¢ = ﬁ_]; ¢(z)dz (3.26)

By plotting u against ¢ in the Richardson & Zaki form:
logu =logu,* +n*log(1—¢) (3.27)

we then obtain the theoretical values of n* and u;* from the slope and intercept on the velocity
axis of the function above, respectively. The logarithmic plot of u against (1 — ¢) for Powder 1
is shown in Figure 3.19 for the bed with 10 cm diameter. Table 3.5 reports the theoretical and
experimental values of n* and u;* in beds of different diameters for Powders 1 and 2. The
theoretical values of n* and u,* obtained from our simulations show a reasonable agreement
with the experimental results. In particular, the values of n* are higher than the limiting values
ascribed to n in the limit of inertial regime (discussed in Section 2). We also observe from Table

3.5 that the values of n* and u;* increase as the bed diameter decreases; this is true for both
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powders. This is due to the wall effects becoming more pronounced as the bed diameter

reduces.

To further confirm our results, we ran simulations using powders investigated by Tsinontides &
Jackson (1993) and Srivastava & Sundaresan (2002) — Powder 3 and 4, respectively. The
physical properties of these powders are reported in Table 3.6. We adopt the same approach
reported in the preceding paragraph to determine the values of n* and u,.*. The simulation
results, alongside those obtained using Powder 1 and 2, are reported in Table 3.5. The results

again show that the theoretical values of n* and u,* agree fairly well with the empirical values.
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Figure 3.19: Logarithmic plot of velocity against bed voidage obtained theoretically. The points represent
the theoretical data, while the solid line is the linear fit.

To investigate the role of enduring particle contacts in homogeneous fluidization, we reasoned
as follows: if truly there were no particle-particle contacts in the fluidized bed, the particles
floating freely in the fluid and the homogeneous expansion being dictated solely by fluid
dynamic forces, as some authors argue, we would expect the values of n* to be the same as the

values used in our simulations to model the drag force (that is, the values of n). To explain this,
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let us consider Eq. 3.13. The latter reduces to the Richardson & Zaki equation if we neglect the
contribution of stress transmitted by enduring particle contacts. In this case, the equation merely
expresses the fluid dynamic force balance (where the drag force on the particles balances their
effective weight) which one would expect if the bed were to be uniformly fluidized; hence, the
equation yields the hydrodynamic n and u; values used as input in the model. However, as seen
from the experiments, the values of n* and u,* obtained for the powders are larger than the
hydrodynamic ones (see Table 3.5). This reveals that by accounting for the stress transmitted
via contacts among particles, we are able to capture the expansion profiles in the bed and to

correctly predict the expansion parameters featuring in the Richardson & Zaki equation.

Table 3.5: Summary of Richardson & Zaki (1954) parameters

Experimental Theoretical Hydrodynamic
Powder 1
D (cm) n' u, (m/s) n' u,” (M/s) n u,(m/s)
10.0 5.36 0.183 5.04 0.144 4.6 0.10
5.0 5.96 0.309 5.49 0.204 4.6 0.10
25 6.62 0.587 6.35 0.437 4.6 0.10
Powder 2
D (cm) n' u,*(m/s) n' u,” (m/s) n u,(m/s)
10.0 5.03 0.437 4.94 0.417 4.3 0.25
5.0 5.21 0.524 5.11 0.476 4.3 0.25
25 6.21 1.156 6.13 1.081 4.3 0.25
Powder 3
D (cm) n* u, (m/s) n* u,” (m/s) n u,(m/s)
5 5.01 0.224 5.10 0.189 4.5 0.12
25 5.86 0.333 5.69 0.292 4.5 0.12
Powder 4
D (cm) n* u, (m/s) n* u,” (m/s) n u,(m/s)
5 6.40 0.156 6.67 0.206 4.72 0.06
25 7.43 0.331 7.61 0.374 4.72 0.06
Table 3.6: Physical properties of Powders 3 and 4
Powder 3 Powder 4
Mean particle diameter (pum) 50 75
Particle density, g/cm® 2.35 1.44
Angle of internal friction, ¢ 13° 30°
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3.9 Conclusions

We investigated the solid-like regime of homogeneous fluidization using both experimental and
theoretical methods. We adopted a one-dimensional model to investigate the behaviour of gas-
fluidized beds of fine particles in the homogeneous fluidization regime, accounting for enduring
contacts among particles. These contacts, which are a manifestation of cohesiveness, strongly
affect the expansion profiles of the beds. In particular, the values of the expansion parameters n
and u, of the Richardson & Zaki (1954) equation obtained when we accounted for stress
transmitted through enduring particle contacts are higher than those obtained from purely fluid
dynamic considerations. This agrees with what occurs in reality. We validated our numerical
results by carrying out fluidization and defluidization experiments. The results indicate that
fluid dynamic correlations for calculating the values of n and u;, like those reported, for
instance, in Gibilaro (2001), are unsuitable for describing the expansion profiles of gas-fluidized

beds.
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Chapter 4

Literature review on
solid mixing in gas-fluidized beds

This chapter reviews the process of solid mixing in gas-fluidized beds.

1. We review the importance of solid mixing in gas-fluidized beds and the mechanism by
which it proceeds.

2. We report on experimental and theoretical works carried out on lateral and axial solid
mixing in gas-fluidized beds.

3. We discuss various methods adopted for measuring the rate of lateral solid mixing in
gas-fluidized beds.

4. We report different empirical correlations developed for estimating lateral dispersion

coefficients in gas-fluidized beds.
Parts of this chapter have been published:

Oke, O., Lettieri, P., Salatino, P., Mazzei, L. 2015. Eulerian modelling of lateral solid mixing in
gas-fluidized suspensions, Procedia Engineering, 102, 1491 — 1499.
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4.1 Introduction

Fluidized beds operate in different regimes depending on the superficial gas velocity. For most
gas-fluidized beds, when the superficial gas velocity exceeds the minimum fluidization velocity,
the bed enters the bubbling regime. This regime is characterized by the formation of bubbles,
which cause vigorous mixing of solids in the bed. At higher gas flow rates agitation becomes
more intense, and the movement of solids becomes more vigorous, creating violent mixing
between the solid and gas phases. Intense mixing in the bed promotes extremely high surface
contact between the fluid and the solid per unit volume of the bed, high heat and mass transfer

and high relative velocity between the fluid and the dispersed solid phase.

Excellent mixing in fluidized beds allows them to find applications in many industrial
operations. For instance good mixing in fluidized bed dryers promotes high intensity drying and
high thermal efficiency with uniform and easily controllable temperature. This ensures that
mixing is achieved quicker because of high rates of heat and mass transfer. Excellent mixing
also allows easier maintenance and operation of the dryer and enhances greater adaptability to

automation (Chandran et al., 1990).

In polymerization reactors good mixing is needed to achieve efficient operation and desired
results (Naimer et al., 1982; Kim & Choi, 1999; McAuley et al., 1994). This ensures excellent
gas-solid contact, minimal gas-bypassing and uniform temperature. The latter ensures that there
are no hot spots in the bed. Hot spots are regions of maximum temperature in the bed, causing
deleterious effects such as catalyst deactivation and undesirable reactions. In addition, the
polymerization reaction is highly exothermic, generating significant amount of heat. Good
mixing in the reactor allows the heat to be removed by fast flowing stream of fluidizing gas.
Successful applications of fluidized beds to other highly exothermic and temperature sensitive

processes has been achieved due to the excellent mixing that they provide.

Chemical synthesis in fluidized bed reactors relies on efficient mixing. Usually, the reactions in

a chemical synthesis require strict temperature control. This is because the reaction may be
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explosive outside a narrow temperature range. In addition, the yield of the desired products are
sensitive to the temperature level of operations; hence, excellent solid mixing is needed for

safety of operations and profitability.

Knowing how solids mix is also important in defining input parameters for modelling of
fluidized bed reactors. Petersen & Werther (2005) developed a fluidized bed reactor model
using lateral mixing data as an input parameter. They were able to investigate the distribution of
volatiles (CH4, CO and H,) in the region close to the feed point. Similarly, Wischnewski et al.
(2010) simulated a 3-D industrial circulating fluidized bed (CFB) combustor, describing gas and
solid mixing in the bed by using lateral solid mixing data. Similarly, Pallarés & Johnsson (2008)
investigated fuel concentration at the bottom region of a fluidized bed combustor by developing
a model which accounts for mixing patterns and fuel conversion in the bed. To use the model,

lateral mixing data at the bottom part were necessary input parameters.

In a fluidized bed combustor the rate at which solid fuel mixes laterally has a strong influence
on the performance of the plants. This is because it affects the combustion efficiency, the
allocation of heat release and the formation of emissions (Gomez-Barea & Leckner, 2010). It is
therefore crucial to ensure that fuel spreads homogeneously over the whole cross-section of the
bed. To do this, fuel is usually fed at multiple entry points with the aid of a spreader. However,
each added feed point increases the installation cost, making it crucial to minimize the feed
entry points and, at the same time, maintain fuel burnout to achieve low emissions. These
requirements make the knowledge of how fuel mixes laterally essential for optimal design of the

fluidized bed combustor.

A good understanding of the mixing process is very important in the design of large-scale
fluidized beds. Solid mixing studies combined with gas flow analysis and reaction mechanisms
provide the basis for designing commercial fluidized bed reactors (Shen, et al. 1995). Therefore,
several authors have examined the phenomenon of mixing in fluidized beds; on the one hand

using experimental approaches to investigate the causes of mixing and the mechanisms by
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which it proceeds, on the other hand using theoretical approaches to describe the process and

predict it for design purposes.

The importance of solid mixing in fluidized beds has made researchers focus more on its study
(Marsheck & Gomezplata, 1965; Rowe, et al.1965; Partridge, 1965; Rowe & Widmer, 1973;
Nguyen et al., 1977; Potter, 1971). Knowing the mechanism by which mixing occurs is crucial
in designing efficient fluid bed reactors. This is because it affects important phenomena such as
heat and mass transfer rates, which in turn can affect mechanical design of fluidized bed
accessories such as the number and position of solids feed and withdrawal points (Mostoufi &
Chaouki, 2001). Therefore, a better understanding of how mixing proceeds will significantly aid

the design and operation of fluidized beds.

4.2 The mechanism of solid mixing in gas-fluidized beds

When granular materials are fluidized with a velocity that is at least equal to their minimum
bubbling velocity, bubbles begin to form in the bed. These are regions of low solid density or
voids rising in the bed. They are usually enveloped by a cloud of circulating gas and particles
which is generally referred to as bubble cloud. The region below the bubble is the wake region.
The latter is most likely formed because the pressure in the lower part of the bubble is less than
in the nearby emulsion, drawing the gas into the bubble. This causes partial collapse of the
bubble and creates turbulent mixing (Kunii & Levenspiel, 1991). The turbulent mixing causes
solids to be drawn up behind the bubble, forming the wake region. As bubbles rise through the
bed, they periodically shed the wake, leaking solids into the emulsion. This implies that there is

exchange of solids between the wake and the emulsion.

Researchers believe that solid mixing in fluidized beds is caused mainly by the actions of the
bubbles. The wakes of the bubbles carry solids from the bottom of the bed to the top. Along the
way up, there is exchange of particles among the bubble wakes and the rest of the bed. This

phenomenon is referred to as wake shedding. To balance the upward transport of solid particles,
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there is a downward movement of solid particles in the bubble-free region, creating a global

circulation of particles in the bed. This mechanism is illustrated in Figure 4.1.

Several authors (Sitnai & Whitehead, 1985; Lin et al., 1985; Yamazaki et al., 1986) studied the
mixing mechanisms of different types of powders. They reported that mixing of Geldart B
powders generally depends on the geometry of the bed and the fluidizing velocity. At low
fluidizing velocities, and in beds of aspect ratio lower than unity, the emulsion phase moves
upwards in the regions near the wall and downwards at the centre of the bed. At higher flow
rates however there is a reversal of the flow; the emulsion now moves downwards in the regions
close to the wall and upwards at the bed axis. In beds having aspect ratio greater than unity, two
regions of solid circulation form in the bed: the first forms in the region close to the distributor
and the second forms near the top of the bed. At higher gas flow rates, the latter region becomes

more vigorous and dominates the entire solid mixing process.
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Figure 4.1: Solid mixing mechanism in fluidized beds (Yang, 2003)

The solid mixing pattern of Geldart A powders is more complex: there is both upflow and

downflow of emulsion at the center of the bed (Tsutsui et al., 1979). Mixing of Geldart D
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powders is characterized by elongated bubbles near the distributor plates which transform into
spherical bubbles as they move up the bed (Fitzgerald, 1980). The bubbles grow rapidly and do
not follow any specific path. This makes it difficult to establish a solid mixing pattern, as is the
case for other classes of powders. Canada et al. (1978) reported that at higher superficial gas
velocities, bubbles coalesce, forming large voids which produce large bed oscillations and

cyclic movement of the bed surface.

Solid mixing in a freely bubbling bed is not only caused by vertical motion of bubbles, but also
by bursting of bubbles at the bed surface. This induces lateral dispersion of parts of the wake’s
particles over a wide area, and the remaining particles are ejected into the freeboard (Shen, et
al., 1995). Lateral mixing of particles is also improved by coalescence and lateral motion of

bubbles, as well as gross particle circulation or the so-called ‘Gulf Stream’.

4.3 Axial and lateral solid mixing in gas-fluidized beds

The importance of solid mixing has made researchers focus on its study. To do this, they
investigated how solid mix axially (vertically) and laterally (horizontally) in fluidized beds.
May (1959) was among the first to investigate the process of axial mixing. He measured axial
mixing rate using the dispersal of radioactive particles injected at the bed surface, analysing the

results using the diffusion equation:
0,C = Dyq02,C (4.1)

where C represents the concentration of tracer particles, D, represents the axial dispersion
coefficient and y is the axial spatial coordinate. He found reasonable agreement between the
latter equation and experimental results for Geldart A powders fluidized in a bed of aspect ratio
24. However, when the experiments were carried out in a bed of aspect ratio 6.4 the model

could not fit experimental results satisfactorily.
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Similarly, Miyauchi et al. (1981) studied axial mixing of Geldart A powders in a turbulent bed,
analysing the results using Eq. 4.1. They found that mixing data could be well represented by

the latter. They derived the following equation for D,:
Dy, = 12ut/2W 09 [cm?/s] 4.2)

where wu is the superficial gas velocity and W is the vessel width. Avidan & Yerushalmi (1985)
also found reasonable agreement between Eq. 4.1 and experimental data when they studied axial
solid mixing in the turbulent regime, but their data fitted poorly when the bed was in the

bubbling regime.

To explain why the experimental results of May (1959) did not satisfactorily fit the diffusion
equation at low bed aspect ratio, Kunii & Levenspiel (1969) reported that low aspect ratios
cause strong solid circulation; consequently, strong convective mixing (as a result of bulk
movement of particles), rather than diffusive mixing (due to random fluctuations in particle
velocity), prevails; so that their experimental data cannot satisfactorily fit the diffusion equation.
Conversely, May (1959) obtained a reasonable fit in tall beds because there was mild solid
circulation. Furthermore, when bubbling is vigorous, which is the case in the turbulent regime,
convective mixing is less dominant, and hence experimental data are better fitted by the
diffusion equation. This explains why Miyauchi et al. (1981) and Avidan & Yerushalmi (1985)

obtained reasonable agreement between Eq. 4.1 and their experimental data.

Esin & Altun (1984) studied the rate of axial solid mixing using ion-exchange resins as tracer
particles. They placed a known amount of particles in the bed and a uniform layer of accurately
weighed tracer particles were placed on top. Then the bed was fluidized by air. After fluidizing
the bed for a certain period, they switched off the air supply. Subsequently, they determined the
concentration of tracer particles at different horizontal layers along the bed, analysing the results

using the diffusion equation. They derived the following correlation for Dy,,:
u
Dy, = 0.051 — (u — uy,y) 7t [cm?/s] (4.3)
m
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Following May (1959), Mostoufi & Chaouki (2000) adopted a radioactive particle tracking
technique to investigate the mechanism of axial solid mixing. They fluidized FCC particles at
different fluidization velocities, covering bubbling and turbulent regimes. They reported that
upward movement of solids occurs by diffusive mechanism, while downward movement
proceeds via convective transport. Their results showed that the upward motion was
characterised by bubble-bubble and/or cluster-cluster interaction in the central part of the bed.
On the other hand, solid clusters descend with very little interaction with other clusters, making
the downward solid movement a convective process. Similar to foregoing authors, they

quantified the rate of upward solid mixing using the diffusion equation.

Lee & Kim (1990) studied axial mixing of solids in a fluidized bed containing glass beads, but
they focussed on mixing in the slugging and turbulent flow regimes. They used axial transport
of heat at steady state to determine the mixing rate of solids, analysing their experimental results
using the diffusion equation. Their results showed that effective axial mixing rates did not
change appreciably in the slugging regime, but increased with an increase in gas velocity in the
turbulent regime. Others (Geldart, 1973; Cranfield, 1978; Abrahami & Resnick, 1974) also

investigated axial mixing of solids in fluidized beds experimentally.

Experimental work on solid mixing is not only limited to axial mixing; researchers have
investigated lateral mixing, focussing on the mechanism by which it proceeds and on how the
lateral mixing rate can be quantified. Hirama et al. (1975) showed that bubble eruption at the
bed surface contributes significantly to lateral solid dispersion. To demonstrate this, they
installed lattice at the bed surface to restrict the movement of solids at the surface. They found
that the lateral solid mixing rate was higher than when no lattice was installed on the surface of
the bed, showing that the burst of bubbles at the bed surface substantially affects lateral solid

mixing.

Similarly, Merry & Davidson (1973) investigated how solids mix laterally in fluidized beds.

They reported that uneven distribution of fluidizing medium will promote lateral solid mixing,
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stating that the process induces rapid mixing in the bed, and subsequent eruption of bubbles at
the bed surface. The eruption of bubbles causes their solid contents to be ejected into the free
board over a wide area. Kunii & Levenspiel (1991) provided more insight on the mechanisms of
eruption of bubbles at the bed surface. They stated that the bubble pressure being higher than
the pressure at the bed surface causes the bubble to “’pop’” on reaching the surface, spraying
solids from the bubble roofs into the freeboard. In addition to this, bubbles may rise faster than
the sorrounding material, causing the solids in the wake of the bubble to be thrown as a clump
into the bed surface. They further stated that the coalescence of bubbles as they emerge at the
bed surface may result in strong ejection of wake solids into the freeboard, thus increasing
lateral solid transport. In the same vein, Shi & Fan (1984) investigated the mechanism of lateral
solid mixing using coloured particles as tracers. They reported that the lateral solid mixing
mechanism consists of movement of bubbles through the bed, eruption of bubbles at the bed

surface and gross particle circulation in the bed.

To further investigate the process of lateral solid mixing, Pallarés et al. (2007) carried out solid
mixing studies in fluidized bed boilers. They showed that under operational conditions the flow
pattern of fuel in the latter is highly convective and structured in horizontally aligned vertical
vortices with alternating rotational directions. These are referred to as bubble paths. Each main
bubble path is assumed to create a solid mixing cell around itself. In each cell, these three
mechanisms for lateral dispersion occur: bubble wake mixing, emulsion drift sinking and bubble
eruption of scattering at the bed surface. They reported that the net lateral dispersion is the result

of solid exchange between different mixing cells.

Instead of studying axial and lateral solid mixing in separate experiments, some researchers
concentrated on investigating both in the same experiments. Valenzuela & Glicksman (1984)
carried out a qualitative study on solid mixing in a two-dimensional bubbling bed using glass
bead particles of sizes between 600 and 850 um, investigating axial and lateral mixing by using
heated particles as tracers. They carried out two experiments: the first was by measuring the

steady state temperature around a heated wire placed at the centre of the bed, while the second
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was by measuring the transient temperature response of heated particles injected in the bed.
Their results revealed that lateral solid mixing is partially due to mixing in the bubble wakes.
They also reported that upward solid transport is characterized by a mixing length of the order
of the bubble size, while downward solid transport is more uniform and at a much lower

velocity.

Similarly, Shen & Zhang (1998) investigated the effect of particle size on both axial and lateral
mixing of solids in fluidized beds using heated particles as tracers. The heated particles were
injected pneumatically into the bed and the bed temperature was measured at different locations.
The results of their experiments show that temperature fluctuations become more prominent as
the particle size increases. Their results also revealed that convective axial mixing rates are
higher than those for lateral mixing. They reported that lateral mixing of solid is composed of
two components: the primary being the diffusive component generated by the random motion of
solids, and the secondary being the convective component imparted by the motion of bubbles.
They further interpreted their experimental results using a convection-diffusion model for solid

mixing.

Schlichthaerle & Werther (2001) adopted a different approach to study both axial and lateral
mixing in the bottom zone of circulating fluidized beds (CFB). They injected solid carbon
dioxide into the bed and measured the temperature and gas concentration at different locations,
analysing their results using the convection-diffusion equation. The experiment was carried out
in a CFB riser with a rectangular cross-section and at operating conditions similar to those
usually present in fluidized bed combustors. Their measurements showed a higher extent of
mixing in the axial direction than in the horizontal direction, supporting the observations of

Shen & Zhang (1998).

Most studies on solid mixing reported in the preceding paragraphs were analysed using either
the diffusion equation or the diffusion-convection equation, but as the understanding of

fluidized bed hydrodynamics grew, researchers began to study the process of solid mixing using
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mechanistic models that would enable them to make fundamental measurements for the design
of large-scale fluidized beds. The simplest version of these mechanistic models was introduced
by van Deemter (1967). He developed a counter-current solid circulation model for mixing of
solids in a bubbling fluidized bed. He then used the model to investigate axial mixing in a gas-
fluidized bed. To develop this model, he divided the solid phase into two streams: one flowing
upwards and another flowing downwards with exchange between the two streams. By taking a
mass balance for the tracer injected into the bed, he derived a differential equation describing

the axial mixing of the tracer. This reads:

dc dc
fﬁ + fvg +k,(c—=C)=0; for the upward moving phase (4.4)
ac ac )
F ET + FVa +k,(C—c)=0; for the downward moving phase (4.5)

where f and F, c and C, and v and V are the solid volume fractions, tracer volume fractions
and phase velocities in the upward and downward moving phases respectively and k is the

interchange mass transfer coefficient between the two phases.

Sitnai (1981) proposed a modified form of van Deemter’s counter-current solid circulation
model. The model is similar to that derived by the latter author, except in one aspect: he divided
the bed into three regions instead of two. He assumed that there is a thick region of solids
descending down the vessel wall, representing the third region. The governing equations
therefore contain three partial differential equations of solid concentration. The model was
employed to interpret mixing data, revealing that there is low circulation of solids and high solid
exchange rate between phases. He reported that both processes affect heat and mass transfer
rates in fluidized beds. The model however cannot predict random, short-term, disturbances

near the bed surface.

Shen et al. (1995) adopted the procedure of Sitnai (1981) to develop a model for investigating

axial and lateral mixing in fluidized beds. The model divided the solid mixing process in two
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components: the first is the convection component between the upward moving bubble wakes
and the down-flowing emulsion phase; the second is the diffusion in the emulsion phase. Their
results also showed that the vertical mixing of solids is much faster than the lateral mixing.
Several researchers (Gilliland & Mason, 1949; Leva & Grummer, 1952; May, 1959; Tailby &
Cocquerel, 1961; Talmor & Benenati, 1963; Bailie, 1967; Potter, 1971) have developed

theoretical models to study the mixing process in fluidized beds.

The key limitation of the counter-current solid circulation model is the lack of reliable equations
for estimating the exchange coefficients appearing in the model. Researchers have employed
different means to estimate these coefficients. For instance, Kunii & Levenspiel (1969), through
their bubbling bed model, developed an expression for the interchange mass transfer coefficient.
The model considered the bed as consisting of a continuous phase, called the emulsion, through
which bubbles rise. The latter are surrounded by a cloud of rising gas and particles, called
bubble cloud. The bubbling model bed indicates that the gas in a vigorous bubbling bed exists in
three regions: bubbles surrounded by cloud gas, both rising through an emulsion gas. The model
provides relationships among various quantities necessary for describing bubble conditions in
the bed, in particular the interchange mass transfer coefficient k., appearing in the counter-
current solid circulation model:

_ 3(1 - Emf) umf _1
e = [s7]
1- 5)€mf dp

(4.8)

where &, is the minimum fluidization voidage, u,,s is the minimum fluidization velocity,

6 is the bubble fraction and d,, is the bubble diameter.

The foregoing experimental and theoretical studies on axial and lateral solid mixing revealed
their importance in ensuring efficient operation of fluidized bed processes. In recent times,
researchers have concentrated more on the study of lateral mixing of solids in gas-fluidized
beds. This is because of its importance in large scale fluidized beds. Grace (1981) emphasizes

the importance of lateral solid mixing in shallow beds, stating that its knowledge is even more
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important than that of axial mixing in assessing the performance of gas-solid fluidized beds. In
the remaining part of this chapter, and in the next chapter, we focus on lateral solid mixing,
reporting on various works that have been done on it and the methods employed for measuring
the rate at which it occurs. To quantify the rate at which solids mix laterally in fluidized beds,
researchers often resort to lateral dispersion coefficient, Dg,; this, as we shall see in this study, is
an effective diffusivity relating to the time that solids take to spread laterally over a given
distance in the bed. Lateral dispersion coefficient is usually defined using the following

equation:

0;C = D502 C (4.9)

where C represents the void-free solids concentration, D, represents the lateral dispersion
coefficient and x is the horizontal spatial coordinate. This equation, as just said, should be
regarded as a definition of such coefficient. We will now report various experimental methods

adopted by researchers for estimating Dq,..

4.4 Estimating lateral dispersion coefficients in gas-fluidized beds

A pioneering attempt at estimating lateral dispersion coefficients was by Brotz (1956). He used
a shallow rectangular bed, consisting of two solids which are similar in physical properties, but
differ only in colour. He separated the solid with a removable partition plate which divided the
bed into two equal parts. He fluidized the bed for a certain time and the partition was removed.
By measuring the rate at which the two solids approach uniformity, he estimated the lateral

dispersion coefficient.

Gabor (1964) used a similar experimental method to Brotz. Instead of using solids of different
colours in his analysis, he used differences in magnetic property. In the experiment, he used
copper and nickel having different magnetic behaviour but having the same density, size and
shape. He placed the solids in a rectangular vessel separated by a partition placed at the centre.

On removing the partition, mixing occurred on either side of the centre line. After a certain
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mixing time, he turned off the fluidized gas and carried out sampling at known radial distances
across the bed. From the sampling, he determined the concentration profiles across the bed. By
employing the diffusion-type equation, he estimated the value of the lateral dispersion

coefficient. He developed an empirical relationship for the dispersion coefficient Dy, as follows:
(u— umf) -6 2.1
Dy = Dy |——7———| (1.22x107%) [ft?s~1] (4.10)
P

Here D, is the diameter of the fixed packing in ft, d, is the particle diameter in ft, u is the

superficial gas velocity in ft./s and w,, is the superficial gas velocity in ft./s.

Borodulya & Epanov (1982) employed a heated particle tracer to determine lateral solid
dispersion coefficients in fluidized beds. They also divided the bed into two parts; the heating
chamber and the working chamber with a movable barrier. They pre-heated a very small portion
of the bed to a temperature of 400-600°C and poured it into the heating chamber. By measuring
the time taken for thermocouples in different locations of the bed to show a variation in
temperature, they estimated the dispersion coefficient. They proposed the following correlation

for Dq,:

D, D\%®
————=10.013 (—) Fr=015 (4.11)
(u - umf)Ho Ho
In Eq. 4.11, D is the equivalent diameter of the vessel, H, is the bed height at rest, u is the
superficial gas velocity, u,,; is the minimum fluidization velocity. Fr is the Froude number
given by the following expression:

_ (u - umf)z

Fr
gHy

(4.12)

Shi & Fan (1984) measured lateral dispersion of solids in a rectangular fluidized bed using a
similar approach to that employed by Brotz (1959). They divided the bed equally into two parts

using a removable partition inserted vertically in the bed. In the first half of the bed they put
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dyed particles and in the other half they put undyed particles. Shi & Fan fluidized the particles
at constant superficial gas velocity and quickly removed the partition when the stable state of
fluidization was reached. After fluidizing the particles for a certain time, they took samples of
mixed particles from different lateral positions of the bed. By washing a weighed sample with a
known amount of water, they used spectrophotometer to determine the concentration of tracer
particles in the sample. From series of experimental runs carried out, they obtained the

following correlation for the lateral solid dispersion coefficient:

-0.21 , _o.
Dy _ (& = wmy)dppy e I A
= 0.46 (4.13)
(4 = s ) iy Hr dp Pr

Here p,, and p; are the densities of particle and fluid respectively, u is the fluid viscosity, d,, is

the particle diameter and h,,  is the height at minimum fluidization.

Bellgart & Werther (1986) estimated the lateral solid dispersion in fluidized beds by using
carbon dioxide pellets as a tracer. The sublimation of the latter is an endothermic process having
a thermal effect on the bed and the formation of gaseous CO, can be used to locate the tracer.
They measured the temperature gradient in the bed and the concentration of evaporated carbon
dioxide on the surface of the bed. From their experimental measurements, they obtained the

following correlations:

1 (7 3
Dy, = Dy + 0.023—f gdp3dh (4.14)
HJ, 1—t,

They determined the value of D, from the experiment to be 0.67 X 1073m?/s, g is the

acceleration of gravity, t, is the thickness of the suspension layer around a bubble and H is the

expanded bed height.

Berruti et al. (1986) determined the axial and lateral solid dispersion coefficient by continuously
measuring solid tracer concentration at different locations in the bed. They inserted a tube filled

with tracer up to a particular level in the centre of an empty reactor. Then, they charged sand
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into the reactor to reach the same level as the tracer. They fluidized both the tracer and the sand
for a certain time sufficient to reach stable fluidization, and the tube containing the tracer was
subsequently removed to allow the sand and the tracer to mix. Samples were collected and

analyzed. They obtained the following correlation:

D h 5
S —0.185 x107* [1 — <0.44 + 2.87—) (1) ]
(v — g )dyy hmys ) \R
-0.25 . _o.
(u = Umy)dppy R\ Pp — Pr o
X - — (4.15)
My dp Py

Here p, and p; are the densities of particle and fluid respectively, uy is the fluid viscosity, d,, is

the particle diameter and h,,  is the height at minimum fluidization.

Du & Wei (2002) studied lateral mixing behaviour of FCC particles in fluidized beds using
phosphor tracer techniques. They injected the tracer into the bed using pneumatic tracer injector.
With the aid of an electric flash, the phosphor tracers were excited and gave out emissive light
immediately. The intensity of light given out by the particles at various locations in the bed was
measured using a detector. The tracer concentration is proportional to the emissive light strength
of the particles. By performing the experiments under various operating conditions and particle
properties, Du & Wei (2002) derived the following correlation for the lateral solid dispersion

coefficient:

d.\ %53 0\ 072
D, = 0.018 Re,®"* exp[—19(1 — £)] (d—”> (p—p) $232 (4.16)
S S

Here ¢ is the sphericity of the particles, Re,, is the particle Reynolds number, d,, is the diameter

of tracer particles, p, is the density of particles originally in the bed and ¢ is the void fraction.

Several other empirical methods, reported in Table 4.1, have been used by researchers to study
the lateral dispersion of solids in fluidized beds. Kashyap & Gidaspow (2011) summarized these
methods as saline (Rhodes et al., 1991), ferromagnetic (Avidan & Yerushalmi, 1995), thermal
(Borodulya & Epanov, 1982), radioactive (Mostoufi & Chaouki, 2001), carbon (Winaya et al.,
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2007) and phosphorescent tracers (Du et al., 2002). These empirical approaches to studying
lateral solid mixing in fluidized beds have their limitations. For instance, in thermal tracking
techniques the heat transferred to the fluid phase and walls makes it difficult to interpret the
results. In radioactive tracing methods, safety of equipment and personnel are of great concern.
In phosphorescence tracking, most successful applications are usually in dilute fluidized beds.

Table 4.1: Experimental results on lateral solid mixing in gas-fluidized beds

Author Bed size (m) Tracer particles Range of Dsr (m?/s)
Highley & Merrick (1971) | @ 1.52 Radioactive 0.007 —0.015
Borodulya et al. (1982) ?0.70 Heated bed material Not evident

0.60 x 0.20

0.40 x 0.25

0.50 x 0.05
Shi & Fan (1984) 0.30 x 0.05 Dyed bed material 0.0001 - 0.0008
Subbarao et al. (1985) 0.20 x 0.010 Heated bed material 0.0001 - 0.08
Bellgardt &Werther (1986) | 2.0 x 0.3 Carbon dioxide ice 0.0007 — 0.0026
Berruti et al. (1986) ? 0.27 Potassium cyanide 0.0002 - 0.002
Xiang et al. (1987) 2.6x1.6 Coal particles 0.001-0.01
Salam et al. (1987) 0.90 x 0.15 Coal particles 0.0005 - 0.002
Yang & Kojima (1995) 0.30 x 0.05 Coal particles 0.0004 - 0.0016
Xiao et al. (1998) Tapered[ Mung bean 0.04-0.40

2.5x%0.15
Schlichthaerle & Werther | 1.0 x 0.3 Carbon dioxide ice | 0.12

particles

(2001)
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For all solid tracer techniques, the common limitation is that repeatable results are only
guaranteed if numerous runs of experiments are carried out, which may not be practicable in
real experiments. In addition to these, experiments with solid tracers are difficult to perform
because of lack of continuous sampling and existence of residual tracers. Furthermore, the
values of dispersion coefficients reported by these studies differ by up to four orders of
magnitude making it difficult to generalize or scale up the results from these studies (Liu &

Chen, 2010).

Despite previous experimental and theoretical investigations of the influence of geometry (Liu
& Chen, 2010; Xiao et al., 1998), operating conditions (Bellgardt et al., 1985; Bellgardt &
Werther, 1986; Chirone et al., 2004; Lim & Argarwal, 1994; Pallares et al., 2007) and particle
properties (Pallares & Johnsson, 2006; salam et al., 1987; Xiang et al., 1987) on lateral mixing
in fluidized beds, the understanding of how these parameters affect the dispersion coefficient is
still limited. This is because the mechanisms governing solid mixing are quite complex. There
are several disconnected values reported for lateral solid dispersion coefficients in the literature.
We observed differences of about five orders of magnitude in their values (Gidaspow et al.,
2004; Breault, 2006; Jiradilok, 2007). These differences are due to the fact that investigators
used different definitions, theories, and approaches to determine them (Kashyap & Gidaspow,

2011).

More importantly, studies on lateral solid dispersion in fluidized beds using a computational
approach are still scanty. This has hindered the advancement of knowledge on how various
design and operating parameters affect the coefficient. The computational approach to studying
lateral solid mixing in fluidized beds offers some distinct advantages: an accurate
computational-based model that describes well the lateral mixing process can be useful for the
design of fluidized bed reactors. This reduces time and eliminates the cost of constructing pilot

plants. It also helps to avoid the risks inherent in pilot plant scale-up processes. Another
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important advantage is that a fundamental model can help to shed light on the mechanisms of
lateral mixing potentially allowing for considerably more insight. To the best of our knowledge,
numerical works on lateral solid dispersion in fluidized beds have only been carried out by Liu
and Chen (2010) and Farzaneh et al. (2011). Liu & Chen (2010) employed a hybrid model to
determine lateral dispersion coefficient in large-scale fluidized beds. They used a combination
of Eulerian-Granular simulation and fictitious particle tracing technique. This approach involves
tracking massless fictitious tracer particles in the bed. They determined lateral dispersion
coefficients using two methods; micro and macro methods. The latter is based on fitting the
transient particle concentration profile by the Fickian-type diffusion equation, while the former
is based on statistics of particles from the Langrangian view. They used the Fickian-type
method to study the distribution of fuel particles over the cross-section of a fluidized bed,
assuming that the dispersion rate of fuel particles is the same as that of inert bed materials.
However, the validity of their approach has been questioned by Farzaneh et al. (2011). They
argued that the assumption that the dispersion rate of fuel particles and inert bed materials are
the same is not convincing because they have substantially different size and density. Farzaneh
et al. (2011) employed the Lagrangian modeling approach to determine lateral dispersion
coefficients. They developed a multi-grid Lagrangian model to study the lateral dispersion of
fuel particles in the inert bed materials. The approach was adopted to account for the size
difference between the fuel particles and the inert particles. By using statistical methods, they
determined the lateral dispersion coefficient in the bed. As with other Lagrangian-based

approaches, the method is limited with respect to the number of particles that can be tracked.

In the next chapter, we employed the Eulerian-Eulerian modelling approach to determine lateral
solid dispersion coefficients in fluidized beds, investigating how changes in operating
parameters affect it. The approach describes both the solid and fluid phases as interpenetrating
continua. The model consists of the continuity equations and linear momentum balance equation
written for each phase. These equations are valid for any physical and chemical system, and

therefore this approach does not introduce any assumption in the model, except for the
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constitutive equations needed to render the equations mathematically closed. We follow an
approach similar to that proposed by Brotz (1956). He used two solids of equal physical
properties, but differing in colour. The solids were separated by a vertical partition plate which
divided the bed into two equal parts. He fluidized the bed for a certain time and then removed
the partition; by measuring the rate at which the two solids mix, he estimated the lateral
dispersion coefficient. Following Brotz, we defined two solid phases, Solid-1 and Solid-2, with
equal physical properties, differing only in the names assigned to them in the computational
code. We then placed Solid-1 on the left and Solid-2 on the right of a removable partition. We
fluidized the bed with air at ambient temperature, allowing it to reach pseudo-stationary
conditions, and then removed the partition. From the radial concentration of the Solid-1 phase,

we estimated the lateral solid dispersion coefficient at the assigned operating conditions.

4.5 Conclusions

Efficient mixing is crucial in many fluidized bed processes including combustion, drying,
polymerization and granulation. To study the phenomenon of solid mixing, researchers often
investigate how solids mix vertically (axially) and horizontally (laterally) in the bed. There has
been considerable effort to investigate axial and lateral solid mixing experimentally.
Researchers have adopted several approaches including radioactive, thermal, saline and
phosphorescent tracing methods. In all these experimental techniques, the common limitation is
that repeatable results are only guaranteed if numerous runs of experiments are carried out,
which may not be practicable in real experiments. In addition to these, experiments with solid
tracers are difficult to perform because of lack of continuous sampling and existence of residual
tracers. More recently, computational fluid dynamics (CFD) simulations have proved to be
effective in the study of fluidized beds. By using CFD, it is possible to simulate the behaviour of

large-scale fluidized beds directly and gain insight into the fluid dynamic interactions in the bed.
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In the next chapter we focus on lateral solid mixing. We use the CFD modelling approach to

investigate it, examining the effects of operating conditions on it.
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Chapter 5

2D CFD simulations of lateral solid mixing in
gas-fluidized beds

This chapter is concerned with 2D CFD simulations of lateral solid mixing in gas-fluidized

beds.

1. We describe lateral solid mixing using the Eulerian-Eulerian modelling approach.

2.  We gquantify mixing by means of a lateral dispersion coefficient.

3. We investigate the influence of design parameters and operating conditions on lateral
dispersion coefficients.

4. We validate our numerical results with empirical correlations reported in the literature.

5. We investigate the influence of frictional stress models on our numerical results.

Parts of this chapter have been published:

Oke,O., Lettieri, P., Solimene, R., Salatino, P., Mazzei, L. 2014. Numerical simulations of
lateral solid mixing in gas-fluidized beds. Chemical Engineering Science, 120, 117-129.
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5.1 Introduction

In Chapter 4 we reported different experimental methods employed to investigate lateral solid
mixing in gas-fluidized beds. We emphasized the dearth of computational approach to studying
lateral solid mixing, stressing the need to further explore computational methods in
investigating the latter. In the present chapter we employ the multiphase fluid dynamic
equations, consisting of the continuity and linear momentum balance equations written for the
fluid and the solid phases, to investigate lateral solid mixing. These equations are valid for any
physical or chemical system, since they are essentially expressing the law of conservation of
mass and linear momentum. Nonetheless, these equations are mathematically unclosed. They
contain some indeterminate terms which must be closed in order to solve the governing
equations numerically. These terms are the fluid-particle interaction force, particle-particle
interaction force(this arises when there are more than one solid phases) and effective stress
tensor. The various constitutive equations employed to close these indeterminate terms are
reported. We then solve the governing equations along with their constitutive equations
numerically. We investigate the influence of superficial gas velocity, bed height and bed width
on lateral dispersion coefficients, validating the numerical results with experimental data.
Subsequently, we examine how the constitutive equations used to model the frictional flow
regime affect lateral dispersion coefficients. To begin, we report on how we define the lateral

dispersion coefficient and the methodology we adopt to estimate it.

5.2 Lateral dispersion coefficient — Definition and estimation

Sometimes one might be interested in estimating how fast particles mix in a fluid bed at given
operating conditions, without wanting to solve complex and numerically expensive models. One
way of doing this is resorting to axial and lateral dispersion coefficients; these, as said, are
effective diffusivities relating to the time that solids take to spread axially and laterally over a
given distance in the bed. We are going to focus on the lateral dispersion coefficient; therefore,

before going any further, let us clarify how the latter is defined. Most researchers (Brotz, 1956;
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Borodulya & Epanov, 1982; Shi & Fan, 1984; Liu & Chen, 2010) define it through an equation

analogous to Fick’s law of molecular diffusion, writing:

9,C = Dy, 02,C (5.1)

where C represents the void-free solids concentration, Dy, represents the lateral dispersion
coefficient and x is the horizontal spatial coordinate. This equation, as just said, should be
regarded as a definition of such coefficient. Let us briefly comment on the applicability of Eq.
5.1 to the present investigation. One might wonder how the diffusion equation above can be
relevant to the study of lateral solid mixing in fluidized beds. Lacey (1954) proposed a
diffusion-like mechanism for solid mixing, arguing that particles spread through a surface in a
manner similar to ordinary molecular or thermal diffusion. Each particle has equal chance of
moving to either side of the surface, closely resembling the motion of molecules of a gas.
Indeed, experimental data obtained by Carstensen and Patel (1977) revealed that mixing of
binary particles can be well characterized by Eq. 5.1 as long as the mean diameter of the
particles are identical, the coefficient Dy, appearing in the equation lumping together the effects
of various mechanisms responsible for solid mixing such as wake transport, emulsion drifting,
bubble coalescence and break-up. Therefore Dy, is affected by operational and design
conditions such as superficial gas velocity, bed height, bed geometry, bed width, including
material properties such as particle size and density. This makes Dy, different from the
diffusion coefficient appearing in the original Fick’s law which is constant for a given solute in
a solvent. For shallow beds, particle ejection/fall-back in the freeboard upon bubble bursting at

the bed surface may also be relevant.

Take a 2D bed (we consider two dimensions to simplify the description, but similar
considerations hold in three dimensions) where the concentration of solids depends in general
on both spatial coordinates, so that ¢ = c(x,y,t), with x and y denoting the horizontal and
vertical coordinates, respectively. The concentration in Eqg. 5.1 is averaged over the vertical

direction, and hence is a function of the x coordinate only, so that C = C(x,t). For a given
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system, by matching the actual concentration function C,(x, t), which one can determine either
experimentally or numerically, with the analytical solution of Eq. 5.1, one can find the lateral
dispersion coefficient. We should bear in mind that, unlike molecular diffusion coefficients, D,
is not just a function of the particle properties, but depends on the system geometry and on the
operating conditions. Let us be more specific. Often, to determine the lateral dispersion
coefficient, one considers a bed divided into two equal compartments; the particles occupying
the compartments differ solely in colour (having in particular same size and density). For
instance, one can have red particles in the left compartment and white particles in the other, as
shown in Figure 5.1. The functions c(x, y, t) and C(x, t) represent the concentration of just one
kind of particles, say the red ones, which are regarded as tracer particles. Hence, the initial

conditions characterizing this particular setup are:
_ L L
t=0. C=C for 05x<§ and C =0 for §<xSL (5.2)

The boundary conditions that one needs to assign to solve Eq. 5.1 are:

x=0, x=1L; J,C =0 (5.3)

/ Removable partition

Figure 5.1: A set-up for estimating lateral dispersion coefficients
%

——_

s

clx.t)

Figure 5.2: A set-up showing vertical layers for estimating lateral dispersion coefficients
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In the real experiment (which may be numerical) the two compartments, as reported above, are
separated by a removable wall. At time ¢t = 0, one fluidizes the system, waiting for the latter to
reach pseudo-stationary conditions. Then one removes the partition, letting the red and white
particles spread through the bed. The void-free concentration of red particles, which one in
theory could measure (or calculate numerically), is c(x,y,t). One can then divide the bed in a
given number of vertical layers, as shown in Figure 5.2, and calculate the value of C, in each

layer using the relation:

Co(x,t) = 1 c(x,y, t)dv (5.4)
Vi ly

L

where V; denotes the volume of each vertical layer. The next step is solving Eq. 5.1, using the

conditions in Eq. 5.2 and 5.3. For this simple system an analytical solution is given by:

Cxt;Dy) 1 2°°1, P L, t
— 7 3 ;Za cos (anz) exp (—a T m) (5.5)

Here we have reported explicitly the dependence of the analytical solution on the parameter Dy,.
Then, to estimate Dy, we simply match the profiles C.(x,t) and C(x,t; Dg,.). To do this, we

define:
= [C(x,t; Dgy) — Ce(x, t)]z (5.6)

The task of determining D, then reduces to finding the value of Dy, that minimizes G in Eq.
5.6. This value gives the lateral dispersion coefficient for the system under investigation. By
repeating this procedure for many geometries and operating conditions, one can obtain a
correlation of the form written in Eq. 5.7, which others can then use to estimate Dy, ; this
reduces the need for solving complex models or conducting experiments each time one is

interested in estimating Ds,..

(u = ) himg Ky Tdy o dy
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Here w is the superficial gas velocity, u,,; the minimum fluidization velocity, h,,; the height at
minimum fluidization, p,, the particle density, p the fluid density, u; the fluid viscosity and L

the bed width.

As said, one can use the lateral dispersion coefficient Dy, to roughly estimate the time 7 that
solids take to spread laterally over a distance L in the bed. To demonstrate this, we note that:

ac ¢ ac ¢ a (ac> C/L_C

ot t ' odx L ' 0x\ox L 12
where C represents the concentration scale (whose value does not affect 7, because Eq. 5.1 is

linear in the concentration). Eq. 5.1 thus yields:

LZ
T~— (5.8)
D,

So, if one knows the value of Dy, for a given design and set of operating conditions, one can

estimate the time t required for the solids to spread laterally over the length L in the bed.

We would like to emphasize that the parameter Dy, in Eq. 5.1 is different from the coefficient
appearing in the original Fick’s law. In the latter the parameter is molecular diffusivity, which is
constant for a solute in a given solvent. Fick’s law relates only to the diffusion of molecules
generated by their random motion. The lateral dispersion coefficient, conversely, is affected by
various competing mechanisms. These, as experimental evidence reveals, include bubble break-
up at the upper bed surface and subsequent ejection of particles into the freeboard, wake
transport, and drifting of emulsion owing to the passage of bubbles. Hence, the lateral
dispersion coefficient is affected by several variables, among which we find bubble size and
velocity, particle size and density as well as fluid density and viscosity. Shi & Fan (1984)
reported that gross particle circulation also affects lateral mixing, this circulation in turn
depending on bed height and superficial gas velocity. Determining Dy, is therefore quite

challenging.

108



Chapter 5 CFD simulations of lateral solid mixing 2016

Another clarification is in order. As said, when calculating lateral dispersion coefficients, we
operated in terms of concentrations averaged along the vertical direction of the bed, considering
the function C(x, t), defined through Eq. 5.5, in place of the function c(x, y, t). In doing so, we
lost information about vertical variations in concentration, which we expect to be present; these
variations, nevertheless, are accounted for, inasmuch as they affect the value of C(x,t) and in
turn that of D,,.. We had to operate in terms of vertically-averaged concentrations, for we
decided to define D, through Eq. 5.1, which is one-dimensional and accounts solely for
variations along the horizontal space coordinate. We employed Eq. 5.1 to define Dy, because
this is the relation usually used in the literature; in particular, the researchers cited in this article
who measured D, experimentally - and whose results we used to validate our simulations - did
adopt this definition and, as a consequence, operated in terms of vertically-averaged

concentrations.

5.3 Multiphase fluid dynamic model

The governing equations in this work consist of balance equations for mass and linear

momentum written for the fluid and the two solid phases:
Continuity equation — Fluid phase
0 = — V- cuy (5.9)
Continuity equation — Solid phase i
0ty =— V- (5.10)
Dynamical equation — Fluid phase
0¢(eppusp) = = V- (epeusup) + V- S —nif1 —nof2 + €peg (5.11)
Dynamical equation — Solid phase i
0c(Pipiuy) = — V- (Pipiuwsuy) + V- S; + nifi —nif e + dipig (5.12)
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Here i is a phase index, subscripts 1 and 2 identify the solid to the left and to the right of the
partition, respectively (as reported in Section 5.2), p, and p;, € and ¢; are the densities and
volume fractions of the fluid and solid phases, respectively, while g is the gravitational
acceleration. Furthermore, us, u;, S¢, S;, fi, and f are the averaged velocities, effective stress
tensors and interaction forces per unit particle exerted by the fluid and by the kth solid phase on
the ith solid phase, respectively. The equations written above are unclosed; various terms need

to be expressed constitutively.

5.3.1 Fluid-particle interaction forces

The main components of the fluid-particle interaction force are the buoyancy and drag forces.
We neglect other contributions (Owoyemi et al., 2007); thus, we write f; = f;° +fl-d. We
define the buoyancy force as n;f;* = —¢;Vp,. We close the drag force using the expression of

Mazzei & Lettieri (2007):

3 Pe llueg —u; ll ey _ ,
nifi® = Bi(ur —w;) ;o Bi= ZCD(Rei) c 7 7 . - g (ERe) (5.13)
L
Ing(s, Re;)) Cp" (& Rey)
,Re)) = —————— ; ,Re)) = ———— L ¢200-m)
_1 _1
Cp(Re) = (0.63 + 48Re; 2)2  ;  Cp*(g,Re;”) = (0.63 + 4.8Re;* 2)?
_Pr _ . _Re;
Rel- = Eé‘ " U,f —U; " di ; Rei (E,Rei) = g_n ;
.. 48+24-0.175Re;*3/*

n(Re;’ ) = (5.14)

14 0.175Re;"3/*

Here d; is the particle diameter of the ith solid phase, Re; and Re;" are particle Reynolds

numbers, while C, and C,,” are drag coefficients.
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5.3.2 Particle-particle interaction force

We assume that the interaction force f;, exchanged between particles of different phases
includes only a drag-like contribution. Therefore, it is proportional to the slip velocity between

the phases. We use the constitutive equation developed by Syamlal (1987):

nifix = i (W — ;) ;

)Pipk¢i¢kgik(di + dy)?

S = 2 (1 + e (1+3F,
e . . pidi® + prdi’

2 Il wy —u; |l (5.15)

where e, is a coefficient of restitution equal to 0.90, F;; is a coefficient of friction equal to
0.15 and g;, is a radial distribution function that one obtains by combining the radial
distribution functions g; and g, of the ith and kth particle phases, respectively. Their

expressions are:

d; % P ¢ \3 o digx + dirg;
AT e
L

Here ¢ is the overall solid volume fraction, while ¢, 4, is the maximum value that ¢ can attain.

5.3.3 Effective stress
We close the effective stress tensors using the Newtonian constitutive equations:
2
Sy = —pel + 2uDy + (kp = 2pp) (rD )1 (5.17)
2
Si = _pll + Z/Jl'Dl' + (K'i - §,ul> (tTDi)I (518)

where pg, p;, 1r, 1;, Ky and k; are the averaged pressures, viscosities and dilatational viscosities
of the fluid and particle phases, respectively; I is the identity tensor, while Df and D; are the

rate of deformation tensors defined as:
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1 1
D; = E(Vuf +Vu") ; D;= > (Vu; + V") (5.19)

Closing the effective stress tensors therefore reduces to finding constitutive expressions for the
pressure, viscosity and dilatational viscosity of each phase. The fluid is regarded as
incompressible and so the fluid pressure does not need a constitutive expression. The viscosity
uy is assumed to be constant, while the dilatational viscosity k¢ is neglected. For the solid

phases, we need constitutive expressions to model all these quantities.

The solid phase can be in two flow regimes: the viscous regime where particles undergo
transient contacts and momentum transfer is translational and collisional, and the frictional
regime, where particles are in enduring contacts and momentum transfer is mainly frictional. In
both regimes, the solid phase is modelled as a continuum; in the viscous regime it is
characterized by a viscous solid pressure p;¥, viscosity ;¥ and dilatational viscosity x;¥, while
in the frictional flow regime it is characterized by a frictional solid pressure p;/, viscosity u;”

and dilatational viscosity ;.

We express p;¥ using the closure of Lun et al. (1984)

d; + dy

dipi®; ; di = > (5.20)

p’ =

> (i)
1+2 ) (7)) A +ew)degi
k=1

Here ©; is the granular temperature of the ith phase. In the present study, d; = d, e;; coincides
with the restitution coefficient e; and g;, reduces to g;. For the viscosity u;* we adopt the

closure of Gidaspow (1994):

1
10p;d;/T0; 4 2 4 0; \2
=N T 114-(1 ] —¢2p;id;g;:(1 (—) 21
W= Serrena | Lt eddig| +5olndia+e) (S (5.21)
For the dilatational viscosity x;” we use the closure of Lun et al. (1984):
1
v 4 2 @i 2
K" =20 pidigi(1+ e;) (?) (5.22)
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The granular temperatures are governed by balance equations for the pseudointernal energies
related to the fluctuation velocities of the particles (Gidaspow, 1994; Syamlal et al., 1993). The
equation reads:

0c(dipiU) = = V- (pipiUpwy) — V- q; + S Vuy + 6% — 5,7 — S;° (5.23)
where S;€ is a sink term representing losses of pseudointernal energy caused by inelastic
collisions, Gl-d is a source term representing the generation of particle velocity fluctuations by
fluctuating fluid-particle forces, while S;” is a sink term representing dampening of particle
velocity fluctuations caused by viscous resistance to particle motion. The pseudointernal energy

per unit particle mass is U; = %, and q; is the pseudothermal heat flux. For the closures of

q;, G;%, S;¥ and S;¢ we refer to Gidaspow (1994).

In the frictional flow regime, as reported earlier, particles interact largely through frictional
enduring contacts. These are not accounted for by the kinetic theory of granular flow. Therefore,
to model the flow properties in this regime, one needs to adopt the theories of plasticity and soil
mechanics. Shaeffer (1987) developed a model that relates u; to p;/ based on the principles of

soil mechanics. The model reads:

;_pdsing

25 2\/1—2

(5.24)

where ¢ is the angle of internal friction and I, is the second invariant of the rate of deformation
tensor. The frictional solid pressure is often modelled by means of arbitrary functions that have
no theoretical basis but correctly describe qualitatively how dense granular media behave
(Syamlal et al., 1993). The prime feature that must be captured is that such materials cannot
reach compactions that are unphysically high. A closure for the frictional solid pressure that

some modellers use is:

pi = ¢ip* where p* = 104(¢ — Prnin) & (5.25)
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where ¢,,,;, is the frictional packing limit, and A and B are coefficients having typical values of
25 and 10, respectively. This equation is extremely sensitive to the deviation of ¢ from ¢,,in
and this could lead to big pressure fluctuations and violent numerical instabilities (Schaeffer,
1987). Eq. 5.25 is often employed with radial distribution functions that are bounded and so do
not diverge positively when ¢ approaches ¢,,,,. For instance, the model of Syamlal et al.

(1993), used in the CFD code MFIX, adopts the expression of Lebowitz (1964):

2
_ 3d; " Px
9i = (1 to2 E _dk) (5.26)

k=1

where, as opposed to Eq. 5.16, ¢4, does not feature. As in Eqg. 5.16 g; diverges when ¢
approaches ¢4, the viscous solid pressure already prevents the mixture from overpacking;
therefore, one can use the same equation used to model the viscous solid pressure, that is, Eq.
5.20, to model also the total solid pressure in the frictional regime (instead of summing to the
viscous solid pressure an additional contribution modelled by means of an arbitrary divergent

function, qualitatively sound but theoretically unfounded).

These considerations induced us to employ the so-called KTGF-based model, a frictional model
partly based on the kinetic theory of granular flows (KTGF) which accounts only for the
frictional viscosity u;” neglecting the frictional solid pressure p;/ and the frictional dilatational
viscosity ;. When ¢ exceeds ¢y, the model keeps on using the viscous closure for the solid

pressure, Eq. 5.20, but increases the solid viscosity by adding to the viscous contribution, Eq.

5.21, the frictional one given by Eqg. 5.24. As a consequence, the solid viscosity becomes:
ui= il + (5.27)

In Eq. 5.24 the pressure used in the calculation is the viscous solid pressure (which, as said,

coincides with the total solid pressure, since the frictional solid pressure is not considered).

114



Chapter 5 CFD simulations of lateral solid mixing 2016

5.4 Boundary and initial conditions

The computational grid (uniform, with square cells of 5 mm side) is two dimensional; hence the
front and back wall effects are neglected. On the left, right and middle walls, no-slip boundary
conditions apply. At the bottom of the bed, a uniform inlet fluid velocity u is specified. The
fluid is ambient air. At the upper boundary, the pressure is set to 10° Pa. On all the boundaries,

the solid mass fluxes are set to zero.

Initially, the bed is fixed and consists of two equal and adjacent compartments partitioned by a
removable wall. Each compartment consists of solids having the same size and density. The
voidage is set to 0.4 everywhere in the bed. We fluidize the solids in each compartment with the
same superficial gas velocity for about three seconds until they reach stable fluidization, and
then we remove the partition. To obtain the horizontal solid volume fraction profiles in the bed,
we divide the bed into twenty equal vertical layers evenly distributed over the horizontal
direction and we compute the void-free solid volume fraction in each layer following the

procedure reported in Section 5.2.

5.5 Results

We considered two sets of powders: Powder 1 was used by Shi & Fan (1984) in their
experimental study of lateral mixing of solids in batch fluidized beds, and Powder 2 was
investigated by Mori & Nakamura (1965). The parameters used to simulate these powders, in
particular the geometry and the bed height, are chosen to replicate the experimental work of
these authors. We report in Table 5.1 the parameters employed in the simulations of Powder 1;

those for Powder 2 are reported in Table 5.2.
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Table 5.1: Simulation parameters for Powder 1

Parameters Value

Vessel height 0.35m

Bed Width 0.20-1.00 m
Superficial gas velocity 0.87-1.17m/s
Particle diameter 491 um

Particle density 2620 kg/m?3
Minimum fluidization velocity 0.20 m/s

Bed height 0.05-0.11m
Computational cell 0.005 m
Time-step 0.001 s

As said in Section 5.2, we fluidized the bed, divided it into two equal parts by a removable

partition, for a certain period, allowing them to reach pseudo-stationary conditions, and then

removed the partition. We ran preliminary simulations, removing the partition after running

simulations for three and five seconds, and comparing the void-free concentration profiles

obtained in the two cases, as shown in Figures 5.3 — 5.6. The figures show the void-free

concentration profiles at different times measured after the partition was removed. We observed

that there was no significant difference between the two; consequently, in subsequent

simulations, we removed the partition after three seconds.

Table 5.2: Simulation parameters for Powder 2

Parameters Value

Vessel height 0.30m

Bed Width 0.90m
Superficial gas velocity 0.45-0.75m/s
Particle diameter 595 um

Particle density 1400 kg/m?3
Minimum fluidization velocity 0.25 m/s

Bed height 0.17-0.23m
Computational cell 0.005m
Time-step 0.001s
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Figure 5.4: Void-free mass fraction profiles at t = 2.0 seconds after removing the partition.
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5.5.1 Effect of superficial gas velocity

From the solid volume fraction profiles obtained numerically, we calculated the void-free mass
fraction ¢; of solid phase i in each layer:

~ _ P
4 1t 9

(5.28)
We ran the simulations at various superficial gas velocities (starting from 0.87 m/s, which is the
minimum velocity investigated experimentally by Shi & Fan, 1984, up to 1.17 m/s, with
increments of 0.10 m/s), keeping the minimum fluidization bed height at 5.23 cm (which is the
maximum bed height at minimum fluidization conditions investigated by Shi & Fan, 1984) and
the bed width at 0.6 m (which is the single bed width investigated by Shi & Fan, 1984). We
fitted the void-free mass fraction profiles obtained from our simulations with those obtained
from the analytical solution of Fick’s law, using the least square regression method, as reported
in Section 5.2. In Figures 5.7 and 5.8 we report the profiles of void-free mass fraction obtained
from the Fick’s equation (Eq. 5.1) and those obtained numerically at t = 5.0 s for superficial gas
velocities of 0.87 and 1.07 m/s respectively. Similar profiles are found at other times, but we
have chosen 5.0 s as representative time. We obtained a reasonable fit, as Figures 5.7 and 5.8
show. Figure 5.9 shows the values of dispersion coefficients calculated at different times for

different superficial gas velocities. We observe an initial, sudden, increase in Dy, in the first two

seconds. Subsequently, the values of D, remain approximately stable.

Figure 5.10 reports the snapshots of particle concentrations obtained from the simulations at a
superficial gas velocity of 0.87 m/s (4.35 times u,,f). The figure shows how particles placed at
the left of the removable partition spread to the right. We observe from Figure 5.10 that the
spread of the particles proceeds in a manner similar to what one would observe in, for instance,
the molecular diffusion of ink in water; even though in this case the spread of particles is
induced primarily by bubbles. This diffusion-like spread of particles explains why we obtained

a reasonable fit between our numerical results and those obtained from the Fick’s equation.

119



Chapter 5 CFD simulations of lateral solid mixing

2016

D,,=0.00313 m?/s

0.9

—— Fick

os\.\-

® Fluent

. Y

t=5.0s

%

o
n

/

Void-free mass fraction [-]

o
N

0.1

0 0.1 0.2 0.3 0.4
Horizontal Coordinate [m]

0.5

0.6

Figure 5.7: Solid 1 void-free vertically-averaged mass fraction horizontal profiles for a superficial fluid
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Figure 5.9: Lateral dispersion coefficients at different superficial gas velocities for Powder 1

Figure 5.10: Solid 1 volume fraction profiles at different times for superficial fluid velocity of 0.87 m/s
for Powder 1. The minimum fluidization bed height is 5.23 cm, while the bed width is 0.60 m. The
horizontal dashed line indicates where the bed ends and the freeboard begins.
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The snapshots showing the contours of particle concentrations at superficial gas velocity of 1.17
m/s (5.85 times wu,, ;) are reported in Figure 5.11. It is interesting to observe that the contours of
solid volume fraction shown in this figure are partly different from those in Figure 5.10, even
though the snapshots were taken at the same computational times. In Figure 5.11 we observe
streams of particles transported into the freeboard in a region close to the bed surface. This is
caused by the burst of bubbles and subsequent ejection of their solid content into the freeboard.
As reported by Davidson & Harrison (1971), particles are carried up through the bed in the
bubble wakes, and when bubbles burst, part of them spreads over the surface of the bed. This
kind of solid transport is absent in Figure 5.10. This additional mechanism, observed when the
superficial gas velocity is larger, contributes to the higher value of D, obtained at this velocity,

as reported in Figure 5.12.

INANE ..

Figure 5.11: Solid 1 volume fraction profiles at different times for superficial fluid velocity of 1.17 m/s
for Powder 1. The minimum fluidization bed height is 5.23 c¢cm, while the bed width is 0.60 m. The
horizontal dashed line indicates where the bed ends and the freeboard begins.
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In Figure 5.12 we plot D, against the superficial gas velocity, comparing our simulation results
with those obtained from empirical correlations available in the literature. We observe that the
value of the dispersion coefficient increases as the superficial gas velocity increases. This is
expected, because an increase in velocity induces more vigorous mixing in the bed, rendering
solid circulation more intense and enhancing lateral solid transport. As said, at higher superficial
gas velocities an additional mechanism affects lateral mixing; this is the solid transport across
the bed surface caused by bubble eruption. These observations were also reported by Kunii &
Levenspiel (1989). Figure 5.12 also shows that the numerical values of the dispersion
coefficient have the same order of magnitude as those given by the empirical correlations, but in

all cases overestimate the latter. We will later address the reason for the overestimation.
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Figure 5.12: Dispersion coefficient values at different superficial fluid velocities for Powder 1. The
minimum fluidization bed height is 5.23 cm, while the bed width is 0.60 m. The values are compared with
those obtained from empirical correlations in the literature.

5.5.2 Effect of bed height

We investigated the effect of bed height on lateral dispersion coefficients. To do this, we ran

simulations at different minimum fluidization bed heights (spanning the range between 5.23 cm
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and 11.23 cm), fixing the superficial gas velocity at 1.07 m/s (5.35 times u,,f) and the bed
width at 0.6 m. Following the same procedure outlined above, we obtained the void-free
horizontal mass fraction profiles in the bed. We report in Figure 5.13 and 5.14 the profiles when
the bed height is 7.23 and 9.23 cm, respectively. The numerical profiles fit reasonably well the
analytical ones obtained from the Fick’s law. As shown in Figure 5.15, we observe an increase
in dispersion coefficient as the bed height is increased. This is because as the bed height
increases, bubbles grow in size causing more recirculation and more particles to be drawn into
their wakes. As bubbles erupt at the bed surface, they eject more particles into the freeboard,
enhancing the lateral transport of solids. These effects are observed in the snapshots of solid

volume fraction reported in Figure 5.16 for different bed heights att =5.0 s.
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Figure 5.13: Solid 1 void-free vertically-averaged mass fraction horizontal profiles for a minimum
fluidization bed height of 7.23 cm for Powder 1. The superficial fluid velocity is 1.07 m/s, while the bed
width is 0.60 m. The ‘Fick’ profile is that obtained from the analytical solution of the Fick’s law, while
the ‘Fluent’ profile is that obtained numerically.
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Figure 5.14: Solid 1 void-free vertically-averaged mass fraction horizontal profiles for a minimum
fluidization bed height of 9.23 cm for Powder 1. The superficial fluid velocity is 1.07 m/s, while the bed
width is 0.60 m. The ‘Fick’ profile is that obtained from the analytical solution of the Fick’s law, while
the ‘Fluent’ profile is that obtained numerically.
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Figure 5.16: Solid 1 volume fraction profiles at minimum fluidization bed heights of 5.23 cm, 7.23 cm,
9.23 cm and 11.23 cm for Powder 1. The superficial fluid velocity is 1.07 m/s, while the bed width is 0.60
m. The horizontal dashed line indicates where the bed ends and the freeboard begins.

As the bed height increases, the size of the bubbles increases, implying that greater volume of
emulsion can be driven aside. This leads to more intense mixing, and hence increases solid
lateral transport. We also compared the simulation results with empirical correlations available
in the literature, as shown in Figure 5.15. The values of dispersion coefficients obtained from
the simulations have the same order of magnitude as those given by the empirical correlations;

again, however, the numerical results overestimate the empirical ones.

5.5.3 Effect of bed width

Most researchers investigating lateral solid dispersion in fluidized beds often neglect the
influence of bed width. For instance, Shi & Fan (1984) in their experimental work on lateral
solid mixing in batch gas-fluidized beds summarized the mechanisms governing lateral solid
mixing as: bubble movement through the bed, bubble burst at the surface, and gross particle
circulation in the bed. In summarizing the parameters on which these mechanisms depend, they

did not include bed width. Several other authors (Berruti et al., 1986; Bellgardt & Werther,
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1986; Salam et al., 1987; Xiang et al., 1987; Winaya et al., 2007) who have developed empirical
correlations for lateral dispersion coefficients also ignore bed width as a parameter that might
affect it. We believe that bed geometry should influence lateral mixing, and hence the
coefficient quantifying it, D,.. This is because bed geometry plays a crucial role in gross particle

circulation, which is an important mechanism responsible for lateral solid mixing.

To investigate the influence of bed width on lateral solid dispersion, we considered beds of
different widths, ranging from 0.2 to 1.0 m. We fluidized these beds, maintaining the superficial
gas velocity at 1.07 m/s and the minimum fluidization bed height at 5.23 cm. We then
determined the lateral dispersion coefficient at each value of bed width, using the approach
described previously. In Figure 5.17, we report the values of the dispersion coefficient at
different bed widths. The figure shows that the coefficient increases rapidly as the bed width
increases from 0.2 to 0.4 m, afterwards increases slowly and finally becomes approximately

constant.
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Figure 5.17: Dispersion coefficient values at different bed widths for Powder 1. The superficial fluid
velocity is 1.07 m/s, while the minimum fluidization bed height is 5.23 cm.
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To explain this trend, let us briefly report on the observation by Pallarés et al. (2007) regarding
the mechanisms of lateral solid mixing. They reported that lateral solid mixing is due to
horizontally aligned vertical vortices, rotating in alternate directions (these vortices are referred
to as mixing cells). In these mixing cells, the following mechanisms for solid mixing take place:
bubble wake mixing, drifting aside of emulsion and bubble eruption at the bed surface. The net
lateral solid transport in the bed results from the exchange of solids in the mixing cells and is
determined by the integral length scale of macroscopic solids circulation patterns. It is likely
that the integral length scale of solids circulation be constrained by bed width for comparatively
narrow beds. For wide beds the integral length scale of solids circulation, hence lateral solid

transport, should rather be dictated by bed height.

5.6 Discussion

It is clear from the results presented above that the values of D, obtained from our simulations
are larger than those predicted by empirical correlations, albeit the order of magnitude of the
coefficient is correctly captured. We believe that this overestimation has two main causes. The
first relates to how the frictional stress of the solid phase is modeled constitutively; we address
this aspect in the next section. The second has to do with the dimensionality of our simulations.
Our simulations are 2D (a choice often found in the literature, in our case dictated by our
computational resources, the real-time duration of each simulation and the number of
simulations that our analysis requires). In actual fluidized beds the lateral motion of the solid
has, we might say, two degrees of freedom (bubble-induced particle lateral motion develops in a
horizontal plane), while in 2D fluidized beds only one degree of freedom is present (particle
lateral motion can only develop along a horizontal line). Hence, when comparing lateral solid
dispersion coefficients obtained numerically by means of 2D simulations with those estimated
using empirical correlations, one needs to account for the 2D nature of the simulations. As
discussed by Norouzi et al. (2011), omitting one dimension in the simulations significantly
affects the value of the coefficient. The latter, in particular, is overestimated, as we have also
observed in our work. We shall address this aspect later.
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5.7 Influence of hydrodynamic models

The Eulerian equations of motion adopted in this work, as said in section 5.1, contain
indeterminate terms that need to be expressed constitutively. Such terms are the fluid-particle
and particle-particle interaction forces and the fluid and solid stress tensors. To close the stress
tensors, one usually regards the phases as Newtonian continua; therefore, the closure
relationships take the form reported in Eq. 5.17 and 5.18. So, the problem of closure reduces to
finding constitutive expressions for the pressure, viscosity and dilatational viscosity for each

phase. For the solid phases one needs to model these parameters constitutively.

To model the solid stress, one usually adopts the kinetic theory of granular flows (KTGF). This
assumes that particles are smooth and spherical, that collisions are binary and instantaneous and
that the powder is far from the frictional packing limit. Thus, the kinetic and collisional
momentum transfer arising from the particle velocity fluctuations and the particle collisions are
modelled following the Enskog theory for dense gases (Chapman and Cowling, 1970).
Nevertheless, in several fluidized bed applications, like the one investigated in this work,
particles interact largely through frictional enduring contacts, and the kinetic theory of granular
flows does not take into account these important interactions. Hence, using the kinetic theory to
model the solid stress in dense systems is inadequate and creates problems. We will now discuss

in detail these problems.

In regions of high solid volume fraction, particles interact with multiple neighbours and the
mechanism for stress generation is not just due to kinetic and (particularly) collisional
contributions, but also to sustained contacts among particles. These contacts make particles
dissipate a lot of energy, making them form very dense regions in the bed. This increases the
ability of the granular assembly to resist shearing, because tangential frictional forces at contact
points are now present. Consequently, the frictional viscosity of the bed is larger than that

predicted by the granular kinetic theory model, insofar as this does not account for frictional
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interactions. So, using the kinetic theory alone to model dense fluidized beds underpredicts the

solid viscosity, overestimating in turn the extent of particle mixing.

Enduring particle contacts in dense regions of fluidized beds do not only affect the viscosity of
the solid phase, but also its pressure. The latter has a more pronounced effect on the fluid
dynamics of the bed than the former, for the solid pressure influences significantly the
formation and the size of the bubbles. Let us explain why. The two-phase theory by Toomey &
Johnstone (1952) suggests that the void fraction around the bubbles and that in the emulsion
phase are equal, for the theory assumes that all the gas in excess of that required to just fluidize
the bed results in the formation of bubbles, the emulsion phase remaining at minimum
fluidization conditions with uniform void fraction. However, local measurements of bed
porosity by Lockett et al. (1967), done via capacitance probes, revealed that the void fraction
around the bubbles is not uniform. This was observed experimentally by many other authors
(Nguyen et al., 1973; Collins, 1989; Fan et al., 1990). Experimental investigations of voidage
distributions around bubbles by Yates et al. (1994), and numerical simulations by Patil et al.
(2005), confirmed this, showing that the void fraction decreases exponentially from the bubble
interface to the bulk of the emulsion phase. Figure 5.18 reports the void fraction distribution
around a bubble, as revealed by experimental and numerical studies (Patil et al., 2005); regions
A, B and C represent the bubble, the bubble boundary and the bulk of the emulsion phase,
respectively. A question that one may want to ask is how the void fraction distribution around
the bubbles and the frictional interactions among the particles affect the size of the bubbles.
Answering this question will allow us to highlight the role of frictional stress on the dynamics

of bubbling beds.
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Figure 5.18: Solid volume fraction profile vs. normalized distance from the bubble centre (d;/D,). d; is
the distance from bubble centre and D,, is the bubble diameter.

The bubble size is affected by the resistance that the gas finds to cross the bubble boundary and
reach the emulsion phase. The larger the resistance, the less leaky the bubble boundary is and, in
consequence, the larger the bubble results. The resistance through the bubble boundary depends
on the drag experienced by the gas. This decreases when the void fraction around the bubbles
increases. The frictional solid pressure strongly influences the void fraction distribution around
the bubbles by reducing the compaction of solids around their interface, which increases the gas
flow through the bubble boundary into the emulsion phase, thereby leading to smaller bubbles.
Hence, if one employs the kinetic theory to model the solid pressure, without accounting for
frictional stress, the solid pressure and in turn the void fraction around the bubbles are
underestimated. This increases the drag experienced by the gas around the bubble boundaries
and in turn reduces the gas leakage from the latter. This makes numerical simulations

overestimate the sizes of the bubbles and the extent of particle mixing.

To overcome this problem, Johnson & Jackson (1987) proposed that the frictional stress should

be added to the viscous stress modeled by the granular kinetic theory. The latter, as said,
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captures the flow regime in which the solid pressure is dictated mainly by kinetic and collisional
contributions, whilst the former captures the flow regime in which enduring contacts are present
among the particles. Even if the physical basis of adding the two stress contributions might be
argued, the approach captures well the two extremes of granular flow. The frictional stress is

usually modeled as follows:
O'if = —plfl + le(vul + VuiT) (529)

where p;/ is the frictional pressure and u;” is the frictional viscosity (the dilatational viscosity
is usually neglected). When the solid volume fraction exceeds a threshold value ¢,,i,, the

frictional contribution to the solid pressure and viscosity are added to the viscous contribution:

pi=p’+p) . wm=w" (5.30)

Johnson & Jackson (1987) proposed the following constitutive equation for the frictional

pressure:

(¢_¢min)a
F —d)b "’ ¢ = (pmin
Pif = (Pmax—) (531)
0 ¢ < ¢min

Here F, a and b are empirical constants, ¢,;,;, is the minimum solid volume fraction at which
particles start generating stress through enduring contacts, while ¢, is the maximum volume
fraction that the particles can attain. The frictional viscosity is then related to the frictional

pressure by the Coulomb (1776) friction law:
w' =psing (5.32)
where ¢ is the angle of internal friction of the granular material.

Another approach to modelling frictional stress was proposed by Shaeffer (1987) based on the

principles of soil mechanics. The frictional pressure is given by:

pif = 1025(¢ = Omin) 10 (5.33)

132



Chapter 5 CFD simulations of lateral solid mixing 2016

While the frictional viscosity is modelled by:

;o pi/ sing
N

Hi (5.34)

where I, is the second invariant of the rate of deformation tensor.

Following the reasoning of Johnson & Jackson (1987), Srivastava & Sundaresan (2003)
employed an additive approach to describe the solid stress, using Eq. 5.31 to model the
frictional pressure. To model the frictional viscosity, they adopted a modified form of Shaeffer’s

model:

S sin
w = _posing (5.35)

2 12+%

where ©; is the granular temperature and d,, is the particle diameter. The additional term

0, /dp2 ensures that numerical singularity is avoided in regions where I, approaches zero,
provided that in such regions the granular temperature does not vanish. They used this hybrid
model to simulate the rise of a bubble in a fluid bed. To highlight the role of frictional stress on
the bed dynamics, they ran another simulation without accounting for it. The results of their
simulations revealed that frictional stress influences the bed dynamics significantly, affecting
the shape and size of the bubbles. Passalacqua & Marmo (2009) employed the model of
Srivastava & Sundaresan (2003) to investigate the influence of frictional stress on bubble
growth in fluidized beds. They reported that it affects significantly the size of the bubbles: with
frictional stress accounted for, the predicted bubble size was significantly lower than that
observed in simulations with no frictional stress implemented. They also showed that the value
ascribed to ¢,,,;,, appearing in Eq. 5.31, plays a key role: the size of the bubbles predicted with
lower values of ¢,,;,, are smaller than those obtained with higher values of the parameter. This
is expected, for the lower the value of ¢,,,;,, the sooner frictional stress is accounted for (in the

simulations) and the more particle compaction reduces around the bubbles; this in turn makes
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the latter leakier, reducing their sizes. This effect, as we shall see, affects significantly lateral
dispersion. In light of this, we conclude that the way in which frictional stress is modelled
affects significantly the fluid dynamic behaviour of fluidized beds; particularly in bubbling
beds, where the latter is dictated mainly by the action of bubbles. In this section, we intend to
investigate the role of frictional stress modelling on lateral solid mixing. These significantly
influence bubble size and shape, which in turn affect how quickly the solid spreads throughout
the bed. To investigate this aspect, we ran simulations using the operational conditions reported
in Table 5.1 and considering the different cases outlined in Table 5.3. We tested different
frictional pressure and viscosity models, changing the solid volume fraction at which the bed
enters the frictional flow regime (¢,,,;n) and observing the effects of these variations on lateral

dispersion.

Table 5.3: Summary of simulation cases.

Frictional Frictional Frictional
Pressure Model Viscosity Model Packing Limit
Cases KTGF J&J Schaffer | J&J 050 [ 061

1 X X X
2 X X X
3 X X X
4 X X X
5 X X X

Figure 5.19 shows the plot of the lateral dispersion coefficient against the superficial gas
velocity for Cases 1 and 2. These cases are identical; except that in Case 2 frictional stress is
introduced earlier (the value chosen for ¢,,;,, is lower). Figure 5.19 shows that Dy, is predicted
better in Case 2, its values being lower and closer to those found empirically. The same is
observed for Cases 3 and 4, which are also identical, except that in Case 4 frictional stress is

introduced earlier, as shown in Figure 5.20.
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Figure 5.19: Dispersion coefficient values at different superficial fluid velocities for different simulation
cases. The minimum fluidization bed height is 5.23 cm, while the bed width is 0.60 m. The details of the
cases are reported in Table 5.3.

Figure 5.20 shows that the values of D, in Case 4 are lower than those in Case 3. This is
because frictional stress is introduced earlier. The effect of this, as said in the preceding
paragraphs, is that the voidage around the bubbles increases, reducing the compaction of the
particles and lowering the drag experienced by the fluid. Consequently, the leakage of gas
through the bubble boundary increases, leading to bubbles of smaller size compared with cases
where the introduction of the frictional stress is delayed. To illustrate this, we determined a
statistical distribution of the bubble diameters by dividing the diameter range into classes, as

shown in Figure 5.21.
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Figure 5.20: Dispersion coefficient values at different superficial fluid velocities for different simulation
cases. The minimum fluidization bed height is 5.23 cm, while the bed width is 0.60 m. The details of the
cases are reported in Table 5.3.
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Figure 5.21: Comparison of bubble size distributions for Cases 1 and 2 for Powder 1. The superficial fluid
velocity is 1.07 m/s, the minimum fluidization bed height is 5.23 cm, while the bed width is 0.60 m. The
details of the cases are reported in Table 5.3.
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Although there is no general consensus on how the equivalent bubble diameter should be
defined, we took it to be the diameter of a circle having the same area (we are working in two

dimensions) as the bubble. Thus, the equivalent bubble diameter is calculated as follows:

Deg= |— (5.36)

where A denotes the area of the bubble. We used image analysis software to process the
simulation results and compute the area of the bubbles. To do this, we assumed that bubbles are
continuous regions in which the void fraction is larger than 0.85. By establishing a colour
contrast between these regions and the other parts of the bed, the software allows to determine
the number of bubbles and their areas. Figure 5.21 shows that Case 2, where we introduced the
action of frictional stress earlier, predicts the largest percentage of small-sized bubbles, which
belong to diameter classes [0cm, 1cm] and [1cm, 2cm]. Conversely, Case 1 predicts higher
percentages for greater bubble diameter classes. The reduction in bubble size observed in Case 2

reduces the extent of lateral mixing, causing Dy, to have lower values.

To investigate the effects of frictional viscosity models on particle mixing, we compare Cases 1
and 3. In the first we adopted the model of Schaeffer (1987), while in the second that of Johnson
& Jackson (1987). In both we used the same value for ¢,,;n. As Figure 5.22 shows, Case 3
gives lower values for Dg,.. This is because the model of Johnson & Jackson (1987) gives larger
values of the frictional viscosity than those predicted by the model of Schaeffer (1987)
(Passalacqua & Marmo, 2009). The larger the solid viscosity is, the more the granular assembly
is able to resist shearing; this effect reduces the extent to which particles mix laterally, leading

to lower values of the dispersion coefficient.
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Figure 5.22: Dispersion coefficient values at different superficial fluid velocities for Cases 1 and 3. The
minimum fluidization bed height is 5.23 cm, while the bed width is 0.60 m. The details of the cases are
reported in Table 5.3.

In the cases investigated, we highlighted the influence of frictional viscosity on lateral mixing,
modelling the frictional pressure by means of the kinetic theory while varying the frictional
viscosity model and the frictional packing limit. The simulation results revealed that increasing
the effective viscosity of the solid slows down the bed dynamics, making the particles less able
to mix, thereby reducing Dg,.. We think that we can further improve the simulation results by
changing the frictional pressure model. Thus, instead of modeling the frictional pressure using
the kinetic theory, we used the semi-empirical model proposed by Johnson & Jackson (1987).
The simulation set-up is shown in Table 5.3, Case 5. In Figure 5.23 we compare the results
obtained from Cases 4 and 5. In the latter we obtained lower D, values than in the former for
all values of the superficial gas velocity. This is expected because the frictional pressure
predicted by the model of Johnson & Jackson, used in Case 5, is higher than that predicted by
the kinetic theory model, used in Case 4 (for a quantitative comparison between these pressure
models, we refer to Passalacqua & Marmo, 2009). The higher frictional pressure is, the higher

the void fraction around the bubbles is, and the leakier the latter become. Consequently, Case 5
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predicts smaller bubbles than Case 4. To confirm this, we carried out a statistical analysis of the

bubble size distributions on these cases, as we did previously. This is reported in Figure 5.24.
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Figure 5.23: Dispersion coefficient values at different superficial fluid velocities for Cases 4 and 5. The
minimum fluidization bed height is 5.23 cm, while the bed width is 0.60 m.
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Figure 5.24: Comparison of bubble size distributions for Cases 4 and 5. The superficial fluid velocity is
1.07 m/s, the minimum fluidization bed height is 5.23 cm, while the bed width is 0.60 m.
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In Figure 5.24, we observe that Case 5 has a higher proportion of small bubbles in the size range
[0, 1cm], [1cm, 2cm] and [2cm, 3cm]. The results obtained revealed that Case 5 gives the best
set-up for predicting Dg, out of all the cases considered. To confirm this, we used the set-up in
Case 5 to investigate Powder 2. The properties of this powder are reported in Table 5.2.We
compared the results with those obtained using the set-up in Case 1 (which is the default in
Fluent). We began by investigating the influence of the superficial gas velocity on the
dispersion coefficient. To do this, we kept the minimum fluidization bed height at 0.17 m and
the bed width at 0.9 m, we fluidized the bed at different superficial gas velocities and we
calculated the values of the dispersion coefficient. The results are reported in Figure 5.25. The
trends observed are similar to what we reported for Powder 1: the dispersion coefficient

increases with the superficial gas velocity, and Case 5 gives better predictions than Case 1.
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Figure 5.25: Dispersion coefficient values at different superficial fluid velocities for Cases 1 and 5 for
Powder 2. The minimum fluidization bed height is 17.0 cm, while the bed width is 0.90 m. The details of
the cases are reported in Table 5.3.

Figures 5.26 and 5.27 show the snapshots of solid volume fraction of solid-1 at 0.45 m/s (1.8

times u,,) and 0.75 m/s (3 times w,,f), respectively.
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Figure 5.26: Solid 1 volume fraction profiles at different times for superficial fluid velocity of 0.45 m/s
for Powder 2. The minimum fluidization bed height is 0.17 m, while the bed width is 0.90 m. The
horizontal dashed line indicates where the bed ends and the freeboard begins.

Figure 5.27: Solid 1 volume fraction profiles at different times for superficial fluid velocity of 0.75 m/s
for Powder 2. The minimum fluidization bed height is 0.17m, while the bed width is 0.90 m. The
horizontal dashed line indicates where the bed ends and the freeboard begins.
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We also ran simulations changing the bed height and keeping the superficial gas velocity and
bed width at 0.65 m/s (2.6 times u,,) and 0.9 m, respectively. Figure 5.28 shows that the

dispersion coefficient increases with bed height, and that Case 5 predicts better results than Case
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Figure 5.28: Dispersion coefficient values at different minimum fluidization bed heights for Cases 1 and 5
for Powder 2. The superficial fluid velocity is 0.65 m/s, while the bed width is 0.90 m. The details of the
cases are reported in Table 5.3.

5.8 Effect of simulation dimensionality

As mentioned in Section 5.6, the overestimation of D, is partly due to the 2D nature of our
simulations, which reduces the degrees of freedom of lateral solid motion. To assess how the
dimensionality of our simulations affects the numerical results, we scaled down the numerical
values obtained for Dy, by a factor «, to account for the dimensionality difference between the
2D domain used in our simulations and the 3D nature of the fluidized beds to which the
empirical correlations used for validation refer. So, the dispersion coefficient values found
empirically were no longer compared with the values D, found numerically, but rather with the

scaled values D,./a. To a first approximation, it was speculatively assumed that scaling could
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be accomplished by accounting for the degree of freedom lost when passing from a 3D to a 2D
case, hence a = 2. Figure 5.30 reports, for Case 1, the original and scaled-down values of the
dispersion coefficient obtained numerically and those obtained from the empirical correlations.
The scaled values of Dg,- compare fairly well with predictions of Borodulya et al. (1982), but are
still larger than the values yielded by the other empirical correlations. Altogether, it may be
concluded that values of Dy, of reasonable accuracy can be obtained from 2D simulations with
proper consideration of particle frictional stress combined with scaling to account for simulation

dimensionality. This aspect is further investigated in Chapter 6.
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Figure 5.29: Comparison of dispersion coefficient values obtained by scaling down the original results in
Case 1. The details of the cases are reported in Table 5.3. The values are compared with those obtained
from empirical correlations in the literature.

5.9 Conclusions

In this chapter we investigated lateral solid mixing in fluidized beds using the Eulerian-Eulerian
modeling approach. We defined the lateral dispersion coefficient Dy, using an equation

analogous to the Fick’s law of molecular diffusion. We examined the influence of design
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parameters and operational conditions on the values of D,., considering how the latter is
affected by the constitutive equations used to model the frictional solid stress. The simulation
results show that D, increases with the superficial gas velocity and bed height. We also
observed that Dy, increases rapidly at low values of bed width, but as this increases, Dy, rises
slowly and then remains approximately constant. Furthermore, we investigated the influence of
the fluid-dynamic model used in the simulations on the numerical results. To do so, we ran
simulations with different frictional pressure and viscosity models, changing the solid volume
fraction at which the bed is assumed to enter the frictional flow regime. The results showed that
the model choice significantly affects the numerical results. Bubble size distributions in the bed
show that early introduction of frictional solid stress results in the formation of smaller bubbles,
leading to lower values of Dy,. We confirmed such findings by running simulations with
another powder. For the two sets of powders, we obtained similar trends in Dy, values. Finally,
we examined the influence that the 2D dimensionality of our simulations has on the numerical
results obtained. The overestimation found is partly due to this dimensionality issue. A simple
scaling rule based on the consideration of the loss of degree of freedom of lateral particle
motion when passing from a 3D to a 2D domain was effective to largely reconcile simulated

and empirical values of D,.. This aspect is investigated in greater detail in Chapter 6.
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Chapter 6

3D numerical simulations
of lateral solid mixing in gas-fluidized beds:
CFD and DEM studies

This chapter is concerned with the numerical simulations of lateral solid mixing using both the

Eulerian-Eulerian and the Eulerian-Lagrangian modelling approaches:

1. We investigate the effects of simulation dimensionality on the numerical results
presented in Chapter 5.

2. We run 2D and 3D simulations, comparing their numerical results.

3. We use the Discrete Element Modelling (DEM) approach to investigate the process of
lateral solid mixing.

5. We carry out a parametric study to examine the influence of collision parameters on the
accuracy of DEM simulations.

6. We compare the numerical results obtained from the CFD and DEM simulations.

Parts of this chapter have been submitted for publication:

Oke, O., Lettieri, P., van Wachem, B.G.M., Mazzei, L. 2015. Lateral solid mixing in gas-
fluidized beds: CFD and DEM studies. Chemical Engineering Research & Design. Submitted
for publication.
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6.1 Introduction

In Chapter 5 we adopted the Eulerian-Eulerian approach to investigate lateral solid mixing in
gas-fluidized beds. We investigated the influence of design and operational conditions on lateral
dispersion coefficients, D,.. For all the cases considered numerical results overestimated the
empirical values of the latter, but within the same order of magnitude. We identified two
possible causes for the overestimation. The first relates to the two-dimensional nature of our
simulations; in actual fluidized beds the lateral motion of the solid has, we may say, two degrees
of freedom (bubble-induced particle lateral motion develops in a horizontal plane), while in 2D
fluidized beds solely one degree of freedom is present (particle lateral motion can only develop
along a horizontal line). Thus, lateral dispersion coefficients obtained in 2D simulations should
be expected to overestimate empirical results. This observation was also reported by Norouzi et
al. (2011). To address the dimensionality issue, we proposed a simple scaling rule based on the
consideration of the loss of a degree of freedom of lateral particle motion when passing from a
3D to a 2D domain. The overprediction, nevertheless, was not eliminated. The second
overestimation cause that we identified relates to how the solid-phase frictional stress is
modelled constitutively. We attempted to investigate this aspect by using different frictional
stress models, and changing the solid volume fraction value ¢,,;,, at which the bed was assumed
to enter the frictional flow regime. We obtained improved results with this, but numerical

results were still higher than the empirical ones.

The present chapter intends to address these problems. We believe that the issue of simulation
dimensionality can be investigated by running 3D simulations. Thus, we ran 3D simulations,
considering the same powder, the same computational setup and the same simulation cases
employed in our former 2D simulations. This permitted us to see how simulation dimensionality
affects the numerical results. Furthermore, we attempted to investigate the frictional stress
modelling issue by using DEM simulations. These offer a simpler way of describing the
rheology of the solid phase. This is because we no longer need to model the solid stress, since
the solid is no longer modelled as a continuum. As we shall see later, in the DEM model the
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mechanisms responsible for particle-particle interaction are well captured by just three
parameters: spring constant, damping coefficient and friction coefficient. Finally, we compared

the results of the Eulerian-Eulerian and Eulerian-Lagrangian simulations.

To estimate lateral dispersion coefficients, we follow an approach similar to that proposed by
Brotz (1956), reported in Chapter 5. We briefly summarise the approach again for clarity: He
used two solids having the same physical properties, but differing in colour. The solids were
separated by a vertical partition plate which divided the bed into two equal parts. He fluidized
the bed for a certain time and then removed the partition; by measuring the rate at which the two
solids mix, he estimated the lateral dispersion coefficient. Following Brotz, we placed two types
of solids (for example, red and blue particles) with the same physical properties, but differing in
colour, in a 3D rectangular bed. We placed the red particles on one side and the blue particles on
the other side of a removable partition. We fluidized the bed with air at ambient temperature,
allowing it to reach pseudo-stationary conditions, and then removed the partition. The solution
of the Eulerian-Lagrangian model provides the position of each particle at a given point in time,
and this can be used to calculate the spatial concentration profile of the particles after the
partition is removed. Similarly, the solution of the Eulerian-Eulerian models provides the radial
solid concentration profiles which can be used to estimate the rate of lateral solid mixing. We
divide this chapter into two parts: the first part is concerned with 3D Eulerian-Eulerian
simulations and the second part is about the Eulerian-Lagrangian (DEM) simulations of lateral

solid mixing.

6.2 2D versus 3D simulations of gas-fluidized beds

Until recently, many numerical simulations of dense fluidized beds were two-dimensional (2D)
(Gidaspow & Ettehadieh, 1983; Ettehadieh et al., 1984; Lyczkowski et al., 1987; Bouillard et
al., 1989; Ding & Gidaspow, 1990; Tsuo & Gidaspow, 1990; Ding & Lyczkowski, 1992;
Kuipers et al., 1992; Wang & Bouillard, 1993; Gamwo et al., 1995; Nieuwland et al., 1996;

Boemer et al., 1995; Blazer et al., 1995; Enwald et al., 1997). This is because three-dimensional
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(3D) simulations are computationally expensive due to memory capacity and processor speed of
available computers. To date, even with available computational resources, 3D simulations are
still very expensive because the governing equations have to be integrated over a longer period

of time to compute the inherently chaotic dynamics of the fluidization process (Xie et al., 2008).

Many experimental works aimed at gaining fundamental insights into the dynamics of fluidized
beds are also carried out using 2D beds (often referred to as pseudo-2D beds because there are
no beds that are truly two-dimensional; the latter is generally understood to mean rectangular
equipment having a small depth compared to their width and height). The use of 2D beds for
experimentation has many advantages, especially when studying the growth, velocity and
coalescence of bubbles: it allows bubbles to be readily seen and photographed; it is relatively
easy to modify the distributor plates; a 2D bed and its ancillary equipment, when compared to a
3D bed of the same width, is cheaper to fabricate (Geldart, 1970). Thus, 2D beds have helped

researchers to understand the behaviour of fluidized beds better.

Researchers have obtained satisfactory results from 2D simulations of gas-fluidized beds. Many
of these simulations were carried out for systems where the fluid dynamics are inherently two-
dimensional; in such systems the variation of fluid dynamic properties in space and time can be
neglected in the third dimension. For example, Johanssen et al. (2006) performed 2D
simulations of a rectangular fluidized bed, validating their numerical results with experimental
data from a pseudo-2D bed. In the latter, particle motion in the depth direction is suppressed and
the fluid dynamics can be assumed to be two-dimensional. Their numerical results showed good
agreement with experimental data. Other researchers (Boemer et al., 1998; Goldschmidt et al.,
2001; Goldschmidt et al., 2004; Chiesa et al., 2005; Sun et al., 2006) have also employed 2D

simulations to investigate pseudo-2D bed and reported considerable success.

Despite the success of 2D simulations in understanding and predicting the dynamic behaviour of
fluidized beds, significant differences between 2D and 3D simulations have been reported. Pyle

& Harrison (1967) compared the rise velocities of bubbles in 2D and 3D beds. They reported
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that bubbles in 2D beds have lower rise velocities than those in 3D beds. Similarly, Geldart &
Kelsey (1968) compared bed expansion in 2D and 3D beds. They reported that, under the same
condition of superficial gas velocity, particle properties and bed height, 2D beds have higher
bed expansion than 3D beds. This is expected, since in the former bed solid flow is completely

restrained in the third dimension.

Peirano et al. (2001) performed numerical simulations of a rectangular bubbling bed using the
Eulerian-Eulerian (E-E) modelling approach. They compared their numerical results with
experimental values of pressure fluctuations and bed height fluctuations. They observed
significant differences between 2D and 3D simulations; in particular only the 3D simulations
could predict correctly the experimental data. They concluded that 2D simulations should be
used with caution. Similarly, Cammarata et al. (2003) studied bubbling behaviour of fluidized
beds in rectangular apparatus using 2D and 3D simulations. They compared the bed expansion
and bubble size obtained from their simulations with the predictions form Darton’s (1977)
equation. They reported that a more physically realistic behaviour was obtained in 3D
simulations. They concluded, like Peirano et al. (2001), that 3D simulations should be

preferably used, except in situations where the system is 2D by nature.

Xie et al. (2008) presented a slightly contrary view to the authors in the preceding paragraph.
They reported that 2D E-E simulations are still applicable for studying the behaviour of
fluidized beds, but within a certain range of operating conditions. They performed 2D
simulations of cylindrical and rectangular beds, investigating the bubbling, slugging and
turbulent regime of fluidization. Their results showed that 2D simulations can accurately predict
the behaviour of the bubbling regime where the superficial gas velocity is close to the minimum
bubbling velocity. However, like Peirano et al. (2001), they emphasized that caution must be

taken when employing 2D simulations in other fluidization regimes.

Similarly, Reuge et al. (2008) investigated the expansion and bed height fluctuations of Geldart

B particles using E-E simulations. They carried out both 2D and 3D simulations of the bed.
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Their results showed that 2D simulations overestimated the bed expansion, while 3D
simulations correctly predicted them. They concluded that 3D simulations are necessary to
correctly predict the behaviour of fluidized beds. Significant quantitative differences between
2D and 3D simulations were also reported by Li et al. (2010) in their CFD simulations of gas
mixing in fluidized beds. They reported that bed expansion, solid concentration, gas and solid
velocities were different in 2D and 3D simulations. Accordingly Li et al. (2010) concluded that

2D simulations cannot be used to accurately simulate a 3D system.

Quite recently, Li et al. (2014) evaluated the difference between 2D and 3D simulations of
circulating fluidized beds. They compared the axial pressure gradient and radial void-fraction
profiles obtained from 2D and 3D simulations with those obtained experimentally. Their results
showed that, unlike 3D simulations, 2D simulations could not satisfactorily predict experimental

data.

The works reported in the preceding paragraphs show that there are significant differences
between the dynamics of 2D and 3D beds. We believe that better agreement between our
numerical simulations and experimental data may be achieved if simulations are performed in
3D. Accordingly, we ran simulations in 3D, using the same powder and the same computational
set-up used in the 2D simulations, and considering all the simulation cases investigated for the

latter. The results of our simulations are now reported in the following sections.

6.2.1 Results and discussion on 3D Eulerian-Eulerian simulations

The governing equations, initial and boundary conditions are the same as those used in Chapter
5 for our 2D simulations. The geometry employed is also the same, except that the present
geometry is 3D. The computational domain is shown in Figure 6.1, while Table 6.1 reports the

simulation parameters employed in the present simulations.
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Figure 6.1: Computational grid of our 3D simulations

Table 6.1: Simulation parameters for 3D E-E simulations of Powder 1

Parameters Value
Vessel height 0.35m

Bed depth (thickness) 0.05m

Bed Width 0.60 m
Superficial gas velocity 087-117m/s
Particle diameter 491 um
Particle density 2620 kg /m3
Minimum fluidization velocity 0.20 m/s
Bed height 0.05m
Computational cell 0.005m
Time-step 0.001s

From the solid volume fraction profiles obtained numerically, we calculated the void-free mass
fraction ¢; of solid phase i in each layer:

(‘5. ¢i

P = —¢1 s (6.1)
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We ran the simulations at various superficial gas velocities, keeping the minimum fluidization
bed height at 5.23 cm, the bed width at 0.6 m and the bed depth at 5 cm. We fitted the void-free
mass fraction profiles obtained from our simulations with those obtained from the Fick’s law
using the least square regression method, as did previously. In Figure 6.2 we report the profiles
of void-free mass fraction obtained from the Fick’s law and those obtained numerically at t =
5.0 s at superficial gas velocities 0.87 m/s, for both 2D and 3D simulations. Similar profiles are
found at other times, but we have chosen 5.0 s as representative time. We obtained a good

match between the theoretical and numerical profiles.
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Figure 6.2: Solid 1 void-free vertically-averaged mass fraction horizontal profiles for a superficial fluid
velocity of 0.87 m/s/. The ‘Fick’ profile is that obtained from the analytical solution of the Fick’s law,
while the ‘Fluent’ profile is that obtained numerically.

We observe that concentration falls faster in time in the 2D simulations compared to the 3D
simulations. This is expected because in the latter simulations there movement of solid and gas
is restrained by the front and back walls. Consequently the lateral movement of solid is slower

in 3D simulations. This is confirmed by the snapshots of solid-1 concentration reported in
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Figures 6.3A and 6.3B, which refer to the 2D and 3D simulations, respectively, and to a
superficial gas velocity of 0.87 m/s. The figures show how the tracer particles placed at the left
of the removable partition wall spread to the right. We observe that the movement of solids in
the 2D simulation is faster than that in the 3D simulation. This, as mentioned, is consistent with

the profiles reported in Figure 6.2.
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Figure 6.3: Solid-1 volume fraction profiles at different times for superficial fluid velocity of 0.87 m/s.
(A) 2D simulations (B) 3D simulations. The minimum fluidization bed height is 5.23 cm, while the bed
width is 0.60 m. The horizontal dashed line indicates where the bed ends and the freeboard begins.

Table 6.2: Simulation cases for E-E simulations

Frictional Frictional Frictional
Pressure Model Viscosity Model Packing Limit
Cases KTGF J&J Schaffer \ J&J 0.50 0.61

1 X X X
2 X X X
3 X X X
4 X X X
5 X X X
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We ran simulations considering the different cases reported in Table 6.2, using the same
operational conditions reported in Table 6.1, as we did in Chapter 5. We tested different
frictional pressure and viscosity models, changing the solid volume fraction at which the bed
enters the frictional flow regime (¢,,,;) and observing the effects of these variations on lateral

dispersion.

Figures 6.4 - 6.8 show the variation of lateral dispersion coefficient with superficial gas velocity
for cases 1 — 5. The values of D, are compared with the empirical data of Shi & Fan (1984).
We observe an increase in D, as the superficial gas velocity is increased. This is true for both
2D and 3D simulations. Nevertheless, in all the cases considered, 2D simulations clearly
overestimate Dy, values, and their values are higher than those of 3D simulations. Begis &
Balzer (1997) and Beégis et al., (1998) have reported significant difference between fluidization
dynamics predicted by 2D and 3D simulations. To explain this, Xie et al. (2008) carried out a
budget analysis of the governing partial differential equations, evaluating each term appearing
in the latter. Their analysis revealed that the difference between 2D and 3D simulation results is
due to the additional terms appearing in the three dimensional equations of change. The
difference, according to Xie et al. (2008), increases as the superficial gas velocity increases.
This possibly explains why, in Figures 6.4 — 6.8, the difference between Dy, values obtained in
2D simulations and 3D simulations increases as the superficial gas velocity increases. We
observe in Figures 6.4 — 6.8 that 3D simulations results agree reasonably well with empirical

data in all cases than the 2D simulations.

Figures 6.4 - 6.8 show that the results of the 2D simulations are appreciably affected by the
model used for the frictional solid stress (frictional pressure and frictional shear viscosity) and
by the value ascribed to ¢,,i,. The reasons for this were discussed in Chapter 5 and so will not
be repeated here. The results of the 3D simulations are far less sensitive to the frictional solid
stress model. In both 2D and 3D simulations, we see that lowering the value of ¢,,;, or using

the constitutive model of Johnson & Jackson (1987) instead of the kinetic theory of granular

154



Chapter 6 DEM and CFD simulations of lateral solid mixing 2016

flow (KTGF) model for the frictional pressure results into lower values of the lateral dispersion
coefficient. As explained in Passalacqua & Marmo (2009), this is because the model of Johnson
& Jackson (1987) yields larger solid pressure than the KTGF model, given the same solid
concentration, whilst lowering the value of ¢,,,;;,, introduces this effect sooner, that is to say, at
lower power compaction. Larger solid pressures in turn result into smaller bubbles, reduced
solid recirculation and reduced solid dispersion. This trend is found also in the 3D simulations,
but the effect is less significant. For instance, for a fluid velocity of 1.17 m/s, the difference in
the Dy, value between Cases 1 and 5 is 1.9 E-3 m?/s for the 2D simulations, while it reduces to

0.3 E-3 m?/s for the 3D simulations.
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Figure 6.4: Dispersion coefficient values at different superficial fluid velocities for Case 1. The values are
compared with those obtained from empirical data of Shi & Fan (1984).
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Figure 6.5: Dispersion coefficient values at different superficial fluid velocities for Case 2. The values are
compared with those obtained from empirical data of Shi & Fan (1984).
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Figure 6.6: Dispersion coefficient values at different superficial fluid velocities for Case 3. The values are
compared with those obtained from empirical data of Shi & Fan (1984).
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Figure 6.7: Dispersion coefficient values at different superficial fluid velocities for Case 4. The values are

compared with those obtained from empirical data of Shi & Fan (1984).
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Figure 6.8: Dispersion coefficient values at different superficial fluid velocities for Case 5. The values are

compared with those obtained from empirical data of Shi & Fan (1984).
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6.3 Eulerian-Lagrangian (DEM) Simulations

Before advancing further let us briefly recap one of the main goals of this chapter. The Eulerian-
Eulerian models employed in Chapter 5 overestimated the values of D.,.. We identified two
possible causes for the overestimation: the first relates to the 2D nature of our simulations and
the second has to do with how we modelled the frictional solid stress appearing in the Eulerian-
Eulerian models. We investigated these issues in Section 6.2. It is clear from the results
presented in the latter that the major cause for the overestimation is largely the 2D nature of our
previous simulations. This section investigates the capability of the Eulerian-Lagrangian (E-L)
modelling approach to estimate lateral dispersion coefficients with the intent of comparing the
simulation results with those obtained using the Eulerian-Eulerian models. The E-L approach
used in this work is the Discrete Element Method (DEM). In the latter, we track the motion of
each particle individually, and the fluid phase is described using the averaged equations of
motion. The particle-particle interaction can be modelled either by using a soft sphere or a hard
sphere approach. The following sections summarize these approaches, commenting on their

relative advantages and disadvantages.

6.3.1 Hard-sphere approach

In the hard-sphere approach, collisions between particles are assumed to be binary and
instantaneous. Collisions are processed one by one according to the order in which the events
occur. The approach uses the conservation equations of linear and angular momenta to calculate
the velocities of particles emerging from collisions. The model equations for this approach are
reported below. These are based on the hard-sphere model developed by Hoomans et al. (1996,

2000, 2001).

Consider two colliding spheres i and j with position vectors r; and r;, diameters d; and d;, and
masses m; and m;, respectively. The normal and tangential unit vectors are defined

respectively as:
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(ri—r;) Vi
ng; = — 5 = T (6.2)
ri — 7 |vi]
where v;; can be expressed as:
1 1
vij = (vi — 17]) - (E diwi + Ed]wl) X Tli]' (63)

v; and v; denote the linear velocities of the spheres and w; and w; their angular velocities
before collisions, and the corresponding velocities after collisions are denoted by primes. The

impulse J exerted on sphere i by sphere j is given by:

mi(vi' - vi) = —mj(v]', - v]) :] (64)
and
21; 21
d—l(wi' —w;) = d_](("j’ —w;) = -n; xJ (6.5)
i §

where I is the moment of inertia about the centre of a sphere given by:
[ =md?/10 (6.6)

where m is the mass of the sphere and d is its diameter. The relative velocity at the point of

contact is expressed as:

Eqg. 6.4 and 6.5 can be combined to obtain:

, 7(1 1 501 1

To determine the velocities of particles after collision, we need to calculate the impulse J.
Therefore we use the following closure models. First, we express the coefficient of normal

restitution e characterising the normal component of v;; as:
nj vyt = —e(ny; - vy)) (6.8)

where 0 < e < 1. The coefficient of dynamic friction (u = 0) is written as:
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|ny < JI = u(ny - ) (6.9)
and the coefficient of tangential restitution (0 < f < 1) is given by:

n; X v’ = —f(ny; X vy) (6.10)
If we combine Eqg. 6.7 and 6.8, we obtain the normal component of the impulse vector:

-1+ e)(vy; - nyj)
Jn= R (6.11)

m; Hj

For the tangential component of J, two types of collisions are possible: sticking or sliding.

According to Lu et al. (2005), if

then, the collision involves sliding, and

Je =—whn (6.13)
If collision involves sticking,
1+ B)ymm;
u= — (vij ' tl]) (614)
then,
— et 6.15
t 35(ml + m]) (vu l]) ( )

Given the definitions of Jin Eq. 6.11, 6.13 and 6.15, the velocities of particles after collision

can be calculated from Eqg. 6.4 and 6.5.

When the hard-sphere model is used for simulations of dilute systems, they are much faster than
soft-sphere simulations, since the former approach does not take into account multiple collisions
at the same instant. Campbell & Brennen (1985) were the first to use the hard-sphere model to

investigate granular systems. Subsequently, it has been employed to study a wide range of
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complex system. Hoomans et al. (1996) used the hard-sphere approach, together with CFD
conservation equations for the fluid phase, to study gas-solid flow in fluidized beds. Through
this approach, they investigated the influence of particle-particle interaction on bubble
formation. Later, they used the approach to examine segregation caused by density and size
difference in fluidized beds (Hooman et al., 2000). Other researchers (Goldschmidt et al, 2001,
Li & Kuipers, 2002; Helland et al., 1999; Lun, 2000; Zhou et al., 2004) have also employed the
hard-sphere approach to investigate various aspects of fluidized beds, including high pressure
fluidization, circulating fluidized beds and gas turbulence. Nevertheless, the approach becomes
useless when particle concentration is high, such as those encountered in dense fluidized
systems, because it does not consider multiple contacts of particles. When this happens, the soft-

sphere approach becomes the plausible alternative.

6.3.2 Soft-sphere Model

The soft-sphere model was developed originally by Cundall & Strack (1979). In this method,
particles are allowed to overlap slightly at the point of collisions, and the forces at the point of
contacts are calculated from the deformation history of the contacts. The physical motivation for
the soft-sphere model is that collisions of particles are accompanied by deformation at the point
of contact. The deformation, described by the overlap displacement of two particles, is the
driving force of the soft-sphere model (van Wachem, 2003). The greater the overlap, the greater
the repulsive force between the colliding particles. The soft-sphere model allows for multiple
overlap; the net contact force is calculated as the addition of all pair-wise interactions. Tsuji et
al. (1993) were the first authors to use the soft-sphere approach to simulate the dynamics of
fluidized beds. Based on the model developed by Tsuji et al. (1993), lwadate & Horio (1998)
introduced van der waals forces to simulate the fluidization of cohesive particles. The soft-
sphere model has also been employed in other applications such as heat transfer (Li & Mason,

2000) and coal combustion (Zhou et al., 2003).
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In the soft-sphere models, the motion of particles is described individually by applying

Newton’s equation of motion.

6.3.2.1 Equations of motion

The linear motion of a particle i, assumed to be spherical, with mass m; and centre coordinate

T; , can be modelled using the Newton’s second law of motion:

dzrl-

dt?

m; =Fi+Fep; +Fg; (6.16)

Here F_; is the total contact force. The latter is the addition of individual contact forces exerted

by all other particles in contact with particle i. F.; has normal and tangential components:
Fei= ) (Fijn+Fij0) (617)
J

where F, in and F;; . are the normal and tangential components of F;;, respectively, where F;;

ij,t Jj1
represents the contact force exerted by particle j on particle i. F,,; is the total external force

acting on particle i. This can be decomposed into the following forces:
Fext,i = Fg,i + Fd,i + Fp,i (618)

here F,;, Fy;, and F,; are the gravitational, drag and pressure forces respectively. Other
contributions to F,,,; such as the virtual mass, lift, Faxen and Basset forces are neglected.
Lastly, F; is the sum of all other particle-particle forces, which can include electrostatic and
van der waals forces. In this work, we do not consider these particle-particle forces.

The rotational motion of particle i is given by:

dwi
L

=T, (6.19)

where I; is the moment of inertia, w; is the angular velocity and T; is the torque of particle i.

The torque depends only on the tangential component of individual contact forces, thus:
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T, = Z(Rinij X Fij ¢) (6.20)
Jj

where n;; is the unit vector from the centre of particle i to that of particle j, R; is the radius of
particle i. We should note that although the total force acting on particle i is given by the sum of
the forces on the right hand side of Eq. 6.16, only the tangential component of the contact force
exerted by particle j on particle i is used in Eq. 6.20 to calculate T;. According to Xu & Yu
(1997), the total external force (the fluid-particle interaction force and the gravity) acts on the
centre of mass of the particle, hence it has no contribution to the rotational motion of the latter.
Conversely, the interparticle forces (the total contact force and the particle-particle interaction
force) act on the contact point between particle i and j, generating a torque which causes
particle i to rotate. The only interparticle force acting between particle i and j is F;; (since the

contribution of Fg; has been neglected). The tangential component F;. . of the latter is

ij, t
therefore responsible for the effective torque on particle i. As said in the preceding paragraphs,
the translational and rotational motions of particles are described Egs. 6.16 and 6.19. By

integrating these equations, we obtain the evolution in time of particle positions and velocities.

6.3.2.2 External force

The gravitational force F; on particle i is expressed as:
F i =mg (6.21)
The drag force F,; that the fluid exerts on particle i is given by:
Fg; = (Vi/pDB(us —v;) (6.22)
Here v; and V; are the linear velocity and volume of particle i, respectively, while 8 denotes the

drag coefficient, whose constitutive expression has been reported in Chapter 5.

The pressure force F,; on particle i is expressed as:
Fp,i = — Vlef (623)
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where ps represents the volume-averaged fluid pressure. This force may be regarded as the
buoyancy force acting on particle i. The expression that we selected for the drag coefficient S is
consistent with this choice of buoyancy force.

We will now describe the contact force scheme employed in the soft-sphere approach.

6.3.2.3 Contact force

The most widely used contact force model in DEM simulations, which is also employed in this
work, is the spring, slider and dash-pot model, proposed by Cundall & Strack (1978). The

diagram representing this model is reported in Figure 6.11.

The Cundall & Strack (1978) contact force model considers three mechanisms of particle-
particle interactions. These mechanisms are captured by three mechanical elements in the model
— spring, dash-pot and slider. The spring simulates the deformation following collision of
particles. The dash-pot models the energy dissipation due to particle-particle interaction, and the
slider simulates the frictional force arising when particles slide on each other under the
application of a normal force. The effects of these mechanisms on particle motion are captured
by the following parameters: the spring stiffness K, the damping coefficient  and the coefficient

of friction w. This is represented in Figure 6.11.

! K,

Spring
u
Dash-pot Spring VV\VYV Friction slider
Mn K,
Dash-pot
b. Compressive force a. Shear force

Figure 6.11: Graphical representation of spring/dashpot model (Tsuji et al., 1992).
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When particle i is in contact with particle j, the contact force Fi, acting on particle i is given

by the sum of the forces due to the spring and the dashpot:

Fii == [Kn6 2 4 10y mi)Iny (6.24)

ij,n

With Tsuji (1992), we used the Hertzian contact theory to model the relationship between the
normal spring force and the normal displacement; the relationship between the two is non-
linear. In Eq. 6.24, K,, is the normal spring stiffness, &,, is the normal displacement or overlap,
1 is the normal damping coefficient and v;; is the relative velocity between particles i and j,

given by:
vy = (v; — V) + (Ryw; + Rjw)) X ny; (6.25)
The normal vector n;; and the overlap &,, are given by:

ri—rj

n; = 8p = (R +R) = |r; — 1] (6.26)

|7”i —rj| ’

The expression for the tangential component of the contact force depends on whether particles i
and j slide on each other (kinetic friction) or not (static friction). If they do not, the force is

given by:
Fi; == [KeSe + (i tij)] i (6.27)

where K;, 6;, n; and t;; are the spring stiffness, the displacement, the damping coefficient
andthe unit vector in the tangential direction. The vector t;; and the tangential displacement &,

are found by adding the displacement vectors through subsequent time-steps of collision (van

Wachem et al. 2015). If the following relation is satisfied:

Fij o> n|Fy | (6.28)

particles i and j slide. Then, Eq. 6.27 no longer holds and must be replaced by:
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Fj . =—-u |Fi,-,n| £ (6.29)

The next step is determining the values of the normal and tangential spring constants and

damping coefficients. We address this in the following sections.

6.3.2.4 Spring stiffness

For two spheres of equal size, Tsuji (1992) suggested the following expression to calculate the
normal spring stiffness:

J2RiE;
K, =

=5t=ch (6.30)

where E; is the Young modulus and o; is the Possion ratio of particle i. In the case of contact

between a sphere and a wall, K, is given by:

4/R;
3

-0 | 1—0,°2
E, ' E,

K, = (6.31)

1

where E,,, and g,, are the Young modulus and Poisson ratio of the wall, respectively.

The relation for calculating the tangential spring stiffness was derived by Mindlin (1949) and
Mindlin & Deresiewicz (1953) and reads:

2J2RG; _ 1)y

K, = 1) 6.32

where G; is the shear modulus of particle i. This is related to the Young modulus E; and to the
Poisson ratio g; as follows:

E;

Gi=—"t—
¢ 2(1+0'i)

(6.33)

For the case of contact between a particle and the wall, Tsuji (1992) provides the following

expression for calculating the tangential spring stiffness:
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8,/R;G;
K, = 2—”5n1/2 (6.34)
o,

6.3.2.5 Damping coefficient

Following van Wachem et al. (2010), we use the following expressions for the damping

coefficients:
N, = a /MK, 5n1/4 ;N = a MK, 6t1/4 (6.35)

For collisions between particle i and j, it is:

mimj

=Gt (6.36)

For collisions between particle i and the wall, M = m,;. where « is a parameter that depends on
the coefficient of restitution e. This dependence is well defined by Tsuji et al. (1992), as

reported in Figure 6.12.
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Figure 6.12: Relationship between parameter a and restitution coefficient e (Tsuji et al., 1992)

We would like to point out that although the values of K, and K; can be obtained from Eg. 6.30,

6.31, 6.32 and 6.34, in practice the values assigned to these parameters are smaller than those
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obtained from these equations (which are based on the material properties, that is, the Young
modulus and Poisson ratio); this is because otherwise the integration time step required in the
simulation becomes impractically small. So, when assigning the values of K, and K,, one takes
into account computational efficiency as much as material properties (Gera et al., 1998;
Kawaguchi et al., 1998; Mikami et al., 1998; Kaneko et al., 1999; Rong et al., 1999; Rhodes et
al., 2001; Tian et al., 2007). Extra care has to be taken when choosing the stiffness values, for
too small values can lead to unrealistic overlap between the colliding particles, rendering the
results inaccurate, whereas too large values can render the computational time exceedingly high.
Tsuji et al. (1993) suggested a normal stiffness value of 800 N/m. This value has been widely
used by researchers, producing acceptable results (refer, for instance, to Gera et al., 1998;
Kawaguchi et al., 1998; Mikami et al., 1998; Kaneko et al., 1999; Rong et al., 1999; Rhodes et
al., 2001). Albeit this value reduces the computational effort considerably, there is a risk that the
accuracy of the simulation results might be affected (Di Maio & Di Renzo, 2004). All these

aspects will be examined in this chapter.

6.3.3 Comparison between hard-sphere and soft-sphere approaches

Although numerical simulations of fluidized beds have been carried out using both hard-sphere
and soft-sphere models, each approach has distinct features which make it suitable in some
applications and unsuitable in others. In soft-sphere models, slight deformation is allowed at
contact points of particles and multiple contacts among particles are permitted. This is not
possible in hard-sphere models where collisions are binary and instantaneous. Similarly, it is
quite straightforward to incorporate cohesive forces into soft-sphere models. This is because
collisions among particles are described using the Newton’s equations of motion of individual
particles. In hard-sphere models, doing this is quite challenging because the model equations are
not in terms of forces; they are derived via momentum exchange at the point of contact (Van der
Hoef et al.,, 2006). However, soft-sphere models, when compared to their hard-sphere

counterpart, present some difficulties when dealing with particles of different sizes. In soft-
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sphere models, one needs to use different values of spring constants to model contact forces

between particles of different sizes. Doing this is quite challenging.

Table 6.3: Comparison between hard and soft-sphere models. (YY) — Good; (Y) — Normal; (N) — Not
suitable (\VVan der Hoef et al., 2006).

Hard-sphere Soft-sphere
Computing efficiency YY Y
Multiple contacts N YY
Dense systems N YY
Incorporation of cohesive force Y YY
Energy conservation during collisions YY Y
Multiple particle sizes YY Y

Furthermore, hard-sphere models are more straightforward and require less complicated
constitutive equations than soft-sphere models. In the latter, we need to derive closure equations
for the contact force, damping coefficient and stiffness. Some of these equations rely on the
physical properties of particles which, in some cases, have to be determined experimentally. We
briefly summarize the comparison between hard and soft-sphere models in Table 6.3. In this

work, we employ the soft-sphere approach.

6.3.4 DEM simulation results and discussion

This section investigates the capability of the Eulerian-Lagrangian (DEM) modelling approach
to estimating lateral dispersion coefficients with the intent of comparing their simulation results
with those obtained using the Eulerian-Eulerian models. In the former approach, as said, we
solve relatively less complicated models; in particular, closure problems for frictional solid
stress no longer arise, since we do not solve average equations.

Setting up DEM simulations

The DEM simulations code (MultiFlow) employed in this code was provided by Professor
Berend VVan Wachem at Imperial College London. Setting up simulations in MultiFlow requires
selecting the files that describe the simulation. This include selecting the options file case.mf
containing the simulation set-up, a mesh.geo file containing the computational mesh and a

compileoptions.h file including specific options at compile time and a script for running
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MultiFlow. Additionally, the user needs to select the USERinit.c file for describing the initial
conditions, USERBoundary.c file for describing the boundary conditions. It is important to note
that appropriate values should be used in the above files and if changes are made to any of the
files, one needs to recompile MultiFlow. A detailed description of how MultiFlow works,
including the step-by-step guide of how to use the codes are reported in Appendix A.
Discussion

It is important to point out that the powder and the bed geometry used in Section 6.2 for our
Eulerian-Eulerian simulations are different from those used in the DEM simulations. This is
consequence of the limitations imposed by this modelling approach. The simulations required to
treat the same geometry and powder considered in the previous CFD simulations are far too
expensive for our computational resources, requiring about 13 million more particles than those
used in the DEM simulations that we were able to run. Since our aim is to compare the
performance of the Eulerian-Eulerian and Eulerian-Lagrangian modelling approaches, we
simulated a new geometry and powder. We used the powder investigated experimentally by
Grakhovskii (1968), which has a bigger mean size than those employed previously in Section
6.2. The parameters used in our simulations, in particular the bed height and the superficial gas
velocities, were chosen to replicate the work of the author. However, the bed depth and width
used in our simulations are smaller than those of Grakhovskii (1968) (He used a bed of depth
100 mm and width 1000 mm). This is again because of the huge computational cost we will
incur if we employed the bed dimensions of the former author. In Table 6.4 we summarize the

powder properties and the bed dimensions employed in our simulations.
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Table 6.4: DEM simulation parameters for Powder 2

Conditions of particle

Particle shape Spherical
Diameter 3mm

Density 1000 kg/m®
Stiffness 40,9772 N/m**
Restitution coefficient 0.90

Friction coefficient 01-04
Poisson ratio 0.33

Minimum fluidization velocity 0.76 m/s
Number 29,470
Conditions of gas

Density 1.2 kg/ m®
Viscosity 1.7 x 10°Ns/m®
Simulation conditions

Bed height 60 mm

Bed width 200 mm

Bed depth 60 mm
Superficial gas velocity 1.9-2.66 m/s

To estimate the Dy, values, we used the same procedure as in the Eulerian-Eulerian simulations.
The results of DEM simulations provide the position of each particle at any given time. This
allowed us to determine the radial void-free concentration profiles in the bed. By matching these
profiles with those obtained analytically from the Fick’s equation, we calculated the Dg, values
at different operational conditions. We report in Figure 6.13 the concentration profiles for a
superficial gas velocity of 1.9 m/s; the values of the other parameters are those shown in Table
6.4. The profile given by the CFD simulation is also included for completeness. We observe a
good agreement between the numerical and analytical profiles. These refer to atimet = 2.0 s,

but similar results were obtained at other times and superficial gas velocities.
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Figure 6.13: Void-free concentration profiles obtained in DEM and CFD simulations at superficial gas
velocity of 1.9 m/s.

We should notice that the accuracy of the simulations depends strongly on the values assigned
to the parameters appearing in the model (i.e., restitution coefficient, particle-particle friction
coefficient and stiffness or spring constant); hence, extra care has to be taken when choosing
them. The coefficient of restitution accounts for the kinetic energy dissipated when particles
collide. The energy that is lost is accounted for by the contact damping force included in the
DEM model through the dashpot model. It is customary to base the damping coefficient on the
collisional properties of the particles, in particular the restitution coefficient e. Nevertheless, we
should notice that the latter is neither a material property nor a constant, but it depends, among
other parameters, on the relative impact velocity of the colliding particles (Kuwabara & Kono,
1987). However, the variation of the restitution coefficient is negligible, except at very high
impact velocities (usually 10 m/s and above) (Labous et al., 1997). So, the value of e is
normally taken to be constant in DEM simulations. The typical value employed in the literature
is 0.90, and therefore in the present work we employed this value. Unlike the coefficient of
restitution, the friction coefficient and spring constants depend on the material properties. The

friction coefficient is an empirical parameter whose value depends on many factors, including
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particle shape, particle size and surface texture, whilst the spring constants depend on the
Young’s modulus and Poisson’s ratio of the material. Since we do not have the empirical values
for these parameters (even if we did, we could not have used them, insofar as the simulations
would have been too expensive computationally), we performed a parametric study to determine

how the values assigned to them influence the numerical results of our simulations.

To investigate how friction coefficient and stiffness affect our numerical predictions of D,., we
carried out sensitivity analyses on them using the values of parameters reported in Table 6.4 as a
reference case. We begin by considering the effect of friction coefficient. The latter is a key
parameter that can significantly affect the fluid bed dynamics in DEM simulations. Cleary et al.
(1998) carried out a sensitivity analysis of friction coefficient on solid mixing rate in a ball mill
using DEM simulations. They reported that the mixing rate increased as the friction coefficient
was reduced. To investigate the influence of friction coefficient on lateral solid mixing, we
performed simulations using different values of u in the range commonly employed in DEM
simulations of fluidized beds, keeping the normal spring stiffness K,, at 40977 N/m*? the
restitution coefficient at 0.9 and the superficial gas velocity at 2.66 m/s (3.5 umf)(an
intermediate value in the range investigated experimentally by Grakhovskii (1968)). The
snapshots of the bed, obtained using the reference conditions in Table 6.4 at a superficial gas
velocity of 2.66 m/s, at different computational times are reported in Figure 6.14. The latter
shows the lateral spread of particles past the removable wall partition. This is similar to what we
observe in CFD simulations in the previous section. Figure 6.15 shows that Dy, reduces as the
friction coefficient increases. This is consistent with the findings of Cleary et al. (1998) and had
to be expected, because when the friction force increases, sustained interaction among particles
increases, inhibiting the motion of the solid and thereby reducing D,,.; nevertheless, the order of

magnitude of D, remains the same.
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Figure 6.14: Snapshots of the bed at different computational times obtained at a superficial gas velocity of
2.66 m/s.

2.8

2.6 ~_

2.0

™~

1.6

Dsr x 103 [m?/s]

1.4

1.2

0.05 0.1 0.15 0.2 0.25 0.3 0.35 0.4 0.45

Friction Coefficient [-]

Figure 6.15: Lateral dispersion coefficient vs. friction coefficient.
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Generally, the value of the stiffness should as well be carefully chosen, since it affects the
integration time-step significantly: the higher the stiffness, the smaller the necessary integration
time-step. This is because higher stiffness results in shorter collision times. Stiffness also
influences interparticle overlap during collisions; generally, small stiffness leads to large
interparticle overlap. Stiffness values must be chosen in such a way as to attain a balance
between accuracy and computational efficiency. A large stiffness value, albeit it may yield more
accurate results, does reduce the computational efficiency dramatically. On the other hand,
when stiffness values are impractically small, the accuracy of the simulations could be
compromised. Therefore, it requires careful judgement on the modeller’s part to strike a
reasonable balance between accuracy and efficiency. To investigate the effect of stiffness on the
lateral dispersion coefficient, we conducted a sensitivity analysis on it, using the parameters
reported in Table 6.4 as a reference case. We ran simulations at different stiffness values,
keeping the coefficient of restitution at 0.90, the friction coefficient at 0.20 and the superficial
gas velocity at 2.66 m/s. Figure 6.16 reports how D, changes with stiffness. We can see that
Dy, decreases slowly initially, and then more rapidly, as stiffness increases. However, the order

of magnitude of Dg, remains unchanged.
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Figure 6.16: Lateral dispersion coefficients at different stiffness values.

We investigated how the bed thickness (i.e. the bed depth in the z-direction) influences the Dy,
values, because we could not simulate directly the experimental system, adopting the real value
of bed depth (100 mm), owing to the enormous computational resources required. Hence, we
decided to investigate how the choice of bed depth value affects the numerical prediction of Dy,
In the literature, the effect of the bed thickness has mainly been studied with respect to the
minimum fluidization velocity. It was observed that the latter increases as the bed thickness
decreases (Kathuria & Saxena, 1987; Saxena & Vadivel, 1988; Caicedo et al., 2002; Sanchez-
Delgado et al., 2011). This is because, as the bed depth reduces, the effect of wall friction
becomes more pronounced, limiting the movement of the particles. For this same reason, we
believed that the bed thickness would affect our numerical results. Indeed, studies have shown
that bed thickness does affect bubble size, shape, velocity and expansion (Geldart, 1970; Geldart
& Cranfield, 1972; Rowe & Everett, 1972; Cranfield & Geldart, 1974; Glicksman &
McAndrews, 1985); these are important parameters that strongly influence solid mixing in fluid

beds. To investigate the effect of bed thickness, we ran simulations at different superficial fluid
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velocities, using geometries of depths 10 dp and 20 dp, where dp is the particle diameter, and
(in a third case) periodic walls (imposing periodic boundary conditions at the front and back
walls of the vessel). The values of the simulation parameters were those shown in Table 6.4.
Figure 6.17 reports how D, changes with the superficial gas velocity for the various bed depths
examined. We note that D, reduces as the depth of the bed is decreased, as expected. The
simulations run with periodic boundary condition give higher values of D, than those with rigid
walls, because the walls do not constrain the bed dynamics. Since the depth of the bed
considerably affects solid dispersion, in the simulations one should employ the correct
dimension (the same as that of the real system investigated experimentally). If doing so is not
feasible (for instance because the number of particles to be tracked would be too large), then
one has to keep in mind that simulating a narrower bed may affect the simulation results,

leading to lower dispersion coefficient values, as seen in Figure 6.17.
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Figure 6.17: Dispersion coefficient values for different superficial gas velocities and bed depths. The
minimum fluidization bed height is 6 cm, while the bed width is 0.20 m. ‘dp’ is the particle diameter.

The results presented in these paragraphs reveal that DEM simulations are able to estimate the

rate of lateral solid mixing in fluidized beds, but the accuracy of this modelling approach, as we
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have seen, depends largely on the values chosen for the simulation parameters. So, even if we
are not faced with the problem of constitutively expressing the frictional solid stress, as we are
in the Eulerian-Eulerian simulations, we are still faced with the challenge of assigning
appropriate values to the simulation parameters. To overcome this issue, one needs to estimate
the parameters experimentally, but doing so is extremely time-consuming, and, as pointed out in
Section 6.3.2, employing the empirical values in the simulations would require enormous
computational resources; this, in particular, is true for the spring constants. In the next section,
we compare the DEM simulation results with the experimental ones and those obtained from the

Eulerian-Eulerian simulations.

6.4 DEM vs. CFD simulations

We ran simulations in CFD using the same powder, geometry and operational conditions
employed in the DEM simulations. Table 6.5 reports the simulation parameters and the powder
properties used in the CFD simulations. In the DEM ones, we considered two stiffness values:
40,977 N/m*? and 409,772 N/m*?. For each, we ran simulations at various superficial gas
velocities, keeping the other parameters constant (the values are those reported in Table 6.4).
Figure 6.18 reports how D, changes with superficial gas velocity. We observe that Dy,
increases with superficial gas velocity; this is expected because an increase in the latter induces
more bubbling, which makes the rate of lateral solid mixing rise. The Dy, values calculated at
40,977 N/m*? are larger than those calculated at 409,772 N/m*2 This is true for all the

superficial gas velocities considered and agrees with what Figure 6.16 reports.

In the CFD simulations we considered Cases 1 and 5 reported in Table 6.2. The void-free mass
fraction profile for Case 1 obtained at a superficial gas velocity of 1.9 m/s is reported in Figure
6.13. In Figure 6.18, it is interesting to note that the Dy, values obtained in Case 5 are lower
than those obtained in Case 1. The trend is the same as that observed in Section 6.2. The figure
also shows that the CFD simulations predict the D, values better than the DEM simulations,

although the empirical data are still slightly overestimated. The predictions of the DEM
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simulations are fairly accurate, the order of magnitude of the results matching that of the
empirical data. This reveals that DEM simulations are equally capable of estimating D,

accurately, provided one assigns appropriate values to the collision parameters.
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Figure 6.18: Dispersion coefficient values for different superficial gas velocities for DEM and CFD
simulations. The minimum fluidization bed height is 6 cm, the bed width is 0.20 m and the bed depth is 6
cm.

Table 6.5: Simulation parameters for Powder 2

Conditions of particle

Diameter 3 mm
Density 1000 kg/m®
Minimum fluidization velocity 0.76 m/s
Conditions of gas

Density 1.2 kg/ m?
Viscosity 1.7 x10°Ns/m®
Simulation conditions

Bed height 60 mm

Bed width 200 mm

Bed depth 60 mm
Superficial gas velocity 1.9-2.66 m/s
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6.5 Conclusions

We investigated lateral solid mixing in gas-fluidized beds using the Eulerian-Eulerian (CFD)
and the Eulerian-Lagrangian (DEM) modelling approaches. The former approach describes both
the solid and fluid phases as interprenetrating continua, while the latter tracks the motion of
each particle and solves the average equations of motion only for the continuous phase. We
examined the influence of simulation dimensionality on our CFD results. To do this, we ran
simulations in 3D at different superficial gas velocities. Our results showed that as the latter
increases as Dy, increases. We compared our 3D simulation results with those previously
obtained in 2D. We observed that 3D simulations predict D, better. Subsequently, we ran 3D
DEM simulations, adopting the same methodology used in CFD to estimate Ds,. The results
obtained agreed reasonably well with empirical results. DEM simulation results revealed that
the accuracy of numerical predictions depends on the choice of collision parameters; in
particular, the restitution coefficient, the friction coefficients and the stiffness. Both DEM and
CFD modelling approaches provided a reasonably good prediction for Ds,. Nevertheless, CFD

simulations yield slightly better results than DEM simulations.
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Conclusions and future work

Fluidization is a winning technology employed in various industrial processes such as drying,
coating, granulation, food freezing, oil cracking and oil reforming, to cite just a few. Designing
a fluidized bed is very challenging because of the complex interrelationships among the
particles and between the solid and fluid phases. For many years, and partly today, process
engineers have always relied on pilot plant and scale-up relationships to design fluidized beds.
This approach is by no means efficient; a satisfactory performance of the bed on a pilot plant
scale does not guarantee an efficient performance on a commercial scale. This makes the scale-
up method risky and uncertain. Computational fluid dynamics offers an attractive alternative
that can significantly contribute to designing fluidized beds more efficiently. CFD can directly
simulate commercial size beds and permits to investigate the influence of design and process
conditions on its performance. We must however emphasize that the accuracy of CFD
simulation results depends on the accuracy of models employed. To develop accurate models, it

is important that we understand the complex fluid dynamic behaviour of fluidized beds.

The behaviour of gas-fluidized beds depends, among other things, on the superficial gas
velocity. The latter determines the fluid dynamic regime in which the bed operates. Typically,

when the superficial gas velocity exceeds the minimum fluidization velocity, pockets of gas,
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referred to as bubbles, are seen rising through the bed and the bed behaves like a boiling liquid.
This fluid dynamic regime is known as the bubbling regime. As the superficial gas velocity
increases, the bed may operate in other regimes including turbulent, fast fluidization and
pneumatic transport. However, for powders belonging to Group A of Geldart (1973)
classification, there exists an interval of stable expansion before they transit to the bubbling
regime. Thus, for this class of powder, when the superficial gas velocity exceeds the minimum
fluidization velocity, the suspension does not bubble; rather, it expands homogeneously over a

certain range of superficial gas velocity.

The origin of stability of Group A powder has been a subject of controversy among researchers.
Some researchers argued that the stability of Group A powder is solely due to the fluid dynamic
forces in the bed, some maintained that it is due to the existence of interparticle forces, while
others attribute the stability to the existence of both fluid dynamic and interparticle forces in the
bed. In Chapter 2, we reviewed this lingering controversy on the origin of stability of this class
of powders, drawing from both theoretical and experimental evidence. We reported on the
experimental discovery by Valverde (1998) which harmonized the differing ideas on the
stability of gas-fluidized beds, revealing that the homogeneous regime of gas-fluidized beds
consists of two distinct regimes of solid-like and fluid-like behaviours. The solid-like regime is
characterized by the existence of enduring contacts among particles, which are manifestations of
interparticle contact forces. In the fluid-like regime, however, enduring particle-particle contacts

are absent and the particles are freely suspended in the fluid.

In Chapter 3, we investigated the homogeneous regime more closely, using theoretical and
experimental methods. We modelled the stable interval of expansion, accounting for enduring
particle contacts and wall effects. One of the crucial input parameters to the model is the yield
locus of the powders. This features five independent parameters which must be determined
experimentally. The experimental results provided the compressive strength values at different

solid volume fractions at the bottom of the bed, which were then fitted to the yield locus
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expression of Johnson et al. (1990). This allowed us to determine the five independent
parameters in the yield locus expression which were used as inputs into the model. We solved
the model numerically to obtain the expansion profiles in the bed at different fluidization
velocities in the interval of stable bed expansion, back-calculating from them the values of
expansion parameter n appearing in the model. For all the cases considered, we observed that
the values of n are higher than those obtained by purely fluid dynamic correlations, such as
those advanced by Richardson & Zaki and Rowe (1987). This effect was more pronounced in
beds of smaller diameter. To validate our model, we carried out fluidization and defluidization
experiments. This involved measuring the pressure drop and bed height at different superficial
gas velocities in the interval of stable bed expansion. Because our fluidizing vessels were made
of stainless steel, we used a pulsed x-rays facility at UCL to enable us to see through the bed in
order to measure the bed height. We analysed our results by means of the Richardson & Zaki
equation, determining the parameters n and u; appearing in the latter. We obtained a reasonable
agreement between numerical and experimental findings. The results revealed that enduring
contacts among particles, which are manifestations of cohesiveness, plays a crucial role in the
homogeneous expansion of gas-fluidized beds. In a liquid-fluidized bed such particle-particle
contacts are absent, and one can confidently use the fluid dynamic correlations commonly found

in the literature to analyze their expansion profiles.

The results presented in Chapter 3 revealed that sustained frictional contacts among particles
exist even in the homogeneous gas-fluidized state of fine powders. We confirmed this from our
theoretical and experimental analyses. The numerical solution of linear momentum balance
equation for homogeneous fluidized beds shows that solid volume fraction profiles develop
along the bed axis which is a consequence of enduring particle contacts. The back-calculated
values of Richardson & Zaki parameters, obtained theoretically and experimentally, also reveal
that enduring contacts do play a role in the homogeneous expansion of gas-fluidized beds. The
results presented in this work thus support the view that interparticle forces are likely the

dominant mechanism responsible for the homogeneous expansion of gas-fluidized beds. This is
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contrary to the ideas of some authors, reported in Chapter 2, that fluid dynamic forces play a

major role.

In Chapter 4, we examined the phenomenon of solid mixing in the bubbling regime of gas-
fluidized beds. We reviewed the importance of solid mixing in the latter, highlighting the
mechanisms by which it proceeds. We reported on the processes of axial and lateral solid
mixing, emphasizing their importance in the design and efficient operation of large-scale fluid
beds. We then discussed various experimental methods employed in the literature for measuring

the rate of lateral solid mixing and the empirical correlations available for its estimation.

In Chapter 5, we used the Eulerian-Eulerian modelling approach to investigate the phenomenon
of lateral solid mixing in gas-fluidized beds. We quantified the rate of lateral solid mixing by
means of a lateral dispersion coefficient Dg,.. The latter was defined using an equation
analogous to the Fick’s law of molecular diffusion. We solved the Eulerian-Eulerian models in
CFD codes to obtain the void-free solid volume fraction profiles in bed. By matching void-free
solid volume fraction profile obtained numerically with those obtained analytically from the
Fick’s equation, we determined the values of D, at different operational conditions. The results
of our simulations revealed that Dy, increases with the superficial gas velocity and bed height,
while it initially increases with bed width, but then remains approximately constant. In all the
simulation cases, our numerical results overestimated the empirical ones, but the order of

magnitude was predicted correctly.

We provided a two-fold explanation for the overestimation: on one side, it reflects the different
dimensionality of simulations (2D) as compared with real fluidized beds (3D), which affects the
degrees of freedom of particle lateral motion. On the other, it is related to the way frictional
solid stress was modelled: we employed the kinetic theory of granular flow model for the
frictional solid pressure and the model of Schaeffer (1987) for the frictional solid viscosity. To
investigate how sensitive the numerical results are on the constitutive model adopted for the

frictional stress, we ran the simulations again using different frictional models and changing the
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solid volume fraction at which the bed is assumed to enter the frictional flow regime (¢, . ). We

observed that D, is quite sensitive to the latter. We obtained the best prediction when ¢ . =
0.50. Nevertheless, numerical results still overestimated the empirical ones. To investigate the
effect of simulation dimensionality on our results, we proposed a simple scaling rule, based on

the loss of degree of freedom when passing from a 3D to a 2D domain. The overprediction,

nevertheless, was not eliminated.

In Chapter 6, we focussed on the problem of overestimation reported in Chapter 5, using both
CFD and DEM approaches. In the former, we ran 3D simulations using the same powder, the
same operational conditions and the same computational setup as in the previous 2D simulations
reported in Chapter 5. We observed that the frictional stress model, and in particular the value of
solid volume fraction at which the bed is assumed to enter the frictional regime, plays a role in
the numerical simulations of lateral solid mixing. This was also observed in our 2D simulations,
but in the 3D case the effect is less pronounced. The 3D simulations predicted Dy, more
accurately than the 2D simulations, the simulation dimensionality appearing to be the most

important factor.

To analyse further the role of frictional stress models, we ran 3D DEM simulations, employing
the soft-sphere approach in order to model the particle-particle contact forces. This approach,
when compared to its CFD counterpart, offers a relatively simpler alternative for describing the
rheology of the solid phase, since we longer model the solid stress. To run the DEM
simulations, we carried out a sensitivity analysis on some collision parameters employed. The
simulation results revealed that the accuracy of numerical predictions depends on the values
assigned to the collision parameters; in particular, the friction coefficients and the stiffness. Our
simulation results showed that D, decreases with both friction coefficient and stiffness. We
compared the numerical results obtained from DEM simulations with those from CFD
simulations. We observed that both modelling approaches predicted Dy, fairly accurately.

Nevertheless, CFD simulations yielded slightly better results.
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7.1 Future work

In Chapter 2 we reported the ongoing controversy on the origin of stability of gas-fluidized
particles. Some researchers attributed the stability to the existence of interparticle forces in the
bed, while some argued that the stability arises from the fluid dynamic forces, and some others
maintained that both forces are responsible. To gain deeper insight into this problem, it will be
interesting to investigate the fluidization of Geldart A powders using the DEM approach. The
latter offers a flexible way to incorporate interparticle forces and to vary their magnitude. Thus,
one can run two sets of simulations: the first set will account for interparticle forces and the
other will not. This study will allow us to further highlight the role of interparticle forces on the

homogeneous fluidization of Geldart A powders.

We reported in Chapter 2 that the granular Bond number is an important parameter that
determines the fluidization behaviour of powders. For Geldart B powders B,, < 1, hence they
bubble as soon as they are fluidized; for Geldart A powders B,, = 1, so they exhibit smooth
expansion over a range of superficial gas velocity as soon as they are fluidized. It is worth
investigating whether Geldart B powders can be fluidized homogeneously by increasing their
granular Bond number to unity. This can be achieved by imposing interparticle forces on them.

If they do fluidize homogeneously, do they fluidize in the solid-like or fluid-like regime?

In Chapter 3, we modelled the stable expansion of gas-fluidized beds and we estimated the
expansion parameter n. We observed that the values of the latter are higher than those obtained
from purely fluid dynamic correlations, signifying that enduring particle contacts, and indeed
interparticle forces, do play a role in the homogeneous expansion. It is necessary to investigate
how changes in the magnitude of interparticle forces will affect the value of the expansion
parameter n. By imposing varying magnitudes of interparticle forces and back-calculating the
latter, one can further gain useful insights into the relationship between parameter n and

interparticle forces.
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In Chapters 4 to 6, we investigated the process of lateral solid mixing in bubbling gas-fluidized
beds, emphasizing its importance in the efficient operation of large-scale fluidized beds, such as
fluidized bed combustors. In our analyses, we considered particles similar in physical
properties, but differing only in the names assigned to them in the computational codes. This
approach, even though enabled us to investigate the influence of operational conditions on
lateral solid mixing, presented a simplistic view of fluidized bed combustion processes. In
actual combustors, the fuel and inert bed materials differ substantially in size and density. In the

future, it would be necessary to account for this ddifference.

Furthermore, in our simulations we considered a batch process, where the particles are charged
into the reactor at once and then fluidized for given length of time. This is the usual method
commonly employed by most researchers studying solid mixing process in fluidized beds.
Nevertheless, many physical and chemical processes are carried out in fluidized beds with
continuous flow of solids. To design and operate these processes, it is crucial to know the
residence time distribution of particles in the bed which can be used to characterize the mixing
process. The methodology adopted in this work can be employed to incorporate continuous flow
of solids into the bed. This, however, will require using a definition of Dg, which is different

from those used in this work and assigning appropriate boundary and initial conditions.
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APPENDIX A

Set-up procedures for the Eulerian-Lagrangian simulations

A.1 Preliminaries

This section provides a basic guide for setting the Eulerian-Lagrangian simulations.

1. Log in to the computer with the following username and password:
Username: luca
Password: ghzv4321
2. The MultiFlow software runs on linux operating system. When you login, open a
terminal. To do this, click on a black square icon at the bottom right corner of the

screen. An interface appears as shown in the figure below:

server@localhost: ~ 169x49
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3.

Type eclipse inside the interface and press enter on the keyboard. This takes the
user to eclipse workspace which contains the programme for the MultiFlow
simulations.

In the eclipse workspace, there are three major project directories: MFTL,
MultiDoc and MultiFlow. The latter is the most relevant for setting up and running
multiflow simulations.

Double click on MultiFlow. This brings out a number of sub-directories.

Double click on examples. Again, this contains many sub-directories. Double click
on EulLag, and then click on FluidizedBed.

Then, double click on Delft-FluidizedBed; a number of files appear. The most

relevant ones are: run, run-mf, USERBoundary.c and USERinit.c.

A.2 Setting up simulations

8.

Double click on USERBoundary.c file. This is where you set the boundary
conditions, in particular the inlet superficial gas velocity. You can set this value on
the line 110 and 114 of the programme. The USERBoundary.c is as shown below,
with the line number omitted. Line 110 and 114 are written in bold letters in the

programme below.

/*************************************************************

*

This file

* Is intended to specify the boundary conditions on all the

outer

* Dboundaries, or inner thin walls, by setting A, B, and C.

*

* The routine will be called for every boundary and for

every
*

variable.

* Creation date: 05-09-2003
* Author (C) Berend van Wachem
*

*************************************************************/

#include <string.h>
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#include "cfdmesh.h"
#include "constants.h"
#include "petsc.h"
#include "general.h"

int USERBoundary (char *varname, char *typename, char
*boundname, int direction, int Istart, int Jstart, int Kstart,
int Iend,

int Jend, int Kend, int blocknumber, int Ilen, int Jlen,
int Klen, double *A, double *B, double *C, struct CFDMesh
*Mesh)
{

int i, j, k;

int index = 0;

double *XC, *YC, *zC;

int bladdress;

int ierr;

Vec *VFRAC;

double *vfrac;

int OwnThisBlock = MF NO;
int OwnThisPoint = MF NO;
int HaveVolumeFraction = MF NO;
int lblock;

int 1i, 13, 1k;

int Ireal, Jreal, Kreal;

/*************************************************************
************/

/* Find out if current processor owns this block number

*/

/***********************************************************/
if ((lblock = FindBlock (Mesh->NMyBlocks, Mesh->CFDBlocks,
blocknumber)) >= 0)

{
OwnThisBlock = MF YES;

ierr = VecGetArray (Mesh->CFDBlocks[lblock].CC.X,
&XC) ; CHKERRQ (ierr) ;
ierr = VecGetArray (Mesh->CFDBlocks[lblock].CC.Y,
&YC) ; CHKERRQ (ierr) ;
ierr = VecGetArray (Mesh->CFDBlocks[lblock].CC.Z,
&ZC) ; CHKERRQ (ierr) ;
}

if (FindDatalListofLocalVectors (Mesh->BLCC, "VFracL",
&VFRAC) )

{

HaveVolumeFraction = MF YES;

if (HaveVolumeFraction && OwnThisBlock)

{
ierr = VecGetArray (VFRAC[lblock], &vfrac);CHKERRQ (ierr);
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}

/* Loop over boundary */

for (k = Kstart; k < Kend + 1; k++)
{ for (j = Jstart; j < Jend + 1; j++)
{ for (i = Istart; i < Iend + 1; i++)
{ index = (i - Istart) + (j - Jstart) * (Iend - Istart +
1) + (k - Kstart) * (Iend - Istart + 1) * (Jend - Jstart + 1);

if (OwnThisBlock)
{

Ireal = (1 - Mesh->CFDBlocks[lblock].IGs + Mesh-
>CFDBlocks[1lblock] .IDs - 1);
Jreal = (j - Mesh->CFDBlocks[lblock].JGs + Mesh-

>CFDBlocks[lblock] .JDs - 1);
Kreal = k - Mesh->CFDBlocks[lblock] .KGs + Mesh-
>CFDBlocks[lblock] .KDs - 1;

bladdress = (Ireal - Mesh->CFDBlocks[lblock].IGs) +
(Jreal - Mesh->CFDBlocks[lblock].JGs) * Mesh-
>CFDBlocks[lblock] .IGe
+ (Kreal - Mesh->CFDBlocks[lblock] .KGs) * Mesh-
>CFDBlocks[1lblock] .IGe * Mesh->CFDBlocks[lblock].JGe;

if (OwnGlobalPoint (Ireal, Jreal, Kreal, Mesh-
>CFDBlocks[1lblock] .Is, Mesh->CFDBlocks[lblock].Js,

Mesh->CFDBlocks[1lblock] .Ks, Mesh-
>CFDBlocks[1lblock] .Ie, Mesh->CFDBlocks[lblock].Je, Mesh-
>CFDBlocks[1lblock] .Ke,

Mesh->CFDBlocks[1lblock] .IGs, Mesh-
>CFDBlocks[1lblock] .JGs, Mesh->CFDBlocks[lblock] .KGs, Mesh-
>CFDBlocks[1lblock] .IGe,

Mesh->CFDBlocks[lblock] .JGe, Mesh-
>CFDBlocks[1lblock] .KGe, &1i, &13, &lk))

{

OwnThisPoint = MF YES;
}
else
{

OwnThisPoint = MF NO;

}
}

if (memcmp (boundname, "INLET", 5) == 0)
{

if (memcmp (varname, "Pressure", 5) == 0)

{

Alindex] = 0.0;
Bl{index] = 0.0;
Clindex] = MF_FLOW_EXTRAPOLATE;

}

else if (memcmp (varname, "UVelocity", 5) == 0)
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{
Alindex] = 1.0;
B[index] = 0.0;
if (HaveVolumeFraction && OwnThisPoint &&
OwnThisBlock)
{

C[index] = 5.02 / vfrac[bladdress];
}
else
{

Cl[index] = 5.02;

}
}

else if (memcmp (varname, "VVelocity", 5) == 0)
{
Alindex] 1.0;
B[index] = 0.0;
Clindex] = 0.0;
}
else 1if (memcmp (varname, "WVelocity", 5) == 0)
{
Alindex] 1.0;
Blindex] = 0.0;
Clindex] = 0.0;
}
else if (memcmp (varname, "TEMPERATURE", 5) == 0)
{
Alindex] = 1.0;
Blindex] = 0.0;
Clindex] = 100.0;
}
else 1if (memcmp (varname, "VFrac", 4) == 0)
{
Alindex] = 0.0;
Blindex] = 1.0;
Clindex] = 0.0;
}
else
{
Alindex] = 0.0;
Blindex] = 1.0;
Clindex] = 0.0;
}
}
else if ((memcmp (boundname, "PRESS", 5) == 0) ||
(memcmp (boundname, "OUT", 3) == 0))
{
if (memcmp (varname, "Pressure", 5) == 0)
{
Alindex] 1.0;
Blindex] = 0.0;
Clindex] = 0.0;
}
else if (memcmp (varname, "UVelocity", 5) == 0)

{
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Alindex] 0.0;
Blindex] = 1.0;
Clindex] = 0.0;

1
else if (memcmp (varname, "VVelocity", 5) == 0)
{
A[index]
B[index]
Cl[index]
}
else if (memcmp (varname, "WVelocity", 5) == 0)

{

’

’

Il
o~ O
oNeNe)

’

A[index] 0.0;
Blindex] = 1.0;
Clindex] = 0.0;
}
else if (memcmp (varname, "VFrac", 4) == 0)
{
Alindex] = 0.0;
Blindex] = 1.0;
Clindex] = 0.0;
}
else
{
Alindex] = 0.0;
Blindex] = 1.0;
Cl[index] = 0.0;
}
}
else 1f ((memcmp (boundname, "WALL"™, 4) == 0) ||

(memcmp (boundname, "SIDEWALL", 8) == 0))
{

if (memcmp (varname, "Pressure", 5) == 0)
{
Alindex] 0.0;
Blindex] = 1.0;
Clindex] = 0.0;
}
else if (memcmp (varname, "UVelocity", 5) == 0)
{
Alindex] = 1.0;
Blindex] = 0.0;
Clindex] = 0.0;
}
else if (memcmp (varname, "VVelocity", 5) == 0)
{
Alindex] 1.0;
Blindex] = 0.0;
Clindex] = 0.0;
}
else if (memcmp (varname, "WVelocity", 5) == 0)
{
Alindex] 1.0;
Blindex] = 0.0;
Clindex] = 0.0;
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else if (memcmp (varname, "TEMPERATURE", 5) == 0)
{

Alindex] = 1.0;
Blindex] = 0.0;
Clindex] = -100.0;
}
else if (memcmp (varname, "VFrac", 4) == 0)
{
Alindex] = 0.0;
B[index] = 1.0;
Clindex] = 0.0;
}
else
{
Alindex] = 0.0;
Blindex] = 1.0;
Clindex] = 0.0;
}
}
else
{
Alindex] = 0.0;
Blindex] = 1.0;
Clindex] = 0.0;

}

} /* End looping over K */

ierr = VecRestoreArray (Mesh->CFDBlocks[lblock].CC.X,

CHKERRQ (ierr) ;
ierr = VecRestoreArray (Mesh->CFDBlocks[lblock].CC.Y,

CHKERRQ (ierr) ;

if (Mesh->ThreeD)
{

ierr VecRestoreArray (Mesh-

>CFDBlocks[lblock] .CC.Z, &Z);

//
//

if

{

CHKERRQ (ierr) ;
}

(HaveVolumeFraction && OwnThisBlock)

ierr = VecRestoreArray (VFRAC[1lblock],

&vfrac) ; CHKERRQ (ierr) ;

}

if

{
&XC)

&YC)

(OwnThisBlock)

ierr = VecRestoreArray (Mesh->CFDBlocks[lblock].CC.X,
; CHKERRQ (ierr) ;
ierr = VecRestoreArray (Mesh->CFDBlocks[lblock].CC.Y,
; CHKERRQ (ierr) ;
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ierr = VecRestoreArray (Mesh->CFDBlocks[lblock].CC.Z,
&ZC) ; CHKERRQ (ierr) ;
1

return (0);

9. Double click on USERInit.c file to set the initial conditions for the primary cell.

Usually you do not need to change anything here. The file is shown below:

/*******************************************************
* Kk ok kkkk

* This file

*

*! Is intended to specify all initial conditions for
the primary cell

*! centered variables.

*

* This routine is called only once, in the beginning
of a non restart run

*

Creation date: 18-11-2003
Author (C) Berend van Wachem

File $Id:USERinit.c 6 2007-03-20 20:52:287 berend $
Last modified by: S$Author:berend $
On: $Date:2007-03-20 21:52:28 +0100 (Tue, 20 Mar

2007) $

* O X X X X % ot

Rk i b b b b b b b b b b b b b b b I I SR I b b b b b b b b b b b b b b b b b b b b S b S b S b b S e S 3

*********/

#include <string.h>
#include "cfdmesh.h"
#include "constants.h"
#include <stdlib.h>
#include "general.h"
#include "io.h"
#include "petsc.h"
#include "options.h"

int USERInit (char *varname, double *varray, int Istart,
int Jstart, int Kstart, int Iend, int Jend,
int Kend, int blocknum, struct CFDMesh *Mesh, struct

MFOptions *Options)
{

int ierr;

int i, j, k, address;

double *X, *Y, *Z;

int bladdress;
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double x0 = 1.5e-2;
double yO0 4.5e-2;
double r0 = 4e-3;

/* Open up Mesh->CFDBlocks[blocknum].X, Y and Z */

ierr = VecGetArray (Mesh->CFDBlocks[blocknum].CC.X,
&X) ;

CHKERRQ (ierr) ;

ierr = VecGetArray (Mesh->CFDBlocks[blocknum].CC.Y,
&Y) ;

CHKERRQ (ierr) ;

if (Mesh->ThreeD)

{
ierr = VecGetArray (Mesh->CFDBlocks[blocknum] .CC.Z,

&72) ;
CHKERRQ (ierr) ;
}

/* Loop over boundary */
for (i = Istart; 1 < Iend + Istart; i++)
{
for (j = Jstart; 7 < Jend + Jstart; j++)
{
for (k = Kstart; k < Kend + Kstart; k++)
{
/* Calculate address */
address = (i1 - Istart) + (j - Jstart) * Iend +
(k = Kstart) * Iend * Jend;

bladdress = (i - Mesh->CFDBlocks[blocknum].IGs)
+ (j - Mesh->CFDBlocks[blocknum] .JGs)
* Mesh->CFDBlocks[blocknum] .IGe+ (k - Mesh-
>CFDBlocks [blocknum] .KGs)
* Mesh->CFDBlocks [blocknum] .IGe* Mesh-
>CFDBlocks [blocknum] .JGe;

if (memcmp (varname, "Pressure", 5) == 0)

{

varray[address] = (double) 0.0;
ilse if (memcmp (varname, "UVelocity", 5) == 0)
{ varray[address] = (double) 2.0000;
ilse if (memcmp (varname, "VVelocity", 5) == 0)
{ varray[address] = (double) 0.0000;

}

else if (memcmp (varname, "WVelocity", 5) == 0)

{

varrayladdress] = (double) 0.0;
}
else if (memcmp (varname, "TEMPERATURE", 5) == 0)
{

varray[address] = (double) 1.00;

196



Appendix A Setting up Eulerian-Lagrangian simulations

}

else if (memcmp (varname, "VFrac", 5) == 0)
{

if (X[bladdress] <= 0.7)

{

varrayladdress] = 1.0;
}
else
{
varrayladdress] = 1.0;
1
1
else if (memcmp (varname, "Density", 5) == 0)
{
varrayl[address] = Options->Phase[0] .density;

}

}

ierr = VecRestoreArray (Mesh->CFDBlocks[blocknum].CC.X,
&X) ;

CHKERRQ (ierr) ;

ierr = VecRestoreArray (Mesh->CFDBlocks[blocknum].CC.Y,
&Y) ;

CHKERRQ (ierr) ;

if (Mesh->ThreeD)

{

ierr = VecRestoreArray (Mesh-
>CFDBlocks[blocknum] .CC.Z, &Z);
CHKERRQ (ierr) ;

}

return (0);

10. Next, double click on the run file. It is a script to run the simulations.

11. Double click on the run.mf file. This contains really the set-up of the
simulations. The file is quite self-explanatory (Please note that the
particle box number in the file below should be kept in the range 1.01 —
1.4. This number affects the fluid volume fraction in the bed; if you choose
a number that is too large, the volume fraction may be unrealistically
small). Here we set the conditions for the fluid and the particles. The

run.mf file is shown below:
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FHAFH AR H AR H AR H SRR A
MultiFlow Options File

FHAFH AR H AR H SRS E AR S AR HE A A
# All options need to be specified,

# or set to "DEFAULT".

# If an option is NOT specified, MultiFlow will ask

# to do so.

# debugging options
# these can only be yes or no
#
# Information about the phases to be solved in the
system
#
PHASE 01
Fluid
Eulerian
Incompressible
Density 1.280
Viscosity 1.7e-5
AutoMesh 70 2 120 0.0 0.0
GravityVector -9.81 0.0 O.
END

0.0 3.5e-1 1.0e-3 6.0e-1
0

PHASE 02

Solid

Lagrangian

TimeStep 1.0e-3

CollisionModel Tsuji

AutoTimeStep

MinCollisionStep 040

WallYoungsMod 1.0e+6

WallPoissonRatio 0.33

WallFriction 0.35

WallRestCoef 0.9
# ParticleType <NUM> <DIAM> <DENSITY> <YOUNGS>
<POISSON> <FRICT> <REST COEF>
ParticleType 01 4.9e-04 2620.0 1.0e+6 0.33 0.35 0.9
ParticleType 02 4.9e-04 2620.0 1.0e+6 0.33 0.35 0.9
ParticleType 03 0.02 0500 1.0e+7 0.35 0.1 0.06
ParticleType 04 0.03 1000 1.0e+7 0.35 0.1 0.06
# InitBlockParticles 01 0.0 0.0 0.0 90.0e-3 8e-03
115.0e-03 1.8e-4
InitBlockParticles 01 0.0 0.0 0.0 -5.0e-2 1.0e-03 2.99%e-
1 1.0e-4
InitBlockParticles 02 0.0 0.0 3.0le-1 5.0e-2 1.0e-03 -
6.0e-1 1.0e-4
# InjectParticles <PNUM> <Point> <Velocity> <StartTime>
<EndTime> <interval> <randomness>
ParticleBox 1.2
# PSDFileName <PNUM> <FILENAME>
# PSDFileName 01 examples/Eullag/FluidizedBed/Delft-
FluidizedBed/psd
# ParticleOutlet OUTLET

GravityVector -9.81 0.0 0.0
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END

#

# Executing, timesteps, filenames

#

EXCECUTE

#Restart NO

Restart YES
ResDirectory wallresultsl
ResTime Last
TimeSteps 10 1.0e-3
OutputFrequency 10
OutputFileName results.mfo

END

#

# Convergence criteria

#

CONVERGENCE
Mass 1.0e-6
Maxiter 500

END

NUMERICS

AdvScheme UPWIND
END

12. Then you can compile the simulation set-up. To do this, click on the project icon at
the top of the screen. A number of options appear from which you have to click on
build project. For every modification you make in the simulation set-up, remember
to re-compile the simulation before going to step 13.

13. To run the simulation, open another terminal (black square icon at the bottom right
corner of the screen). Then type the following command

cd src/eclipseworkspace/MultiFlow/
then press enter. This takes you to the MultiFlow directory.

14. The next step is to run the simulations. To do this, type the following command in
the terminal:

examples/EulLag/FluidizedBed/Delft-FluidizedBed/run

now you are running the script called ‘run’ in the Delft-FluidizedBed directory.

A.3 Visualization and post-processing
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15. The results of the simulations are created in a directory (assume this directory is
called results). You will go to the paraview directory and translate the results from
the native MultiFlow format to a format that can be read in paraview (paraview is a
software for post processing and visualization of simulation results). To do this,
type the following commands in the terminal

cd paraview

this takes you to the paraview directory.

16. To translate the results, use the following command

mftovtk -d ../results; ptovtk -d ../results; collection -d ../results

then press enter.

17. To go to the paraview software for visualization, type paraview in the terminal and

press enter.

The following additional steps are needed if you run a simulation with partition and
you intend to remove the partition.

18. The programme that adds and removes partition to the geometry is the
createparticlebox.c file which you can find in the MultiFlow directory. The
programme line 1573 adds or removes a partition from the geometry. If the line is
deactivated, by adding double backslash (//) before the text on this line, the partition
is removed, otherwise the partition is present in the geometry. If you intend to run
simulations with a partition, you need to define two types of particles, one on each
side of the partition, in the run.mf file in step 10 above; you will also need to
specify the location of the partition in the geometry. This is also done in the
createparticlebox.c file. For instance, if you intend to insert a partition at the
middle of a geometry having a width of 0.6, in the createparticlebox.c file you
will set the zwallv = 0.3. Remember also to specify the values of other spatial
coordinates; these should be the same as the depth and height of your geometry.
Another important parameter that needs to be specified in the createparticlebox.c
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19.

20.

21.

file is the xdims and ydims values. The latter is approximately the number of
particles that fit in the y direction divided by the particle box number (step 11
above), while the xdims is approximately the number of particles that fit in the x
direction divided by the particle box number.
To remove the partition when the simulation is completed, you need to move the
simulation results to a new directory, for example let us assume that the name of the
new directory is wallresults. To do this, type the following commands inside the
terminal (you may not need to open another terminal for this, you can type the
command inside the same terminal where you ran the simulations):

mv results wallresults
Then remove the partition by following the steps in 18.
After this, in the run.mf file remove the ash symbol (#) before the RESTART YES,
and put it before the RESTART NO option. Recompile the simulations (step 12)

and start running the simulations (following the steps from 13).
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Creating geometries in ANSYS Workbench

B.1 Procedures

The following is a step-by-step guide on how to create geometries in ANSY'S workbench.

1. Open Workbench.

2. Create a new project by double clicking on mesh icon at the left hand side of the screen.
A box comes up in the project schematic containing three icons — 1.mesh 2. Geometry
3. Mesh.

3. Double click on the geometry option. This takes you to the design modeller which
enables you to create the geometry.

4. In the design modeller, select the unit of distance you would like to work with, usually
the S.I. unit is preferred — meters.

5. In the tree outline, select the XY plane.

6. Click on the sketch icon at the top of the page — a blue icon with a star on top. This
brings out the option of sketch 1 in the tree outline.

7. Then click on sketching at the bottom of the tree outline. This brings out the sketching

toolbox.
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10.

11.

12.

13.

14.

15.

16.

Select rectangle and draw, from the origin, the rectangle of your choice in the XY plane.
You can adjust the dimensions of the rectangle by clicking on dimension below the
sketching toolbox. Then click on the side whose dimension you wish to modify. Then in
the detailed view write the dimension of your choice. When you are happy with the
sketch, click on generate at the top of the screen.

If you intend to have geometry separated by a partition, repeat steps 6 — 8. You will
then have two sketches in the tree outline — Sketch 1 and Sketch 2.

Select the Sketch 1 in the tree outline. Then, on top of the page, click on concept, then
surfaces from sketches. On the details view (below the page) click on operations and
select add frozen. Still on the details view, set the value of thickness to 0.0001m.

Repeat Step 10 for Sketch 2.

In the tree outline, click on 2 parts 2 bodies. When you do this, you have two surface
bodies appearing below the 2 parts 2 bodies. Click on the first surface body, then in the
details view select fluid option. Repeat this for the other surface body.

Save the project by clicking on the save icon at the top left of the screen.

Go back to the workbench page (the original page that came up when you opened the
Workbench). Double click on mesh (3). The geometry you have created comes up in a
separate window.

Right click on mesh (at the left side of the screen), and then click on insert and the
mapped face meshing, select the geometry (the sketch you have created) and then click
on apply in the box below.

Mapped face meshing option appears on the left hand side of the screen. Right click on
mapped face meshing and then insert and then sizing. A box appears at the bottom left
of the screen. Using the mouse, click on the face of the sketch you intend to ‘mesh’.
Then click on apply (in the geometry option) inside the box. In the latter, the type of the
mesh should be element size, then in the element size (below the ‘type’ option) specify

the dimension of your element (grid size). THEN click on update at the top of the
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17.

18.

19.

screen. This generates the mesh for the face you selected. If you have more than one
face, repeat step 16.

The next step is to name the edges. To do this, click on the second box at the top of the
screen, have an edge highlighted in green. Then, select each edge by right clicking.
Then, you have an option —create named selection. Click on the latter and name the
edge as you wish. Do this for all the edges, except the partition (If you are dealing with
geometry having partition).

You also need to name the faces. To do this, click on the third box at the top of the
screen, having a face highlighted in green, then select the face and right click. Click on
create named selection and name the face as you wish. If you have two faces, do this for
the other face.

Export the file as .msh file. To do this click on file, and export as .msh file.

B.2 Loading the mesh in Fluent

20.

21.

22.

23.

Load the mesh you have created in workbench into Fluent. Go to cell zone condition,
change the solid type to fluid. Below the mesh you loaded in Fluent, there is a typing
interface. Type mesh, then press enter on the keyboard.

Then type modify-zones, and press enter again.

Type fuse-face-zones and press enter again. This procedure is necessary for the
following reasons: We created two rectangles in workbench and we joined them
together. Essentially we have two edges at the middle of the rectangles which must be
fused together to make one partition; hence the reason for this step.

Type the ID number of surface_body facel. To know the ID go to boundary conditions,
then click on surface _body facel. The ID comes out. Do this also for
surface_body facel (if applicable). Press enter three times. Once this has been done, a
fuse zone is created named interior-4 in the list of the boundary conditions. This

interior-4 has to be changed to wall boundary condition. You can do this by selecting
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the interior-4, and changing the boundary condition to a wall in the box below the list of
boundary conditions. A message comes up asking you to confirm if you wish to change
the interior-4 to wall. Click on Yes. Then an interface comes up where you can select
the condition of the wall you wish. Usually, we use a stationary wall with a no-slip

boundary condition. Click Ok. This completes the task.

B.3 Creating a 3D geometry

24,

25.

26.

217.

28.

29.

30.

Follow steps 1-9 above.

Then extrude the geometry. To do this, select the sketches you have created (by clicking
on it in the tree outline) and click on the extrude icon at the top of the page. Down the
page, you will see the detailed view box. Click on add material and select add frozen
option. You can specify the depth of the extrusion in the detailed view box by changing
the FDI depth value to the value of your choice. Then click on generate. Do this for all
the sketches in the tree outline if you have more than one sketch.

Click on 2parts 2bodies (depending on the number of bodies you joined together). Click
on solid. In the detailed view box below, change the option to fluid. Do this for the two
solids (if applicable). Then click save.

Go back to the workbench click on mesh (step 14 above). A graphical interface comes
up which brings out the geometry you have created.

In the outline at the left side of the screen, right click on mesh and select the option
generate mesh.

You can modify the mesh by clicking on sizing in the box below and adjusting the
element size to the value of your choice and click on update.

The next step is to name the faces of the geometry. To do this click on the third box at
the top, having a face highlighted in green. Then select each of the faces by clicking on
them, then right click and create a named selection and name them accordingly. Do this

for all the faces, except for the partition.
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31. Then you need to name the bodies (If you have joined two or more bodies together). To
do this, click on fourth box on top of the page — having all the faces green. Then select
the body by clicking on it, right click and create a named selection. This enables you to
assign names to the body or bodies.

32. Save and export the mesh as .msh file.

In Fluent

33. Load the geometry in Fluent. Again, we need to fuse the partition together.
34. To do this, follow steps 20 — 23. The only difference here is that instead of fusing
surface_body facel and surface body face2, we fuse instead wall_zonel body and

wall_zone2_body. This completes the task.
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Setting up simulations in ANSYS FLUENT

C.1 Introduction

This section provides a guide on how to set up Eulerian-Eulerian simulations in ANSYS
FLUENT 12.1. The procedures given in this section are based on the simulation cases

considered in our research, but users can easily adapt the procedures to suit their purpose.

C.2 Procedures

The following gives the outline of how to set-up the simulations

1. Open Fluent. An interface, inside the red box in the screenshot below, comes up. Here
you can select the dimension of the simulations you intend to run. Select double

precision, and serial. Then click Ok.
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2. Next, load the mesh. To do this, click on file at the top of the page. Select read, then
select case. Navigate to the folder where you have saved your mesh and UDFs. Select

the mesh and click Ok. Refer to the screenshot below.

1 FLUENT (34, dp pbe e = ow =~
() Meh_Otoe_Sohve Adwpt Suface Ouplay Repot Puabel View Help

Uelcone to ANSYS FLUENT 12.1.4

Copyright 2009 ANSYS
AL Rights Reserved.

Loading “C:\Users\General/.cxlayout™
Dane.

Tl S R RCH ] -1 |

3. Click on General at the left side of the screen. The under solver select pressure-based,
absolute, transient/steady (this depend on the type of simulations you intend to run, but

generally we choose transient).

X FLUENT (34, dp, pbos lam] = en =~ |
Fie_Meh Oetie Soive_Adugt Suface Display Repon_Pucbel View Hlp

vl e [PRR S KRN0 -

Mesh Aug 17,2015
ANSYS FLUENT 12.1 (3, dp, pbns, lam)

eparing nesh For display...

: File "E:\arkus\U1 887\Partition\Utest.cas” not found?
ror bject: aF

| I EILECRENEE] ]
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4. Next, select model at the left side of the screen. Then click on multiphase, select
Eulerian. Next, specify the number of phases. The screenshot for this step is shown
below. In our simulations we used 3 Eulerian phases because we have two solid phases

and one fluid phase.

vvvvvv

Aug 17,2015
ANSYS FLUENT 121 (34, dp, pbns, lam)

5. Click on material under the problem setup. Then click on fluid (Usually, this is the
default. You can either leave it or modify the fluid properties to suit your purpose).
Once you are happy with the fluid properties, write the name of the first solid phase, for
example you can name it solid-1. Then input its density and viscosity. For the latter,
choose a very small value; we suggest 10°. Then click on change/create. A message
pops up asking you if you want to overwrite air, click No. If you have more than one
solid phase, repeat the same thing you did for solid-1.

6. The next step is to load the UDF. To do this, click on Define (at the top of the page),
then user-defined, then click function, then click compiled. A box comes up as shown
below. Click add, then navigate to the UDF folder. Click on build, then Ok. Then click

on load. This loads the UDF.
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7. Next, click on Define, then user-defined, then function hook. A box comes up as
shown in the screenshot below. In the box, click edit for the initialization, another box

pops up, select initialization and click Ok. Do the same for the post-processing.

Aug 17,2015
C )

ANSYS FLUENT 121 (3d, dp, pbns, eulerian, lam, transient)

8. Next, we need to specify the number of memories. To do this, click on Define, then
user-defined, then click memory. You can now specify the number of memories you
want. This will depend on your UDF.

9. Next, click on phases under problem set-up group. If you have three phases, like we
had, you have one primary phase and two secondary phases, as shown in the screenshot

below. Select the first secondary phase, then click edit.
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Aug 17, 2015
ANSYS FLUENT 121 (34, dp, pbns, eulerian, lam, transient)

A box comes up. Select phase material, select granular under granular temperature
model. Select phase property. Then input the diameter of the particle. For the
following options, we suggest you make your selections as shown below, but you can

modify them to suit your purpose.

Granular viscosity Gidaspow
Granular bulk viscosity Lun et al.
Frictional viscosity KTGF
Angle of internal friction Default
Frictional pressure KTGF
Frictional modulus Derived
Frictional packing limit Default
Granular temperature Algebraic
Solid pressure Lun et al.
Radial distribution Lun et al.
Elasticity modulus Derived
Packing limit Default
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Next, click on interaction. A box, with green boundary in the screenshot above, comes
up. Here, you select the drag coefficient of your choice; in our case, we used the user-
defined drag. To select the drag coefficient, you have to click on edit.

10. Next, click on boundary conditions in the problem setup group. A box comes up as
shown in the screenshot below. Select each zone and choose the appropriate boundary
condition from the type. For faces that are walls, select wall; for outlet, select pressure
outlet; for inlet, select velocity inlet. For the velocity inlet, here you need to specify the
magnitude of the superficial gas velocity. To do this, you select phase-1by clicking on

phase, select phase-1 in the drop-down menu and click edit.

1 FLUENT 134t b
Fe_Mah 0

Aug 17,2015
lam, transient)

ANSYS FLUENT 12.1 (34, dp, pbns, eulerian

el BRI RCRCH ] | -] o |

11. Click on solution methods. We suggest that you make the following selections; of

course you can make selections to suit your purpose.

Scheme multiphase couples
Gradient Green-Gauss cell based
Momentum Second order upwind
Volume fraction Quick

12. Click on solution initialization in the problem setup group. Then click initialize again.
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13. In the problem setup group, click on calculation activities. Then select how you would
like the solutions to be saved (we suggest saving every 100 time steps). Next, click edit,
an autosave box comes up, select eachtime. Click Ok.

14. Next, click on display at the top of the page. Then click on residuals. A box comes up
where you can modify the absolute criteria; we suggest you change the absolute criteria
to 10°.

15. Next, click on run calculations in the problem setup group. Here you input the time
step (we suggest a value of 0.001 s), the number of time steps (this depends on how
long you want your simulations to run), maximum iteration/time step (we suggest 250),
reporting interval (use the default value of 1), profile update interval (we suggest the
default value of 1). If you are satisfied with the simulation setup, then click on calculate

to start your simulations.

You may want to display your setup before starting the simulations or during the simulations.
To do this, click on display at the top of the page. Then graphics and animations, then click

contours. Then you can display the contours of any parameter you like.
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APPENDIX D

Experimental Results

D.1 Particle size distributions for Powder 1(Alumina)

This section reports the particle size distribution of powders used for fluidization and

defluidization experiments.
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D.2 Particle size distributions for Powder 2(Ballotini)
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D.4 Bed height curves for fluidization and defluidization (Powder 2)
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